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SYMANTEC LICENSE AND WARRANTY
The software which accompanies this license (the "Software") is the 
property of Symantec or its licensors and is protected by copyright 
law. While Symantec continues to own the Software, you will have 
certain rights to use the Software after your acceptance of this li-
cense. Except as may be modified by a license addendum which 
accompanies this license, your rights and obligations with respect 
to the use of this Software are as follows: 

• You may: 

(i) use one copy of the Software on a single computer; 

(ii) make one copy of the Software for archival purposes, or 
copy the software onto the hard disk of your computer and retain 
the original for archival purposes;

(iii) use the Software on a network, provided that you have a 
licensed copy of the Software for each computer that can access the 
Software over that network;  

(iv) after written notice to Symantec, transfer the Software on 
a permanent basis to another person or entity, provided that you 
retain no copies of the Software and the transferee agrees to the 
terms of this agreement; and 

(v) if a single person uses the computer on which the Soft-
ware is installed at least 80% of the time, then after returning the 
completed product registration card which accompanies the Soft-
ware, that person may also use the Software on a single home com-
puter.  

• You may not:

(i) copy the documentation which accompanies the Software;

(ii) sublicense, rent or lease any portion of the Software;

(iii) reverse engineer, decompile, disassemble, modify, trans-
late, make any attempt to discover the source code of the Software, 
or create derivative works from the Software; or

(iv) use a previous version or copy of the Software after you 
have received a disk replacement set or an upgraded version as a 
replacement of the prior version, unless you donate a previous ver-
sion of an upgraded version to a charity of your choice, and such 
charity agrees in writing that it will be the sole end user of the prod-
uct, and that it will abide by the terms of this agreement. Unless you 
so donate a previous version of an upgraded version, upon upgrad-
ing the Software, all copies of the prior version must be destroyed.

• Sixty Day Money Back Guarantee:

If you are the original licensee of this copy of the Software and are 
dissatisfied with it for any reason, you may return the complete 
product, together with your receipt, to Symantec or an authorized 
dealer, postage prepaid, for a full refund at any time during the sixty 
day period following the delivery to you of the Software.
• Limited Warranty:

Symantec warrants that the media on which the Software is distrib-
uted will be free from defects for a period of sixty (60) days from 
the date of delivery of the Software to you. Your sole remedy in the 
event of a breach of this warranty will be that Symantec will, at its 
option, replace any defective media returned to Symantec within 
the warranty period or refund the money you paid for the Software. 
Symantec does not warrant that the Software will meet your re-
quirements or that operation of the Software will be uninterrupted 
or that the Software will be error-free. 

THE ABOVE WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL 
OTHER WARRANTIES, WHETHER EXPRESS OR IMPLIED, INCLUD-
ING THE IMPLIED WARRANTIES OF MERCHANTABILITY, FIT-
NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  
THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU 
MAY HAVE OTHER RIGHTS, WHICH VARY FROM STATE TO 
STATE.

• Disclaimer of Damages:

REGARDLESS OF WHETHER ANY REMEDY SET FORTH HEREIN 
FAILS OF ITS ESSENTIAL PURPOSE, IN NO EVENT WILL SYMAN-
TEC BE LIABLE TO YOU FOR ANY SPECIAL, CONSEQUENTIAL, 
INDIRECT OR SIMILAR DAMAGES, INCLUDING ANY LOST PROF-
ITS OR LOST DATA ARISING OUT OF THE USE OR INABILITY TO 
USE THE SOFTWARE EVEN IF SYMANTEC HAS BEEN ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGES.

SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION 
OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES 
SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY 
TO YOU.

IN NO CASE SHALL SYMANTEC’S LIABILITY EXCEED THE PUR-
CHASE PRICE FOR THE SOFTWARE. The disclaimers and limita-
tions set forth above will apply regardless of whether you accept 
the Software.

• U.S. Government Restricted Rights:

RESTRICTED RIGHTS LEGEND. Use, duplication, or disclosure by 
the Government is subject to restrictions as set forth in subpara-
graph (c) (1) (ii) of the Rights in Technical Data and Computer Soft-
ware clause at DFARS 252.227-7013 or subparagraphs (c) (1) and 
(2) of the Commercial Computer Software-Restricted Rights clause 
at 48 CFR 52.227-19, as applicable, Symantec Corporation, 10201 
Torre Avenue, Cupertino, CA 95014.

• General:

This Agreement will be governed by the laws of the State of Cali-
fornia. This Agreement may only be modified by a license adden-
dum which accompanies this license or by a written document 
which has been signed by both you and Symantec. Should you 
have any questions concerning this Agreement, or if you desire to 
contact Symantec for any reason, please write: 

Symantec Customer Service, 175 W. Broadway, 
Eugene, OR 97401.
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Welcome to 
pcANYWHERE32

pcANYWHERE32 for Windows 95 and Windows NT offers a complete 
communications solution for your remote control, file transfer, and general 
communication needs. 

With pcANYWHERE32 you can:

■ Remotely control one PC from another, as long as both PCs are 
running pcANYWHERE software.

■ Automatically transfer files and synchronize folders between two 
PCs. 

■ Connect to a variety of online services. 

■ Establish a connection to your network and become a node on the 
network.

You can make a connection using telephone lines, a network, or a 
combination of the two. You can make direct connections between two PCs 
using either a serial or parallel cable.

NOTE: Some pcANYWHERE32 features are not supported in Windows NT, 
version 3.51. Please refer to the reference book section of online help for 
information about these features.

Quick tour of pcANYWHERE32
pcANYWHERE’s main window consists of eight buttons, six of which 
correspond to the six primary functions of pcANYWHERE: 

Figure 1-1
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■ Quick Start: Click to display pcANYWHERE wizards for each primary 
function. A wizard is an executable file that automatically prompts 
you for information necessary to accomplish the related task.

■ Be A Host PC: Click to establish your computer as a pcANYWHERE 
host to be accessed by one or more remote users. From this window 
you also create a list of host connection items and select host 
communications options for each host item. (For more information 
on host operations, see “Configuring the host” on page 43.)

■ Remote Control: Click to control a pcANYWHERE host computer. 
From this window you also create and manage a list of one or more 
remote control connection items to choose from for remote 
computing sessions. 

NOTE: Remote control and file transfer share the same connection 
items. When the connection item is started from the remote control 
window, the session begins in remote control mode. When the 
connection item is started from the file transfer window, the session 
begins in file transfer mode. 

■ File Transfer: Click to connect to a pcANYWHERE host computer 
and immediately begin a file transfer session.

■ Be A Gateway: Click when you want the PC to act as a gateway on 
the network. A gateway PC allows network users to share the 
communications device on the gateway PC, and allows remote 
callers to access a pcANYWHERE host by connecting to the 
gateway’s modem. From this window you also create and maintain a 
list of gateway connection items.

■ Remote Networking: Click when you want to connect to a network 
as a remote node. With a remote networking connection, your 
remote PC becomes a workstation on the network, with access to 
network files and services. 

pcANYWHERE integrates remote control and remote networking 
technologies to enhance the performance of the session. (See “Remote 
networking” on page 83 for information on remote node connections.)

■ Call Online Service: Click to connect with bulletin board services 
(BBSs), information services such as CompuServe, and other multi-
user systems such as mainframes and minicomputers. From this 
window you also create and manage a list of one or more online 
service connection items to choose from for online sessions. (See 
“Online services” on page 153, and “File transfers and session 
management” on page 91, for more information.)
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pcANYWHERE32 connection items
Once you click a button, the main window displays a wizard icon for the 
selected action, as well as icons for any connection items created for the 
action. A connection item represents a pcANYWHERE file containing 
connection device information and security settings for a connection. It 
consists of an icon and a name.

Figure 1-2 pcANYWHERE connection items

Every connection item has a properties sheet associated with it containing 
the settings configured for the item. 

All pcANYWHERE connection items can be dragged or copied from the 
pcANYWHERE main window to the Windows 95 desktop or a folder. 

Be A Host 
connection 
items

Double-click to 
start the Be A 
Host wizard

Right-click on a connection 
item to view the context menu. 
Choose Properties to add or 
modify the settings of the 
connection item
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Protecting connection items
Every connection item has a Protect Item property page on the item’s 
properties sheet that allows you to assign a password to the item to protect it 
from unauthorized use. You can use the same password for all your 
connection items, regardless of what mode they are in. Using the same 
password is easier than having to remember multiple passwords.

A password can be used to prohibit the connection item’s properties from 
being modified or viewed as well as prevent the execution of the connection 
item. 

To password protect a connection item:

1 Click the connection item you want to protect.

2 Do one of the following:

■ Right-click the selected item and choose PROPERTIES from the 
context menu.

■ Select PROPERTIES from the File menu.

3 Click the Protect Item tab.

Figure 1-3

4 Type a password in the Password text box.
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5 Retype the password in the Confirm Password text box to confirm it.

6 Check the level of protection you want.

■ Required To View Properties: Check to require a user to enter the 
correct password to view the properties on this connection item.

■ Required To Execute: Check to require a user to enter the correct 
password before running the connection item.

■ Required To Modify Properties: Check to require a user to enter 
the correct password before modifying any of the properties for 
this connection item. This selection is grayed when the Required 
To View Properties box is checked.

Getting online help
In addition to technical support options that are described in the back of this 
manual, pcANYWHERE for Windows 95 and Windows NT provides an 
excellent online help system.

To get help at any point in pcANYWHERE you can:

■ Choose CONTENTS from the Help menu to access the table of 
contents.

■ Click the Index or Find tabs and search for a procedure or feature.

■ Right-click any option or area of a window, then click What’s This 
for a description of the option and its function in pcANYWHERE.

■ Click Help from any dialog box for pointers on how to set the 
options in that dialog box.

■ Consult the Reference book section of help for the answers to 
frequently asked questions.

Quick Start wizards
You can use pcANYWHERE’s Quick Start wizards to quickly make a remote 
control, file transfer, gateway, or online service connection. 

The Quick Start button displays a list of available wizards.
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Figure 1-4 List of pcANYWHERE wizards

When executed, a wizard creates a connection item by asking the user to 
provide the minimum configuration information necessary to establish a 
connection. 

If you want to take advantage of all the commands and features available in 
pcANYWHERE, please read the appropriate chapters of this manual or refer 
to online help before proceeding.

To run a wizard:

1 Do one of the following procedures:

■ Click the Quick Start action button and select the wizard you 
want to run from the list (see Figure 1-4).

■ Click any action button and double-click the add item wizard 
icon.

2 Follow the on-screen prompts.

Be A Host PC wizard
Run the Add Be A Host PC Item wizard when you want to be a host PC and 
wait for a call from a remote caller. The host wizard prompts you for the 
following connection item information: 

■ Name: Provide a brief, descriptive name for the connection item.

Use the 
wizards to 
automatically 
configure and 
run a 
connection 
item
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■ Connection Device: Choose the device the connection item uses to 
make connections.

Remote control wizard
Run the Add Remote Control Item wizard when you want to call a host PC 
and begin a remote control session. The remote control wizard prompts you 
for the following connection item information:

■ Name: Provide a brief, descriptive name for the connection item.

■ Connection Device: Choose the device the connection item uses to 
make connections.

■ Phone Number: Enter the phone number of the host PC if you want 
the connection item to automatically dial the host. If a phone 
number is not provided here, you are prompted for one each time 
you run the remote control connection item.

File transfer wizard
Run the Add File Transfer Item wizard when you want to call a host PC and 
immediately begin transferring files to or from the host. The file transfer 
wizard prompts you for the following connection item information: 

■ Name: Provide a brief, descriptive name for the connection item.

■ Connection Device: Choose the device the connection item uses to 
make connections.

■ Phone Number: If you have selected a modem connection device, 
provide the host’s phone number if you want the connection item to 
dial the host automatically. If a phone number is not provided, you 
are prompted for one each time you run the remote control 
connection item.

■ Host Name: If you have selected a network connection device, 
provide a host name if you want the connection item to connect to 
the host automatically. If a host name is not provided, you can select 
a host from a list of available hosts.

NOTE: Remote control and file transfer share the same connection items. 
When the connection item is started from the remote control window, the 
session begins in remote control mode. When the connection item is started 
from the file transfer window, the session begins in file transfer mode. 
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Online service wizard
Run the Add Online Service Item wizard when you want to call a bulletin 
board service (BBS), or other online computer service, for the purpose of 
obtaining and exchanging information. An online service session is not a 
remote control session as you do not remotely operate the online service 
computer. The online service wizard prompts you for the following 
connection item information:

■ Name: Provide a brief, descriptive name for the connection item.

■ Connection Device: Choose the device the connection item uses to 
make connections.

■ Phone Number: Enter the phone number of the online service if you 
want the connection item to dial the service automatically. If a 
phone number is not provided here, you are prompted for one each 
time you run the remote control connection item.

■ Terminal Emulation: Choose the terminal emulation required for this 
online service. 

Gateway wizard
Run the Add Gateway Item wizard when you want to configure your PC as a 
gateway on the network. A pcANYWHERE gateway PC allows network users 
to share the gateway PC’s communications device, and provides dial-in and 
dial-out services. The gateway wizard asks for the following connection item 
information:

■ Name: Provide a brief, descriptive name for the gateway connection 
item.

■ Bidirectional Operation: Designate if this gateway is to allow both 
incoming and outgoing calls. 

■ Incoming Connection Device: Choose the device to use for the 
gateway’s incoming calls.

■ Outgoing Connection Device: Choose the device to use for the 
gateway’s outgoing calls. 

What’s new in this version
■ Strong Encryption: Increases security using Microsoft’s cryptography 

API.

■ NT Caller Security: Integrates pcANYWHERE remote callers with 
Windows NT User and Group Security.



Chapter 1.  Welcome to pcANYWHERE32 17
■ Live Update Integration: Automates downloads of pcANYWHERE32 
software updates.

■ Voice First Connections: Allows switching between voice and data 
during a single phone call. 

■ Host Conferencing: Allows multiple remotes to connect to and view 
the activities on one host. 

■ Improved Mouse Control: Synchronizes the remote’s mouse 
configuration with the host’s.

■ Optimized Desktop Control: Increases connection speed and host 
desktop navigation by reducing the host’s display settings to match 
the remote display settings. 





 automatically 
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Installation 
pcANYWHERE32 files are shipped in a compressed format and
decompressed during the installation process. Therefore, to install and run 
pcANYWHERE on your computer, you must first run the installation program. 
Do not just copy pcANYWHERE files into a directory on your hard disk. 

This chapter covers the following procedures:

■ Standard installation of pcANYWHERE: Use a standard installation 
when you are installing on an individual computer and are not 
sharing pcANYWHERE data files with other users.

■ Network administrator installation: Use an administrator installation 
when you are installing pcANYWHERE to a network drive and are 
creating pcANYWHERE shared data files. 

■ Network workstation installation: Use a workstation installation on a 
PC connected to a network after the network administrator has done 
the administrator installation. 

Uninstalling pcANYWHERE32: Use the uninstall program to remove 
pcANYWHERE files as well as other files associated with the 
pcANYWHERE32 installation.

System requirements

Minimum required hardware
■ 386 or higher microprocessor

■ 4 MB RAM

■ VGA or higher resolution display adapter

■ Hard disk drive, one CD ROM drive

■ At least 20 MB free disk space

Recommended hardware
■ 486, Pentium, or higher microprocessor

■ 8 MB RAM or higher

■ 20 MB free disk space
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Required software

■ Windows 95 or Windows NT 3.51 or later

Standard installation of pcANYWHERE32 
Use the standard installation of pcANYWHERE32 to create and maintain your 
own pcANYWHERE configuration files. Standard installation can be used 
even if your PC is connected to a network.

If you are a network administrator and you want to create and control 
pcANYWHERE configurations for all users on the network, see “Network 
administrator installation” on page 23. 

To perform a standard installation of pcANYWHERE: 

1 Insert the CD into your computer’s CD ROM drive.

2 Make sure that Windows 95 or Windows NT is running on your 
computer.

3 Do one of the following procedures:

■ If Windows AutoPlay is enabled, click Install Software on the 
pcANYWHERE32 installation screen.

■ If Windows AutoPlay is not enabled, choose RUN from the 
Windows 95 or Windows NT 4.0 Start menu and type 
D:\cdinst.exe in the Open text box, click OK and follow the 
on-screen instructions.

Figure 2-1

Licensing pcANYWHERE32

The pcANYWHERE32 for Windows 95 and Windows NT program requires 
that you provide licensing information before continuing with the 

Click Browse if you 
want to install 
pcANYWHERE 
from a different 
folder
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installation. This installation entitles you to use pcANYWHERE on two 
computers: a host and a remote. 

To license your copy of pcANYWHERE:

1 Type your name in the Name text box.

Figure 2-2

2 Type your company’s name in the Company text box (optional).

3 Click Next to continue with the installation.

Specifying the program folder
After you enter the license information for your copy of pcANYWHERE, the 
installation program asks for the name of the folder where the files will be 
copied. A suggested folder is displayed in the Program Location dialog box. 
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Figure 2-3 Location for pcANYWHERE32

To accept the displayed program folder:

■ Click Next to proceed with the installation. pcANYWHERE is 
installed in the folder with the name that appears in the text box.

To change the program location:

1 Click Browse to select a new folder.

2 Click Next to continue with the installation.

The installation program copies the files to the specified folder and creates 
the following subfolders:

■ Data: The default subfolder for connection item configuration 
information. (See Chapter 1, “Welcome to pcANYWHERE32” on 
page 9 for information on connection items.)

■ Download: The default subfolder for files downloaded from an 
online service.

Registering your copy of pcANYWHERE32

As a registered user you receive future product announcements and other 
important notices. If you choose to skip registration now, you can register 
later by selecting ONLINE REGISTRATION from the Help menu. 
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After completing the registration forms, you can choose:

■ Modem: To register your copy of pcANYWHERE32 for Windows 95 
and Windows NT 4.0 directly from your computer and send the 
registration information electronically to our toll-free number.

■ Fax Or Mail: To send the registration information to your printer. You 
can then either fax or mail it to the address provided on the printed 
registration form.

■ Internet: To send the registration information through the Internet 
using a LAN (Local Area Network) or RAS (Remote Access Server) 
connection.

NOTE: The installation makes changes to the SYSTEM.DAT and 
USER.DAT files in your Windows 95 folder. The original files are 
backed up with the file names SYSTEM.PCA and USER.PCA.

Network administrator installation
This section explains how to perform an administrator installation of 
pcANYWHERE32 to your network. To install the program as an administrator, 
you need full access privileges to the network. The pcANYWHERE32 
program files and options set during the administrator installation affect every 
network user who runs pcANYWHERE.

To install pcANYWHERE on a network:

1 Insert the CD into your computer’s CD ROM drive.

2 Make sure that Windows 95 or Windows NT is running on your 
computer or workstation.

3 Choose RUN from the Windows 95 or Windows NT 4.0 Start menu.

4 Type D:\installs\pca32\disk1\setup.exe /A in the Open 
text box (see Figure 2-1) and click OK.

5 Enter the necessary licensing information. (See “Licensing 
pcANYWHERE32” on page 20 for information.)

6 Choose the network folder where you want to install pcANYWHERE. 
(See “Specifying the program folder” on page 21.) 

NOTE: This folder must be accessible to all users performing a 
pcANYWHERE workstation installation.

Network
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7 Click Next to continue the installation.

The installation program copies the files to the specified folder and 
creates the following subfolders:

■ Data: Default subfolder for connection item configuration 
information. (See Chapter 1, “Welcome to pcANYWHERE32” on 
page 9 for information on pcANYWHERE’s connection items.)

■ Setup: Contains the SETUP.EXE file that installs pcANYWHERE to 
individual network workstations. (See “Installing 
pcANYWHERE32 on network workstations” on page 26 later in 
this chapter for details.)

8 Register your copy of pcANYWHERE. (See “Registering your copy of 
pcANYWHERE32” on page 22.)

Installing pcANYWHERE32 Five-Node Add-on
pcANYWHERE32 Five-Node Add-On disks are available to extend your 
license agreement. Each Add-On licenses five additional users.

To install the Five-Node LAN Add-On disk:

1 Insert the pcANYWHERE32 Add-On disk into the computer’s floppy 
disk drive.

2 Choose RUN from the Windows 95 or Windows NT 4.0 Start menu.

3 Type A:\Setup in the Open text box.

4 Type the location of the pcANYWHERE32 network installation in the 
Install To text box and click OK.

A message appears confirming installation. You can choose ABOUT 
PCANYWHERE from the Help menu to verify the number of licenses.

Configuring administrator options
The pcANYWHERE administrator can customize the network version of 
pcANYWHERE and control the availability and use of connection items. 

The pcANYWHERE administrator can:

■ Allow users to name their computers.

■ Define a default folder for connection items.
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■ Allow a user to select a different folder.

■ Protect connection items with a password to prevent users from 
modifying connection item properties.

To configure administrator options:

1 Perform a workstation installation of pcANYWHERE32. (See “To 
install pcANYWHERE32 on a workstation:” on page 26 for 
instructions.)

NOTE: After installing pcANYWHERE32 to the network, you must 
perform a workstation installation on the administrator’s PC before 
administrator options can be configured. 

2 Choose RUN from the Windows 95 or Windows NT 4.0 Start menu.

3 Type netpathname\WINAW32.EXE /A in the command line text 
box and click OK. (Replace netpathname with the network drive 
and folder that contains the network installation of pcANYWHERE.)

4 Type the administrator password in the Enter Administrator 
Password text box.

NOTE: The administrator password is case-sensitive. The first time 
you run pcANYWHERE with the /A administrator option, you are 
asked to confirm the password.

5 Choose SHARED DATA from the Administrator menu.

Figure 2-4
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6 Check Allow Folder Change to allow users to use a different folder 
for their connection items. (See Chapter 1, “Welcome to 
pcANYWHERE32” on page 9 for information on pcANYWHERE’s 
connection items.)

7 Do one of the following procedures:

■ Type a folder to use as the default folder for Remote Control 
connection items. 

■ Click Browse to select a default folder.

8 Repeat steps 6 through 7 for the Online Service, Be A Host PC, and 
Gateway property pages.

9 Click the Computer Name Selection tab.

10 Choose one of the following options:

■ Allow User Defined: Allows the user to provide any name for an 
individual PC. 

■ Windows Computer Name Only: Causes pcANYWHERE to 
automatically use the computer name provided in the 
Windows 95 and Windows NT installation.

Installing pcANYWHERE32 on network workstations
After the administrator has installed pcANYWHERE32 on the network and has 
configured the shared data files, users on the network can install 
pcANYWHERE on their local workstations. 

A workstation installation must be performed at each individual PC that is 
running pcANYWHERE32 from the network. This section explains how to 
perform workstation installations. Before beginning, be sure your network 
administrator has completed the network installation.

Note: Ask your network administrator which network drive and folder 
(netpathname) contains the pcANYWHERE program files.

To install pcANYWHERE32 on a workstation:

1 Choose RUN from the Windows 95 or Windows NT 4.0 Start menu.

The Run dialog box appears (see Figure 2-1).

2 Do one of the following procedures:

■ Enter netpathname\SETUP\SETUP.EXE in the command line 
text box and click OK. (Replace netpathname with the network 

Network
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drive and folder that contains the network installation of 
pcANYWHERE. Ask your network administrator for help if 
necessary.)

■ Click Browse to locate the correct drive and folder and select the 
SETUP.EXE file. 

3 Click OK and follow the on-screen instructions.

4 Type the necessary licensing information. (See “Licensing 
pcANYWHERE32” on page 20.)

5 Select the folder where you want to install pcANYWHERE. (See 
“Specifying the program folder” on page 21.)

6 Do one of the following:

■ Click Next to allow pcANYWHERE to wait as a host before 
logging on to Windows or the network.

■ Click Skip to continue the installation. You can still use the 
pcANYWHERE host but only after you log on to Windows and 
your network.

7 Click Next. 

The installation program copies the files to the specified folder and 
creates the following subfolders:

■ Data: The default subfolder for connection item configuration 
information. (See “pcANYWHERE32 connection items” on page 
11 for information on pcANYWHERE’s connection items.)

■ Download: The default subfolder used for files downloaded from 
an online service.

To uninstall pcANYWHERE32:

1 Choose PROGRAMS from the Windows 95 or Windows NT 4.0 Start 
menu.

2 Point to the PCANYWHERE32 folder.

3 Point to REMOVE PCANYWHERE and release the mouse button.

To run pcANYWHERE32 from Windows 95 or Windows NT:

1 Choose PROGRAMS from the Windows 95 or Windows NT 4.0 Start 
Menu.

2 Point to the PCANYWHERE32 folder.

3 Point to PCANYWHERE32 and release the mouse button.
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The first time you start pcANYWHERE32 after installation, the 
pcANYWHERE Smart Setup Wizard appears to help you configure your 
PC with basic connection device information. 

Figure 2-5

4 Do one of the following procedures:

■ Click Next if your operating system has added your modem to the 
Modem text box.

■ Click Add Modem to have Windows 95 detect your modem or to 
select your modem from a list of modems supported by 
Windows 95.

5 Select a default network device for this PC to use for network 
connections. You can select other network protocols at any time 
from the pcANYWHERE program. (See “Network devices” on page 
34 for information on network protocols.)

6 Select a port to use for your direct cable connections. You can select 
other ports at any time from the pcANYWHERE program. (See 
“COM1 through COM4 serial devices” on page 32 for information on 
communication ports.)

7 Click Finish.

To run pcANYWHERE32 from Windows NT, version 3.51:

1 Do one of the following procedures:

■ Double-click the pcANYWHERE program icon in the 
pcANYWHERE program group.

The Smart Setup 
Wizard only executes 
the first time you start 
pcANYWHERE after 
installation

If your operating 
system has detected 
your modem during 
installation, 
pcANYWHERE 
automatically adds it 
to your connection 
device list
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■ Choose RUN from the Program Manager File menu, type 
pathname\WINAW32.EXE in the command line text box and 
click OK.

The first time you start pcANYWHERE32, the pcANYWHERE Smart 
Setup Wizard appears to help you configure your PC with basic 
connection device information. 

2 Select the serial port your PC is using for modem connections from 
the Com Port drop-down list.

3 Select your modem from the drop-down list box. If your modem is 
not listed, choose the generic modem that most closely emulates 
your modem. 

4 Click Next to continue the wizard.

5 Select a default network device for this PC to use for network 
connections. You can select other network protocols at any time 
from the pcANYWHERE program. (See “Network devices” on page 
34 for information on network protocols.)

6 Select the serial port your PC is using for direct cable connections 
from the Com Port drop-down list.

7 Click Finish to close the Smart Setup window and return to the 
pcANYWHERE32 main window. 
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Connection devices
This chapter describes the settings found in the Connection In
page. This property page is located in the properties sheet of all connection 
items and determines what hardware device the connection item uses to 
make connections. 

Windows 95 and NT 4.0 Connection Info 
property page

Before you can make a connection, pcANYWHERE must know what 
communication device to use. Every connection item has a properties sheet 
associated with it that contains all the information and settings needed to 
make a connection.

To configure connection information for Windows 95 and Windows 
NT 4.0:

Do one of the following:

■ Choose NEW from the File menu to configure a new connection item.

■ Right-click a connection item and choose PROPERTIES from the 
context menu to modify an existing item.
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Figure 3-1

NOTE: Windows NT does not support IPX, NASI/NCSI, or parallel port (LPT) 
connections.

TAPI modem definition
If your modem was connected to your PC when you installed Windows 95 or 
Windows NT 4.0, the operating system added a modem in the Modems 
folder of the Windows 95 and Windows NT control panel. pcANYWHERE32 
automatically adds this modem definition to the top of the list of devices on 
the Connection Info property page. Choose this modem definition for 
modem connections (see Figure 3-1).

If your modem was not present at the time of the Windows installation, or if 
your modem has changed since the installation, edit or add a modem 
definition using the Windows 95 or Windows NT 4.0 control panel. 

COM1 through COM4 serial devices
Modem definitions and serial ports are controlled in the Windows 95 and 
Windows NT 4.0 control panel. The modem definition listed in the device list 

Choose the 
modem 
definition for 
modem 
connections if 
your operating 
system has 
provided one
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also includes the correct serial port. (See “TAPI modem definition” on page 
32 for details.)

pcANYWHERE32 can make both serial and parallel direct connections in 
Windows 95. COM1 through COM4 are for serial direct connections using a 
null modem cable. LPT1 through LPT4 are for parallel direct connections 
using a special parallel cable. (See “LPT1 through LPT4 parallel connections” 
on page 34.) 

Parallel connections for Windows NT are not supported. Please refer to the 
Reference book section of online help for important information on 
Windows NT.

To configure COM1 through COM4:

1 Check the serial communications port your PC uses for serial 
connections.

2 Click Details.

Figure 3-2

3 Choose from the following connection preferences:

■ Speed: Most newer machines can handle speeds of 38,400 and 
higher.

■ Parity: Set to None for pcANYWHERE remote control sessions. 
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■ Flow Control: Set to RTS/CTS for pcANYWHERE remote control 
sessions.

■ Started By: Select a method by which the communication session 
begins. The default is carrier detect. Refer to online help or your 
modem’s manual for more information on the available settings.

■ Ended By: Select a method by which the communication session 
ends. The default is carrier detect. 

4 Do one of the following:

■ Click Apply to save connection info settings and leave the 
connection item’s properties sheet open.

■ Click OK to save all settings and return to the pcANYWHERE 
main window.

LPT1 through LPT4 parallel connections
Parallel port connections are used to direct-connect two computers using a 
parallel cable. A parallel cable significantly increases the performance of 
pcANYWHERE when using a parallel port to connect two computers.

NOTE: To communicate between the two computers bi-directionally, you 
must configure the parallel port in the BIOS for bi-directional operation and 
use a bi-directional parallel cable.

To configure LPT1 through LPT4:

■ Check the parallel communication port your PC uses for direct 
connections and click OK. 

Network devices
Network devices are used by PCs that are attached to a network. For 
example, your PC can connect to other computers on that network or use 
network communication devices such as a pcANYWHERE gateway, or Novell 
NetWare Connect, to connect to computers that are not on the network.

To configure IPX, SPX, NetBIOS, Banyan, and TCP/IP network 
devices:

1 Click the Remote Control action button.
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2 Right-click a connection item and choose PROPERTIES from the 
context menu.

3 Check the network protocol your PC uses.

4 Click Details. (The Details button is grayed on Be A Host connection 
items.)

Figure 3-3

■ Use Gateway: Check this box if you plan to use a gateway for 
communicating out of the network through an outbound 
gateway.

■ Name: Enter the gateway name to have pcANYWHERE select that 
gateway automatically. If no name is entered, a list of available 
gateways is presented. Enter an asterisk (*) to allow 
pcANYWHERE to select any gateway.

■ Class: Enter the gateway classification if several gateways exist 
with different classes. If no class is entered, a list of available 
gateways and classes is presented. Enter an asterisk (*) in the 
Class text box to have pcANYWHERE select any class.

■ Parity: Click the Parity prompt button to select a parity different 
from that set under the gateway’s outgoing list device. Parity 
should be set to None for pcANYWHERE remote control 
connections. 

Check if you want 
to connect to a 
gateway PC and 
use the gateway’s 
modem to call out 
of the network
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NOTE: An Options property page appears when NetBIOS is selected 
as the network device. This property page contains a setting that 
allows a user to use a LAN Adapter Number (LANA) that is 
configured in the Windows 95 or Windows NT operating system. 

To configure NASI/NCSI network devices:

1 Check NASI/NCSI in the device list.

2 Click User.

Figure 3-4

3 Type the following information:

■ User Name: Enter the name that you use to login to the 
NASI/NCSI server. See your network administrator for your login 
information.

■ Password: Enter your password on the NASI/NCSI server.

■ Session Name: Enter a name for this session. This name is listed 
as an available workstation session after you log on to the server. 

4 Check Session Name Is Available To All Users to make this 
workstation session available to all callers after connecting to the 
NASI server.

5 Click the Details tab.

NetBIOS

Enter your network user 
name and the password 
that identifies you on the 
NetWare Connect server

The session name identifies 
the workstation

Check to allow 
other users to 
view your session 
name
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Figure 3-5

6 Check any of the following options:

■ Server: Check to enter a server name. Click the Browse  button to 
select from a list of currently available servers. Select <Any> to 
have pcANYWHERE select the first available server.

■ Service: Check to enter the modem group name. Click the Browse  
button to select from a list of currently available services. Select 
<Any> to have pcANYWHERE select the first available service.

■ Port: Check to enter a port name. Click the Browse  button to 
select from a list of currently available ports. Select <Any> to have 
pcANYWHERE select the first available port.

■ Select When Connecting: Allows the remote caller to select the 
server, service, and port at the time of connection.

NOTE: If you plan to wait for a connection as a host, pcANYWHERE 
requires that you preselect a specific server, service, and port, or a 
NetWare connect dial-in group. Do not select the <Any> options if 
you use different logins and passwords on multiple servers. 

ISDN connections
Integrated Services Digital Network (ISDN) is a digital telecommunication 
network that is becoming increasingly popular because of its ability to 
transmit data at speeds up to 10 times faster than modems. pcANYWHERE32 
supports ISDN connections using Common ISDN Application Programming 
Interface (CAPI) 2.0 devices. 
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To configure ISDN using CAPI 2.0 devices:

1 Check ISDN Via CAPI 2.0 in the device list.

2 Click Details.

Figure 3-6

3 Check Attempt Channel Bonding if you want pcANYWHERE to 
attempt to combine two 64K channels into a single channel 
providing for a 128K bps transmission. Channel bonding cannot 
occur if the second channel is unavailable. Check the transmission 
rate to determine if channel bonding was successful. Leave this 
option unchecked if you want the second channel to remain free for 
other communications.

4 Type in Multiple Subscriber Number (MSN) extensions if you want to 
restrict incoming calls to only those extensions. Use a semicolon or 
comma to separate the extensions. If no extension numbers are 
provided, connections are made to any MSN extension. 

Infrared Connections
pcANYWHERE32 automatically detects the presence of the Microsoft Infrared 
communications driver.

Windows NT 3.51 Connection Info property 
page

The connection devices listed in the connection info property page 
for Windows NT, version 3.51, differ slightly from the devices listed for 
Windows 95 and Windows NT, version 4.0. Windows NT, version 3.51, does 
not support TAPI modem definitions, IPX connections, NASI/NCSI 
connections, or parallel port (LPT) connections. 
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To configure connection information for Windows NT, version 3.51:

Do one of the following:

■ Choose NEW from the File menu to configure a new connection item.

■ Right-click a connection item and choose PROPERTIES from the 
context menu to modify an existing item.

Figure 3-7

COM1 through COM4 serial devices
pcANYWHERE32 uses the COM1 through COM4 serial ports to make modem 
connections and direct cable connections in Windows NT, 3.51. 

To configure COM1 through COM4:

1 Check the serial communications port your PC uses for serial 
connections.

2 Click Details.
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Figure 3-8

3 Choose from the following connection preferences:

■ Speed: Start with the default setting. If you experience connection 
problems, lower the speed.

■ Parity: Set to None for pcANYWHERE remote control sessions. 

■ Flow Control: Set to RTS/CTS for pcANYWHERE remote control 
sessions.

■ Started By: Select a method by which the communication session 
begins. The default is carrier detect. Refer to online help or your 
modem’s manual for more information on the available settings.

■ Ended By: Select a method by which the communication session 
ends. The default is carrier detect. Refer to online help or your 
modem’s manual for information on the settings available.

4 Check Use Modem and choose your modem from the Use Modem 
drop-down list box (see Figure 3-8). If the name of your modem 
does not appear in the list, consult your modem’s manual for an 
alternative choice.

5 Click Advanced to change the advanced settings if necessary. Refer 
to your modem’s manual for more information on these advanced 
modem settings.
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6 Click OK.

For details on configuring SPX, NetBIOS, Banyan VINES, TCP/IP, ISDN with 
CAPI 2.0, and Infrared connections, see “Windows 95 and NT 4.0 Connection 
Info property page” on page 31.
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Configuring the host
Before you can begin a remote computing session with a remote
must first create a host connection item. A host connection item is a file 
containing connection device information and security settings for the host. 
With pcANYWHERE32, you can create several host connection items, each 
using a different configuration. For example, you can have a host configured 
to make a modem connection and another to make network connections.

Creating host connection items
You can create connection items manually, or you can run the Add Be A 
Host PC wizard (Figure 4-1). The wizard allows you to configure the name 
and connection device for the connection item, and uses default settings in 
the remaining property pages. (See “Quick Start wizards” on page 13 for 
more information on wizards.)

To customize the default settings, you can edit the connection item’s 
properties.

TIP: You can customize the defaults used by the wizard connection item so 
that every new connection item created by the wizard uses the customized 
settings. (See “To modify a connection item’s properties:” on page 44 for 
details.)

To create a new be a host connection item:

1 Click the Be A Host PC action button.

2 Do one of the following:

■ Double-click the Add Be A Host PC Item icon to create a new 
connection item using the wizard.

■ Choose NEW from the File menu.

■ Right-click in the Be A Host PC window and choose NEW from 
the context menu.
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To modify a connection item’s properties:

Do one of the following:

■ Right-click the connection item and choose PROPERTIES from the 
context menu.

■ Click the connection item and choose PROPERTIES from the File 
menu.

Figure 4-1

The host connection item properties sheet contains six property pages:

Connection Info: Allows you to select the hardware device this host 
connection item will use for each session. A host can wait for a connection 
on two separate devices. 

Settings: Allows you to configure host options for every remote control 
session in which the host item engages.

Callers: Allows you to give callers all rights on the host after connecting, or 
specify the rights available to each individual caller.

Security Options: Allows you to set the security options for all remote control 
sessions this host engages in.

A pcANYWHERE32 
host can wait on 
two devices for an 
incoming call
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Conference: Allows you to configure a multicast IP address for the host to 
allow multiple remotes to view the activity on the host.

Protect Item: Allows you to protect the selected host connection item with a 
password.

To configure host connection info:

1 Open the host item’s properties sheet (see “To modify a connection 
item’s properties:” on page 44). 

2 Choose the communication devices this host item uses to wait for a 
call. The pcANYWHERE32 host can wait on two separate devices for 
an incoming call. (See Chapter 3, “Connection devices,” on page 31 
for more information on configuring connection devices.)

NOTE: When the host connects to a remote using one device, the 
second device is not available until the first session ends.

To configure host settings:

1 Open the host item’s properties sheet (see “To modify a connection 
item’s properties:” on page 44). 

2 Click the Settings tab.
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Figure 4-2

3 In the Host Startup group box, select the options you want to 
configure for this host connection item.

■ Launch With Windows: Causes the host to load and wait for a call 
automatically each time you start your PC.

■ Use Windows Screen Saver: Causes your Windows 95 screen 
saver to launch whenever the host is waiting for a call. Add a 
password to your screen saver to lock the host and prevent 
unauthorized users from canceling the waiting host.

■ Lock NT Workstation: Prevents unauthorized users from canceling 
the waiting host by locking the NT Workstation with a password. 

■ Run Minimized: Causes the host to appear on the desktop as an 
icon when it is waiting for a connection. If this option is 
unchecked, pcANYWHERE displays a status dialog box.

■ Run As A Service: Configures the host to run as an NT Service. 
This option is enabled by default and is a required option if you 
want to launch the host with Windows.

4 In the Modem Connection group box type the number of seconds 
the host waits before making a call back to the remote PC. This 
setting is ignored if the Call Back The Remote User option is not 
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checked in the Callback property page on the Caller properties 
sheet. (See “Modifying caller properties” on page 54.) 

5 In the In Session group box select which keyboard and mouse is 
active during the session. The default setting is Host And Remote.

6 Select how you want to leave the host after an unintentional loss of 
connection occurs or after ending a remote control session: 

■ Wait For: [0] Minutes: Allows the host to set the number of 
minutes to wait after an abnormal disconnect before continuing 
with one of the End Of Session options described above. 

■ Cancel Host: Cancels the host. Other connections are not possible 
when the host is canceled.

■ Wait For Call: Causes the host to wait for another call. 

7 Select what security measures to enable after an unintentional loss of 
connection occurs or after ending a remote control session:

■ Logoff User: Causes the host to log the current host user off the 
network, preventing unauthorized access to the user’s network 
privileges. 

■ Restart Host Computer: Causes the host PC to restart. If you want 
the host PC to wait for another call after restarting, check the 
Launch With Windows option.

■ Use Windows Screen Saver: Causes your Windows 95 screen 
saver to launch whenever the host is waiting for a call. Add a 
password to your screen saver to lock the host and prevent 
unauthorized users from canceling the waiting host.

■ Lock NT Workstation: Prevents unauthorized access to the 
workstation by locking the NT workstation with a password. 

Configuring host security options
Some security options determine if the remote user can blank the host screen 
or encrypt data. Other options regulate passwords and prompts.

To configure the security options:

1 Click the host connection item you want to configure.

2 Do one of the following:

■ Right-click the selected item and choose PROPERTIES from the 
context menu.

■ Choose PROPERTIES from the File menu.
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3 Click the Security Options tab.

Figure 4-3

4 Check the connection options you want for this host connection 
item.

■ Blank This PC Screen After Connection Made: Improves the 
security of unattended host sessions by blanking the host PC’s 
monitor display.

■ Log Failed Connection Attempts: Causes the host to create a log 
file containing information on unsuccessful attempts to connect.

■ Prompt To Confirm Connection: Sends a message to the host 
operator that a connection is being requested by a remote. When 
this option is checked and a remote user attempts a connection, 
the host user receives an alert of the impending connection and 
provides a Yes/No prompt from which the host can choose to 
allow the connection or not.

■ Timeout: Specifies how long the host operator has to respond to 
the Yes/No prompt. The default value is 10 seconds.

■ Disconnect If Timeout: Unchecked, a connection is made 
automatically after the timeout expires. If checked, the remote 
caller is disconnected after the expiration of the specified timeout 
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period. This option is grayed if the Prompt To Confirm 
Connection option is not checked. 

5 Check the login options you want for this host connection item:

■ Make Passwords Case Sensitive: Specifies that passwords must be 
entered with the correct combination of uppercase and lowercase 
letters.

■ Limit Login Attempts Per Call: Specifies how many log in attempts 
the user may make. The default value is 3 attempts. 

■ Limit Time To Complete Login: Specifies the time a user has to 
log in successfully. The default value is 3 minutes. 

6 Choose one of the following encryption levels:

■ Public Key: Provides the highest level of security and is used 
when a certificate authority makes public keys available to the 
Cryptographic Service Provider (CSP) on both host and remote 
sides of the session.

■ Symmetric: Provides the next level of security and is used when 
there is no certificate authority available but there is a 
Cryptographic Service Provider available.

■ pcANYWHERE: Provides minimum encryption capability and is 
used when there is no Cryptographic Service Provider available. It 
is the only level compatible with pcANYWHERE versions 2.0, 5.0, 
and 7.x.

■ Deny Lower Encryption Level: Causes the host to deny 
connections from computers not using the same level of 
encryption as the host. If not checked, the host allows 
connections from computers using a lower level of encryption. 

■ Private Key Container: Select a private key from the list of 
currently installed private keys.

■ Certificate Common Name: Type the name associated with the 
selected private key. This is the name provided to the Certificate 
Authority at the time the certification was requested This option is 
case sensitive; type the name exactly as you provided it to the 
Certificate Authority.

NOTE: Some encryption options are not supported in Windows 3.51.

7 Check the session options you want for this host connection item:

■ Allow Any Caller To Reconnect: Allows any caller to connect to 
the host after a remote computing session is unexpectedly 
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disconnected. If this option is not checked, only the caller that 
was signed on to the host at the time of the disconnect can 
reconnect. This prevents unauthorized viewing of information left 
on the host screen at the time of the disconnect.

■ Disconnect If Inactive: Specifies the timeout period. 
pcANYWHERE32 automatically disconnects the session when no 
screen data has changed or no keystrokes have been entered for 
the number of minutes specified. Establishing an inactivity 
timeout period keeps the telephone line free in case the remote 
user forgets to end the session. This timeout can be enforced on 
an individual caller basis by checking the Caller Subject To 
Inactivity Timeout check box in the Advanced property page of 
the caller’s properties sheet. (See “Modifying caller properties” on 
page 54.) The default is 10 minutes of inactivity before 
disconnection occurs.

Configuring the host for conference sessions
A conference host allows multiple remote users to simultaneously connect 
and view the host activities. For example, the host user can conduct a 
software training demonstration that can be viewed by any remote caller 
connected to the host PC. 

Unlike a standard pcANYWHERE host, a conference host is only remotely 
controlled by the first remote caller to connect. Subsequent remote callers 
can only view the activity on the host screen and can use some utility 
functions such as saving screens and recording sessions.

NOTE: The first caller can connect using any connection device. Other 
callers connecting to view the activities on the host must make a TCP/IP 
network connection.

To configure a conference host:

1 Click the host connection item you want to configure.

2 Do one of the following:

■ Right-click the selected item and choose PROPERTIES from the 
context menu.

■ Choose PROPERTIES from the File menu.

3 Click the Conference tab.
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Figure 4-4

4 Check Enable Conferencing to allow multiple callers to connect and 
view the activities on this host. 

5 Do one of the following procedures:

■ Click Obtain IP Address Automatically to automatically select an 
IP address from any valid Class D addresses.

■ Click Specify IP Address to type an IP address within the range of 
225.1.1.1 through 239.254.254.254.

6 Type the number of routers to include in the conference area.

Protecting the host connection item
Each host item can be password-protected from use by others. Host items 
can have the same password or each can be given a unique password. Please 
see “pcANYWHERE32 connection items” on page 11 for information on 
password protecting connection items.

Configuring host callers
As the host PC, you control who can connect to the host PC and limit the 
amount of control for each individual caller. You can grant full access rights 
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to all callers, or you can specify rights for each individual caller. When the 
Specify Individual Caller Privileges option is selected, only the callers 
selected by the host user can connect to the host item. Each caller is assigned 
a password and login name that identifies the remote caller to the host. 
Security of the host is significantly enhanced when the host enables the 
individual caller privileges option. 

If you are running Windows NT, you can use the Windows NT user and 
group security features. In addition, access to the host can be monitored 
using the security facilities in the Windows NT User Manager. See “To 
configure Windows NT caller privileges:” on page 58 for details. 

To configure caller privileges:

1 Click the Be A Host action button.

2 Do one of the following:

■ Choose NEW from the File menu to create a new host connection 
item.

■ Right-click an existing connection item and choose PROPERTIES 
from the context menu. 

3 Click the Callers tab in the Host Properties sheet.

Figure 4-5

You must check this 
button to create new 
callers or modify 
existing callers

The Add Caller 
wizard adds a caller 
using default 
privileges
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4 Click Specify Individual Caller Privileges to enable caller security.

5 Do one of the following:

■ Right-click in the caller window and choose NEW from the context 
menu.

■ Click the New button in the toolbar.

Figure 4-6

New Caller wizard
The New Caller wizard creates a caller entry containing the caller’s login 
name and password. If you want to assign special rights to the caller, you 
must modify the caller item’s properties.

To run the New Caller wizard:

1 Double-click the Add Caller icon.
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Figure 4-7

2 Enter a name for this caller in the text box and click Next.

3 Enter a login name for this caller to use to log into the host after 
connecting. 

4 Enter a password for this caller to use after connecting to the host. 

5 Enter the password again to confirm it and click Next.

6 Click Finish to save the new caller.

Modifying caller properties
The new caller item created by the wizard contains pcANYWHERE’s default 
property settings. You can customize these settings for a particular caller 
item, granting additional rights or limiting the rights the caller has on the host 
PC. 

To modify the caller’s properties:

1 Right-click the caller connection item and choose PROPERTIES from 
the context menu.
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Figure 4-8

2 Click the Callback tab.

Figure 4-9

3 Check Call Back The Remote User if you want the host to disconnect 
and call back the remote.

4 Enter the phone number of the remote caller. If left blank the remote 
user will be prompted for one after connection. 

5 Click the Advanced tab.

Use the Settings 
property page to 
change the 
caller’s login 
name and 
password 

The callback feature 
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charges or as an 
additional security 
measure
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Figure 4-10

6 Check any or all of the following privileges to enable them for this 
remote caller:

■ Superuser: Provides full capability to the caller. When this box is 
checked, the caller is automatically granted all privileges. All 
other options except for Command To Execute After Connect and 
Save Session Statistics In Activity Log are grayed because it is not 
necessary to select them individually. 

■ Allow Caller To Blank Screen: Permits the remote caller to blank 
the screen on the host PC. If the host PC is unattended, this 
option is used to prevent others from viewing the activities 
occurring on the host during the session. 

■ Allow Caller To Cancel Host: Allows the remote user to cancel the 
host, prohibiting other connections.

■ Allow Caller To Restart Host: Allows the remote user to restart the 
host PC remotely. 

■ Allow Caller To Upload Files: Permits the remote caller to send 
files to the host PC. If this option is not enabled, the remote caller 
is also prohibited from performing any operation that modifies 
the host drive, such as synchronization and cloning.

■ Allow Caller To Download Files: Permits the remote caller to 
retrieve files from the host PC. If this option is not enabled, the 
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appropriate 
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remote caller is also prohibited from performing any operation 
that modifies the host drive, such as synchronization and cloning.

NOTE: Both upload and download privileges must be checked for 
the caller to use the file synchronization and file cloning features. 
(See Chapter 7, “File transfers and session management,” on page 91 
for more information on synchronization and cloning of files and 
folders.)

■ Allow Use Of Ctrl+Break: Permits the remote caller to use the 
Ctrl+C or Ctrl+Break key combinations to halt certain applications 
running on the host.

■ Limit Time Allowed Per Session: Allows the host user to set a time 
limit for the session. pcANYWHERE ends a remote computing 
session after the specified time expires.

■ Caller Subject To Inactivity Timeout: Enforces the timeout set in 
the Disconnect If Inactive option of the Security Options property 
page of the host properties sheet. (See “Configuring host security 
options” on page 47.) If the remote caller is inactive for the 
specified period, the host disconnects the remote computing 
session.

■ Set Drive Access: Restricts the remote caller’s access to drives on 
the host PC. Select the appropriate option buttons to indicate 
availability of host drives. For example, the host can deny remote 
users access to the network drives, and allow read and write 
access to the floppy drives.

■ Command To Execute After Connect: Allows a program to 
automatically run on the host PC after the remote caller logs on. 

■ Save Session Statistics In Activity Log: Enables the host activity 
log. (For more information on activity logs, see Chapter 11, 
“Utilities,” on page 173.)
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Figure 4-11

NOTE: Drive Access is not available in Windows NT since Windows NT 
provides its own drive security.

To configure Windows NT caller privileges:

1 Click the Be A Host action button.

2 Do one of the following:

■ Choose NEW from the File menu to create a new host connection 
item.

■ Right-click an existing connection item and choose PROPERTIES 
from the context menu. 

3 Click the Callers tab in the Host Properties sheet.
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Figure 4-12

4 Click Use NT User Privileges to enable Windows NT caller security.

NOTE: This option is grayed if the Run As A Service option is not 
checked. See “To configure host settings:” on page 45.

5 Double-click the Add User wizard to add a new pcANYWHERE 
caller.

6 Do one of the following procedures:

■ Click the User button to add a Windows NT user to the 
pcANYWHERE caller list.

■ Click the Group button to add a Windows NT group to the 
pcANYWHERE caller list.

7 Click Next.

Check to display NT 
groups that have 
pcANYWHERE 
access

Double-click the 
Add User wizard to 
add a new 
pcANYWHERE 
caller from the NT 
User Manager list.
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Figure 4-13

8 Select the workstation or domain to use to add users or groups to 
the pcANYWHERE caller list. 

NOTE: You must be signed on to a domain for the domain name to 
appear.

9 Choose a user account or a group account from the drop-down list 
and click Next.

10 Click Finish to add the user or group to the pcANYWHERE caller list.

11 Click NT User Manager if you have Windows NT administrator 
privileges and want to add or delete users to the workstation or 
domain. 

NOTE: You must have Windows NT administrator privileges to add 
or delete users to the Windows NT User Manager list. 

To configure pcANYWHERE caller privileges:

1 Right-click the caller item and choose PROPERTIES from the context 
menu.

2 Click the Callback tab.

3 Check Call Back The Remote User if you want the host to disconnect 
and call back the remote.
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4 Enter the phone number of the remote caller. If left blank, the 
remote user will be prompted for one after connection. 

5 Click the Advanced tab. (See “To modify the caller’s properties:” on 
page 54 for detailed information on pcANYWHERE caller privileges.)

NOTE: pcANYWHERE caller privileges are specific to pcANYWHERE 
connections and are in addition to the Windows NT privileges 
configured for the caller.

Protect the caller item
Each caller item can be password protected from use by others. Caller items 
can have the same password or each item can be given a unique password.

TIP: The protect item password protects the caller item from being viewed or 
modified by another user. It is not the password the caller uses to log into the 
host PC. You may want to consider using the same password to protect all 
caller items to avoid having to remember multiple passwords.

To password-protect a caller item:

1 Click the Protect Item tab.
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Figure 4-14

2 Type a password for this caller item.

3 Confirm the password.

4 Check the level of protection you want by choosing one of three 
available options.

5 Do one of the following:

■ Click Apply to save the settings and leave the caller properties 
sheet open.

■ Click OK to save the settings and close the caller properties sheet.

Starting a session
pcANYWHERE32 makes the connection using information in the connection 
item’s Connection Info property page, the session configuration used by the 
host PC, and any caller privileges set by the host PC. 

There are three ways the host PC can begin a remote control session:

■ Launch Host: Causes the host PC to wait for a call using the 
connection devices selected in the Connection Info property page of 
the host connection item.

This connection 
item can be 
viewed but not 
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a password
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■ Call Remote: Causes the host PC to dial the remote PC and make the 
connection. After connecting, the remote PC controls the activities 
on the host.

■ Voice First: Allows the host and remote caller to use the same phone 
line and have a voice conversation before switching to data mode.

To wait for a call from a remote PC:

1 Click the Be A Host PC action button.

2 Do one of the following:

■ Double-click a host connection item that uses the same 
connection device as the remote PC.

■ Right-click a host connection item and choose LAUNCH HOST from 
the context menu.

NOTE: If two devices were chosen in the host item’s Connection Info 
property page, the host waits for a call on both devices (Figure 4-15). When 
the host connects to a remote device, the other device is not available until 
the first session ends. 

Figure 4-15

To call a remote PC:

1 Click the Be A Host PC action button.

2 Right-click a host connection item that uses the same connection 
device as the remote PC and choose CALL REMOTE from the context 
menu.
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3 Do one of the following:

■ Enter a phone number for the remote PC in the Phone Number 
text box and click OK.

■ Choose a network host from the Network host list box.

After connecting to the host PC, the remote user controls the activities 
on the host.

To wait for a voice first call from the remote:

1 Click the Be A Host PC action button.

2 Right-click a host connection item that uses the same connection 
device as the remote PC and choose VOICE FIRST from the context 
menu.

Figure 4-16

3 When finished with the voice conversation with the remote caller, 
click OK and hang up the receiver to begin the remote control 
session.



 you must first 

5
Remote control
Before you can begin a remote computing session with a host,
create one or more remote control connection items. Each connection item is 
a file containing dialing instructions and other settings that the remote PC 
uses to connect to a particular host. You may add to or modify this list of 
connection items at any time.

Creating remote control connection items
You can create connection items manually or you can run the Add Remote 
Control Item wizard (Figure 5-1). The wizard allows you to configure the 
name and connection device for the connection item, and uses default 
settings in the remaining property pages. (See “Quick Start wizards” on page 
13 for information on using pcANYWHERE’s wizards.) 

To customize the wizard’s default settings, you can edit the connection item’s 
properties.

Figure 5-1

The remote 
control wizard 
uses default 
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item’s property 
pages Remote 

control 
connection 
items
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To create a new remote control connection item:

1 Click the Remote Control action button.

2 Do one of the following:

■ Double-click the Add Remote Control Item icon to create a new 
item using the wizard. 

■ Choose NEW from the File menu.

■ Right-click in the remote control window and choose NEW from 
the context menu.

The New Host To Call Properties sheet appears. Please read the 
following section, “To modify a connection item’s properties,” for 
property page details.

To modify a connection item’s properties:

Do one of the following:

■ Right-click the connection item and choose PROPERTIES from the 
context menu.

■ Click the connection item and choose PROPERTIES from the File 
menu.

Figure 5-2
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The connection item’s properties sheet contains five property pages:

To configure remote control connection information:

1 Open the remote control item’s properties sheet (see “To modify a 
connection item’s properties:” on page 66).

2 Select the communication device this remote control item uses to 
make a connection. 

(See “Connection devices” on page 31 for information on configuring 
connection devices.)

To configure remote control settings:

1 Open the remote control item’s properties sheet.

2 Click the Settings tab.

Connection Info: Use this page to select the hardware device this 
remote control connection item will use for each 
session. 

Settings: Use this page to configure optional settings to 
automate your connections to the selected host. 

Automated Tasks: Use this page to configure the automated tasks 
used during sessions with the selected host.

Security Options: Use this page to configure the level of data 
encryption to use for each session.

Protect Item: Use this page to protect the selected remote 
connection item with a password. 
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Figure 5-3

For network connections:

Enter any of the following information in the Network Host PC To Control 
text box:

■ Host name: Causes pcANYWHERE to automatically connect to that 
network host. 

■ Host name with wildcards: Causes pcANYWHERE to display a list of 
only those hosts matching the wildcard name.

In addition to the above, the following information can be used for TCP/IP 
connections:

■ DNS name: Use a host DNS (Domain Name Service) name if the 
network administrator has assigned DNS names and IP addresses to 
all hosts on the network.

■ Host IP address: Causes pcANYWHERE to connect to either a 
TCP/IP host not on the local subnet or to a host on the Internet.

■ Specific group IP address: Substitute 255 for the last portion of an IP 
address to display a list of hosts with IP addresses containing the first 
three portions of the group address. For example, an address of 
120.45.62.255 causes pcANYWHERE to list all hosts on the subnet 
with IP addresses beginning with 120.45.62.

The network host 
PC name is 
grayed if a modem 
connection device 
is chosen 
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Use this addressing method when the host PC is connecting to the 
Internet through an Internet Service Provider.

NOTE: Host names and addresses listed in the Application Options TCP/IP 
property page are ignored when a host name is provided in the Network 
Host PC To Control field. Leave this field blank to display the hosts defined 
in the TCP/IP property page. (See “TCP/IP Hosts” on page 131 for 
information on creating a list of TCP/IP hosts.)

For modem connections:

1 Perform one of the following procedures:

■ Enter the area code, phone number, and any required prefix, in 
the Use Manually Entered Prefix, Area Code, Phone Number field. 

■ Click Use Dialing Properties And Phone Number to enter the area 
code and phone number. Use the dialing properties configured in 
the My Locations property page. 

If a phone number is not provided in either of the above locations, you 
are prompted for one when you launch the connection item.

2 Click Dialing Properties to view the dialing properties of your 
current location or to create a new dialing properties location.

3 Enter values for any of the following options:

■ Automatically Login To Host Upon Connection: Instructs 
pcANYWHERE to use the information contained in the Login 
Name and Password fields to automatically login upon 
connection to a host. 

■ Login Name: Displays the login name used when connecting to 
this host PC. 

■ Password: Contains the password used when connecting to this 
host PC. Caller passwords are optional on the host PC and this 
field can be left blank if a password is not required. However, if 
this field is left blank and a password is required, the host will 
prompt you for both a login name and password. The connection 
will not be automatic.

■ Number Of Connection Attempts: Sets the number of times 
pcANYWHERE will attempt to dial the host after a failed call.

■ Seconds Between Retries: Instructs pcANYWHERE how long to 
wait before attempting to redial the host after a failed call.
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NOTE: Use Dialing Properties And Phone Number is not supported 
in Windows NT, version 3.51, and the option is grayed. Include the 
area code and any other dialing requirements in the Use Manually 
Entered Prefix, Area Code, Phone Number field.

To configure automated tasks:

1 Open the remote control item’s properties sheet (see “To modify a 
connection item’s properties:” on page 66).

2 Click the Automated Tasks tab.

Figure 5-4

3 Check the options you want to use when calling this host:

■ Run Upon Connection: Causes the execution of either a script file 
or AutoXfer procedure when the session starts. 

■ Record Session In File For Later Playback: Causes recording of the 
activities of the remote control session to a file for playback later. 
You can type a new filename in the text box or you can use the 
Browse button to locate and select an existing record file. The 
new session is appended to the end of this existing file. (See 
“Recording sessions” on page 175 for information on session 
recording and playback.) 

You can enter a 
new filename or 
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■ Save Session Statistics In Log File: Causes session statistics such as 
host name, start and end time of session, and files transferred, to 
be saved in a log file. If a filename is not entered here, you 
are prompted for one after disconnecting the session. (See 
Chapter 11, “Logging remote control and online service sessions” 
on page 180 for information on log files and reports.)

To create or modify an AutoXfer procedure:

1 Check Run Upon Connection.

2 Click AutoXfer.

3 Do one of the following:

■ Click Properties to add or modify commands to the procedure 
displayed in the text box. 

■ Type a new name for the procedure and click Properties

■ Click Browse to select a different procedure, then click Properties. 

Figure 5-5

4 Do any of the following:

■ Click Add to add file transfer commands to the procedure.

■ Click Modify to change a command in the procedure.

Removes 
the 
selected 
command 
from the 
AutoXfer 
procedure

Use to 
change the 
order in 
which a 
command is 
run



Chapter 5.  Remote control 72
Figure 5-6

5 Choose the type of file transfer command:

■ Send To Host: Sends a file or folder from the local remote PC to 
the host PC.

■ Receive From Host: Sends a file or folder from the host PC to the 
local remote PC.

NOTE: Subfolders are not included when you file transfer a folder. 
Add a separate command to include the contents of subfolders.

■ Sync: Synchronizes a file or group of files. Synchronization 
ensures that both the host and local PC contain the same files. 
When a duplicate filename exists, the file with the most current 
date and time is copied. See “File transfers and session 
management” on page 91 for more information on 
synchronization.

6 Enter the following information:

■ Local Folder/File: Folder and name of the file being sent or 
received by the remote PC.

■ Host Folder/File: Folder and file being sent or received by the 
host PC.

To view and select files and 
folders on the host create 
the AutoXfer procedure 
from the File Manager 
window
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TIP: To view the host folder and files and add them to an AutoXfer 
procedure, begin a file transfer session with the host and select the 
folders or files from the File Manager window. (See “AutoXfer 
procedures” on page 97 for more information.)

7 Click the Options tab.

Figure 5-7

8 Do one of the following:

■ Click Use Application Defaults to use the settings configured in 
the Application Options, File Transfer property page.

■ Click Override File Transfer Options For This Automated Transfer 
to change the default settings for this AutoXfer procedure.

NOTE: Select a file overwrite option that does not require user 
confirmation if you want this AutoXfer procedure to run 
uninterrupted.

9 Check End Session When Finished to disconnect automatically after 
the AutoXfer procedure ends. 
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TIP: If an error occurs when transferring a file, the file is not 
transferred and the procedure continues with the next command. To 
confirm if a file was successfully transferred, enable the remote’s 
session log. See “To configure automated tasks:” on page 70 for 
details.

To configure security options:

1 Open the remote control item’s properties sheet (see “To modify a 
connection item’s properties:” on page 66).

2 Click the Security Options tab.

Figure 5-8

3 Choose the encryption level from the drop down list box:

■ Public Key: Provides the highest level of security and is used 
when a certificate authority makes public keys available to the 
Cryptographic Service Provider (CSP) on both host and remote 
sides of the session.

■ Symmetric: Provides the next level of security and is used when 
there is no certificate authority available but there is a CSP 
available.
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■ pcANYWHERE: Provides minimum encryption capability and is 
used when there is no CSP available. It is the only level 
compatible with pcANYWHERE versions 2.0, 5.0, and 7.x.

4 Check Deny Lower Encryption Level to have the remote deny 
connection to computers not using the same level of encryption as 
the remote. If not checked, the remote connects to computers even 
when they are using a lower level of encryption. 

NOTE: Earlier versions of pcANYWHERE do not support all levels of 
encryption and connections from them are denied if this option is 
checked.

5 Type the following information:

■ Private Key Container: Type the name used when your key was 
obtained from the certificate authority.

■ Certificate Common Name: Type the name you provided to the 
certificate authority at the time the certification was requested. 
This option is case sensitive; type the name in the same case as 
you provided the certificate authority.

Password-protect an item

You can protect a remote control connection item from being modified, 
viewed, or executed by another user when you assign a password to the 
item. The same password can be used to protect all your connection items, 
including those under the other action buttons. 

(Please see “pcANYWHERE32 connection items” on page 11 for information 
on password-protecting connection items.)

NOTE: The Remote Control and File Transfer buttons use the same 
connection items. Any password set for a remote control item also affects the 
duplicate connection item appearing in the file transfer window.

Making the connection
Whether you are connecting over phone lines to a computer in another city, 
or over a local area network to a computer down the hall, the connection 
procedures are very similar. The host screen appears on the remote PC and, 
in general, the remote user can access any of the host’s files and applications.
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pcANYWHERE makes the connection using information in the connection 
item’s Connection Info property page, the automated tasks information used 
by the remote PC, and any caller privileges set by the host PC. Be sure to 
complete the necessary installation and configuration procedures described 
in “Installation” on page 19 and “Configuring the host” on page 43 before 
beginning.

Starting a session 
Remote control sessions are usually initiated by the remote PC. Using the 
connection information contained in the remote control connection item, the 
remote PC connects to a host PC and, after connecting, controls the session 
activities on the host PC. A remote control session can also be initiated by the 
host, however, it is still the remote PC that controls the session after 
connecting. 

There are four ways to initiate a connection with a host PC:

■ Connect: Causes the remote PC to connect to the host PC in remote 
control mode. This is the most commonly used method.

■ Start File Transfer: Causes the remote PC to connect to the host PC 
and automatically begin the session in file transfer mode.

■ Wait For Connection: Causes the remote PC to wait for a call from a 
host PC. After connecting, the remote PC controls the remote 
computing session.

■ Voice First: Allows the host and remote caller to use the same phone 
line and have a voice conversation before switching to data mode.

To make a modem connection to the host:

1 Click the Remote Control action button.

2 Do one of the following:

■ Double-click a host connection item that uses a modem 
connection device.

■ Right-click a host connection item and choose CONNECT from the 
context menu.

The call is started by the remote and is answered by the waiting host PC. The 
host’s screen appears in a pcANYWHERE remote session window and the 
remote computing session begins. 
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NOTE: If your login information was specified in the settings property sheet 
of the host connection item you are calling, they are entered automatically 
upon connection, and the remote user is not prompted for them. (See “To 
configure remote control settings:” on page 67 for details.)

To make a voice first modem connection to the host:

1 Do one of the following procedures:

■ Click the Remote Control action button on the remote PC.

■ Click the Be A Host PC action button on the host PC.

2 Click once to select a connection item that uses a modem connection 
device.

3 Right-click the connection item and choose VOICE FIRST from the 
context menu.

Figure 5-9

4 When finished with the voice conversation, click OK and hang up 
the receiver to begin the remote control session.

NOTE: VOICE FIRST must be selected on both the host and remote computers. 

To make a network connection to the host:

1 Click the Remote Control action button.

2 Do one of the following:

■ Double-click a host connection item that uses a network 
connection device.

■ Right-click a host connection item and choose CONNECT from the 
context menu.

If you did not enter a host name in the Settings property page of the 
connection item’s properties, a list of available hosts appears.

Both the host and 
remote PC must 
start the connection 
in voice first mode
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Figure 5-10

3 Select the host from the list of available hosts.

NOTE: The list of available hosts is not supported for SPX 
connections in Windows NT, version 3.51, unless you are running 
Novell IntraNetWare. When using SPX connections in Windows NT, 
specify the host name in the Settings property page. 

To wait for a call from the host:

1 Right-click the remote control connection item you want to use.

2 Choose WAIT FOR CONNECTION from the context menu.

The remote control connection item waits for a call from a host.

Upon connection, the host’s screen appears in a pcANYWHERE session 
window on the remote, and the remote computing session begins. The 
remote PC, however, still controls the session. (See Chapter 7, “File 
transfers and session management” on page 91 for information on 
session control and file transfers.)

To connect to multiple hosts:

1 Make a connection to the first host. (See “To make a modem 
connection to the host,” or “To make a network connection to the 
host,” earlier in this chapter.) 

2 Do one of the following:

■ If the Allow Connection To Multiple Hosts option in the 
Application Options, Remote Operation property page, is left 
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unchecked, minimize the first session and run pcANYWHERE 
again. (See “Remote Operation” on page 126 for information on 
remote options.)

■ If the Allow Connection To Multiple Hosts option is checked, 
pcANYWHERE remains open after calling the first host. Click the 
pcANYWHERE32 icon in the task bar to open the application. 

Figure 5-11

3 Make a connection to another host.

4 Repeat for each host you are connecting to.

Each session is displayed in the taskbar (see Figure 5-11). Click on a session 
to switch to that session.

Connecting through a gateway
A pcANYWHERE gateway is a PC on the network that allows network users 
to share a single communications device attached to the gateway PC and 
allows callers outside the network to call the gateway PC’s modem to 
connect to a network host. Because the gateway operates in the background, 
the CPU on which the gateway is configured can devote up to 90 percent of 
its processing time to other tasks. (See “Gateways” on page 147 for 
information on configuring a gateway PC.)

To use a gateway modem to call a host:

1 Click the Remote Control action button.

2 Do one of the following:

■ Create a new connection item. (See “To create a new remote 
control connection item:” on page 66.)

■ Right-click on an existing connection item and choose PROPERTIES 
from the context menu.

3 Choose the network device you use to connect to the gateway PC 
from the device list on the Connection Info property page.

4 Click Details.

Click to dial another 
host

Click on a session in 
the taskbar to switch to 
that session



Chapter 5.  Remote control 80
Figure 5-12

5 Check Use Gateway.

6 If you know the name of the gateway you want to use, type the 
name in the Name text box on the Details property page. If you 
leave this field blank, pcANYWHERE displays a list of available 
gateways to choose from. 

NOTE: The list of available gateways is not supported for SPX 
connections in Windows NT, version 3.51. When using SPX 
connections in Windows NT, you must specify the gateway name. If 
there is a class assigned to the gateway, you must specify the Class 
in addition to the name.

7 Click OK to save settings and return to the properties sheet.

8 Click the Settings tab.
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Figure 5-13

9 Type the phone number of the host you want to call. If you do not 
enter a phone number here, you are prompted for one after 
connecting to the gateway PC.

10 Click OK to close the properties sheet and return to the 
pcANYWHERE main menu.

11 Do one of the following:

■ Double-click the remote control item.

■ Right click the remote control item and choose CONNECT from the 
context menu.

If you provided a gateway name in the Details property page you are 
automatically connected to that gateway PC. If you did not provide a 
gateway name in the Details property page you can select one from the 
list of available gateways (see Figure 5-10).

12 Select a gateway to connect to from the list of available gateways 
and click OK.

If you provided a phone number of the host in the Settings property 
page, the gateway dials that host. If you did not enter a phone number 
in the Settings property page, the gateway prompts you for one. 

The gateway can 
automatically dial 
the phone number 
of the host

You can add a host 
name after the 
phone number to 
automatically 
connect to a 
network host



Chapter 5.  Remote control 82
To call a gateway modem and connect to a network host:

1 Click the Remote Control action button.

2 Do one of the following:

■ Create a new connection item. (See “To create a new remote 
control connection item:” on page 66.)

■ Right-click on an existing connection item and choose PROPERTIES 
from the context menu.

3 Click the Settings tab (see Figure 5-13).

4 Type the phone number of the gateway PC in the phone number 
field.

NOTE: If you know the name of the host you want to connect to 
after calling the gateway PC, you can add the host name after the 
phone number, using the @ symbol as a separator (see Figure 5-13).

5 Click OK to return to the Remote Control main window.

6 Do one of the following:

■ Double-click a host connection item that uses a modem 
connection device.

■ Right-click a host connection item and choose CONNECT from the 
context menu.

7 Enter your password and login information if required.

If you added a host name after the phone number in step 4 above, you 
are automatically connected to that host.

If you did not add a host name after the phone number in step 4 above, 
you can choose a host from the list of available network hosts.



local area 

6
Remote networking
There are two methods for providing access to a computer or 
network (LAN) from a remote location: remote control and remote 
networking. 

The two methods differ significantly and each offers advantages for certain 
types of applications. pcANYWHERE32 for Windows 95 and Windows NT 
combines the two technologies to meet a full range of remote access 
requirements.

Overview of remote control
Remote control technology allows a remote PC to connect to a host PC and 
use the host PC as though the user were at the host site. Using remote 
control, you can call a host PC that is on the network and access any file or 
application that is on the network or host PC.

Applications are executed on the host PC and only the keyboard, mouse, and 
screen information are transferred between the remote and host PC, 
minimizing information transfer across telephone lines. Because minimal data 
is being communicated back to the remote PC, the performance in a remote 
control connection closely matches that of a locally attached network 
workstation. 

Overview of remote networking
Remote networking technology, or dial-up networking in Windows 95 and 
remote access service (RAS) in Windows NT, allows a PC to connect to a 
network by dialing into a dial-up networking server. Using remote 
networking, you can call from your home PC or laptop from any remote 
location, connect to the office network and log on. The remote PC works as 
though it were cable-connected to the network, giving the remote user 
access to any file or application that the remote user has permission to use. 

Applications, however, are executed on the remote PC and all information 
and data required by the application must be communicated over the 
telephone line to the remote PC. Even with high-speed modems, telephone 
lines are much slower than direct LAN connections, and performance could 
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be an issue, especially if you are transmitting a large executable file. Dial-up 
networking connections are better suited to applications that perform the 
majority of processing on the local PC, making only limited queries to the 
network server. 

Combining remote control with remote 
networking

When you are connected to a network as a network workstation, you can 
establish a remote control session with a PC on that network using an IPX, 
SPX, or NetBIOS network connection device. In remote control connections, 
applications are executed on the local host PC, making it unnecessary to 
transfer executable files and other large files to the remote PC. 

Creating remote networking connection items

NOTE: If the Remote Networking action button is grayed, you must add 
Dial-Up Networking in Windows 95 or Remote Access Service (RAS) in 
Windows NT before continuing.

Remote networking connection items are created using the Add Remote 
Networking Item wizard. The wizard allows you to configure the item’s name 
and connection device, using default settings in the remaining property 
pages. 

To customize the default settings, you can modify the connection item’s 
properties.

To create a new remote networking connection item:

1 Click the Remote Networking action button.

2 Do one of the following:

■ Double-click the Add Remote Networking Item icon.

■ Choose NEW from the File menu.

■ Right-click in the remote networking window and choose NEW 
from the context menu.
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Figure 6-1

3 Enter a brief but descriptive name for this connection item.

4 If your operating system has not added a custom modem name in 
the Select A Modem text box, select your modem from the drop-
down list.

5 Click Configure to customize your modem settings. See your 
modem’s manual for information on how to customize these settings.

6 Click Next.

Figure 6-2

7 Enter the area code and telephone number of the computer this 
connection item calls.
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8 Choose a country code for this computer and click Next.

9 Click Finish to save this connection item and return to the remote 
networking window.

To modify a connection item’s properties:

1 Do one of the following:

■ Right-click the connection item and choose PROPERTIES from the 
context menu.

■ Click the connection item and choose PROPERTIES from the File 
menu.

Figure 6-3

2 Enter the area code and phone number of the dial-up networking 
server in the Area Code and Telephone Number text boxes.

3 Choose the country code of the server you are calling from the 
Country Code drop-down list box. 

4 Check Use Country Code And Area Code if either of these are 
needed to call the server.

5 If your operating system has not added a custom modem name in 
the Connect Using text box, select your modem from the drop-down 
list if you are making a modem connection.
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6 Click Server Type to choose the dial-up networking server type. See 
the network administrator for information on selecting server types.

7 Click OK to save settings and return to the remote networking 
window.

Windows NT connection items
In Windows NT, remote networking connection items must be created and 
modified in the Windows NT Remote Access Service (RAS) group box. The 
connection items appear in the pcANYWHERE32 remote networking window 
and can be executed. However, the connection item’s properties cannot be 
modified in pcANYWHERE. Refer to your Windows NT user manual for 
information on how to configure remote access service items.

Making the connection
The remote network connection is made using the information contained in 
the connection item’s property page. After connecting to the server, you are 
prompted for your login name and password and logged on to the network. 
You can access the same network drives that you access when you are 
working on-site. You can also connect to a pcANYWHERE network host after 
connecting. This allows you to work on a host PC as though you were 
physically at that PC. The performance of the session is faster because the 
host PC is locally attached to the network and it is not necessary to transfer 
data over a phone line.

To start a remote networking session:

1 Click the Remote Networking action button.

2 Do one of the following:

■ Double-click the remote networking connection item.

■ Right-click the remote networking connection item and choose 
CONNECT from the context menu.
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Figure 6-4

3 Check Do Remote Control Over Dial-Up Networking if you want to 
connect to a pcANYWHERE network host after connecting to the file 
server. 

4 Click Remote Control Settings to configure the properties of the 
remote control connection. 

Figure 6-5

5 Select a network device supported by your remote access server.

The remaining RAS property pages are the same property pages used 
for remote control connection items. (For complete details on 
configuring connection information, see “To configure remote control 
connection information:” on page 67.) 

Select a network 
device that your 
remote access 
server supports
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NOTE: If you do not check the remote control option, you can run 
pcANYWHERE after connecting to the network and connect to a 
network host. (For information on connecting to network hosts, see 
“To make a network connection to the host:” on page 77.)

6 Click OK to save the selections and return to the Dial-Up 
Networking dialog box.

7 Click OK to start the remote networking connection.
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File transfers and 
session management

This chapter explains how to change session options and access 
pcANYWHERE program functions during remote control sessions. 

NOTE: This chapter covers remote control sessions only. See Chapter 10, 
“Online services,” on page 153 for information on managing a session with 
an online service. 

Managing the remote control session
After connecting, a remote PC controls the activities on the host PC. The 
remote caller can run programs on the host PC, use pcANYWHERE File 
Manager to send or receive files, chat with the host user by typing a 
conversation on the computer, and use options to help navigate the host 
screen.

Online menus 
Online menus are available only after a session is started. Both the host and 
remote user can access an online menu and execute commands on the host 
PC. The online menus however, are not the same for the host and remote. 
Since the remote PC controls the host PC during a connection, the remote’s 
online menu offers more options than the host’s online menu.

To view the online menu on the remote PC:

1 Make a remote control connection with a host PC. (See “Making the 
connection” on page 75 for more information.)

2 Click the remote control menu-box and choose PCANYWHERE from 
the drop-down menu.
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Figure 7-1 Remote online menu

To view the online menu on the host PC:

1 Make a remote control connection.

2 Right-click the pcANYWHERE [In session] icon and choose 
PCANYWHERE from the menu.

Most online menu 
commands are also 
available from the remote’s 
online toolbar

Full Screen

Screen Scaling

Online Options
File Transfer

AutoXfer

Transfer 
Clipboard

Chat

Recording

Save Screen Ctrl+Alt+Del

Restart Host

End 
Session

Click the control box 
to access the 
remote’s online 
menu

Switch to 
voice
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Figure 7-2 Host online menu

Host and remote online menu options
Both host and remote users are able to initiate a typed conversation (chat), 
start a file transfer, and end the session. 

Chatting with the other user
During a chat—a typed conversation initiated by either the host or remote 
user—a dialog box called a chat window displays on both the host and 
remote screens. This feature is particularly helpful for sending or receiving 
brief messages or instructions.

Both the host and remote user can type their messages in the lower chat 
window and press Enter to send the completed message to the upper chat 
window. 

To use the chat window:

1 Choose CHAT from the remote or host online menu (see “Online 
menus” on page 91 for details).

Right-click the 
host session 
icon to view 
online menu
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Figure 7-3

2 Type your message in the lower window and press Enter when 
finished.

To save the contents of a chat window:

1 Choose SAVE AS from the File menu.

2 Select a folder for the file.

3 Enter a filename in the File Name text box and click Save.

To exit chat mode:

■ Choose EXIT CHAT from the File menu.

Ending the remote control session
Either the host or remote user can end the session. The remote caller can 
change the mode to which the host returns, providing the caller was granted 
this privilege.

To end the session from the remote:

1 Choose END SESSION from the remote online menu (see “To view the 
online menu on the remote PC:” on page 91 for details).

2 Click Yes to confirm that you want to disconnect the session.

Type your message 
in the lower box 
and press Enter to 
send the message
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The Host Accepts Another Call check box displays only if the caller has 
been granted the right to restart the host. (See “Modifying caller 
properties” on page 54 for information on caller privileges.)

NOTE: If the remote does not choose to have the host accept another call, 
the host operation on the host PC is canceled. The host user must load 
pcANYWHERE and wait for another call.

To end the session from the host:

■ Choose END SESSION from the host’s online menu (See “To view the 
online menu on the host PC:” on page 92 for details.)

The session disconnects and the host reinitializes and waits for another 
call.

Remote online menu commands
Because the remote user is the one controlling the session, there are more 
online options available on the remote’s online menu. Many of these options 
can be selected by clicking the icon in the online toolbar. (See “Online 
menus” on page 91 for details on accessing commands from the toolbar.)

■ Full Screen: Causes pcANYWHERE to display the host’s full-screen 
on the remote computer. When full screen is selected, the remote 
control menu box is not available. To access the online menu, right-
click the pcANYWHERE session icon. Press Alt+Enter to change back 
to window mode.

■ Screen Scaling: Causes the host to scale down to fit in the remote’s 
window when the host’s screen resolution is higher than the 
remote’s. If screen scaling is not selected, the remote user must scroll 
to view portions of the host screen that are too large to fit in the 
remote window.

■ Online Options: Allows the remote caller to change session options 
for the active session. 

■ File Transfer: Displays pcANYWHERE’s File Manager to allow the 
selection and transfer of files. (For more information on File Manager 
options, see “pcANYWHERE file manager” on page 107.

■ Run AutoXfer: Allows the remote caller to run an existing AutoXfer 
procedure or create a new procedure. (See “To run an AutoXfer 
procedure from the online menu” on page 97 for details.)
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■ Transfer Clipboard: Allows the transfer to the other PC of 
information contained in either PC’s clipboard. (See “Transferring the 
clipboard” on page 102 for details.)

■ Chat: Allows the host and remote caller to communicate by typing a 
conversation in a chat window. (See “Chatting with the other user” 
on page 93 for more information.)

■ Recording: Records the session activities to a file for later playback. 
(See “Playing back recorded sessions” on page 176 for details on 
playing back recorded files.)

■ Save Screen: Saves a screen shot during a session for later viewing. 
(See “To play back recorded screens:” on page 179 for details on 
viewing saved screens.)

■ Switch To Voice: Causes pcANYWHERE32 to suspend the data 
session to allow a voice conversation using the same phone line. 

■ Send Ctrl+Alt+Del: Sends a Ctrl+Alt+Del command to the host that 
opens the Windows task box. The remote user can then switch tasks 
on the Windows NT host PC. 

■ Restart Host: Allows the remote caller to restart the host PC, 
providing the host has granted the caller the right to do so in the 
caller’s properties. (See “Configuring host callers” on page 51 for 
details.)

■ Scripts: When selected from the online menu it allows the execution 
of a pcANYWHERE script file. Use the Browse button to display the 
Scripts dialog box from which you can select a script to run. Refer to 
the Creating pcANYWHERE Scripts manual for information on 
creating scripts.

■ End Session: Causes pcANYWHERE to disconnect the session. The 
mode the host returns to after ending a session is determined by the 
settings found in the host’s Settings property page. (See “To 
configure host settings:” on page 45 for more information.) 

The following indicators appear on the far right side of the online toolbar: 

■ Encryption Level Indicator: Displays the level of encryption used 
during the session. The color of the padlock indicates the encryption 
used: 

■ Red: None 

■ Yellow: pcANYWHERE encryption

■ Blue: Symmetric encryption
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■ Green: Public/Private Key encryption

■ Session Status Indicator: Monitors incoming and outgoing data 
activity, and displays the length of time you are online.

AutoXfer procedures
An AutoXfer procedure is a file containing commands to automatically 
transfer files to the host, receive files from the host, or synchronize files on 
both host and remote PCs. 

You can create AutoXfer procedures using any of the following methods:

■ Automated Tasks property page: Allows you to create an AutoXfer 
procedure to automatically run when the remote control connection 
item connects to the host PC. (For more information on automated 
tasks, see “To create or modify an AutoXfer procedure:” on page 71.)

■ Remote online menu or online toolbar: Allows you to create, modify, 
and run an AutoXfer procedure during a session with the host PC 
(see Figure 7-1).

■ File Manager: Allows you to view the folders and files on both the 
remote and host PC, and select the files or folders to be included in 
the AutoXfer procedure. In addition to the advantage of displaying 
the host files for selection, creating a procedure from the file 
manager window allows you to select more than one file or folder at 
a time. 

To run an AutoXfer procedure from the online menu

1 Choose AUTOXFER from the remote online menu or click the 
AutoXfer icon on the remote online toolbar.

Figure 7-4
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2 Do one of the following:

■ Click Run to run the procedure displayed in the AutoXfer 
procedure name text box.

■ Click Browse to select a different procedure to run.

To create or modify an AutoXfer procedure from the online menu:

1 Choose AUTOXFER from the remote online menu or click the 
AutoXfer icon on the remote online toolbar.

2 Do one of the following:

■ Click Properties to add or modify commands to the procedure 
displayed in the text box. 

■ Type a new name for the procedure and click Properties.

■ Click Browse to add commands to a different procedure.

Figure 7-5

3 Click Add to add file transfer commands to the procedure.
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Figure 7-6

4 Choose the type of file transfer command.

■ Send To Host: Sends a file from the local remote PC to the host 
PC.

■ Receive From Host: Sends a file from the host PC to the local 
remote PC.

■ Sync: Synchronizes a file or group of files. Synchronization 
ensures that both the host and local PC contain the same files. 
When a duplicate filename exists, the file with the most current 
date and time is copied. 

NOTE: Use caution when synchronizing files over different time 
zones to avoid overwriting the wrong file.

5 Type the following information:

■ Local Folder/File: Folder and name of the file being sent or 
received by the remote PC.

■ Host Folder/File: Folder and name of the file being sent or 
received by the host PC.

TIP: To view and select folder and files on the host PC, create the 
AutoXfer procedure from the pcANYWHERE File Manager. See“To 
create an AutoXfer procedure from the file manager:” on page 101.

6 Click OK to return to the properties page.
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7 Click the Options tab. 

Figure 7-7

8 Do one of the following:

■ Click Use Application Defaults to use the settings configured in 
the Application Options, File Transfer property page.

■ Click Override File Transfer Options For This Automated Transfer 
to change the default settings for this AutoXfer procedure.

NOTE: Select a file overwrite option that does not require user 
confirmation if you want this AutoXfer procedure to run 
uninterrupted.

9 Check End Session When Finished to disconnect automatically after 
the AutoXfer procedure ends.

If an error occurs when transferring a file, the file is not transferred and 
the procedure continues with the next command. To confirm if a file 
was successfully transferred, enable the remote’s session log. See “To 
configure automated tasks:” on page 70 for details. 

10 Click OK to accept settings and return to the Run AutoXfer dialog 
box.

11 Do one of the following:

■ Click Run to run the procedure.

■ Click Cancel to return to the remote control session without 
running the procedure.
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To create an AutoXfer procedure from the file manager:

1 Choose FILE TRANSFER from the remote online menu or click the File 
Transfer icon on the remote online toolbar (see Figure 7-1).

2 Select the file or group of files you want to add to the AutoXfer 
procedure. See “Selecting files and folders” on page 109 for 
information on selecting files and folders.

3 Choose ADD TO AUTOXFER from the File menu or click the Add 
AutoXfer button on the file manager button bar.

Figure 7-8

4 Do one of the following:

■ Click OK to add the file transfer commands to the selected 
AutoXfer procedure and return to the File Manager window.

■ Click Browse to add the file transfer commands to different 
AutoXfer procedure.

■ Enter a filename in the AutoXfer Procedure To Add Operations To 
text box to add the selected file transfer commands to a new 
procedure.

NOTE: To view or modify the contents of an AutoXfer procedure, 
choose MODIFY AUTOXFER from the File menu. 

This button changes 
depending on 
whether the files 
were selected from 
the local or host 
window
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Transferring the clipboard
The Windows clipboard contains information that is cut or copied from 
another application. You can use the clipboard to transfer information 
between Windows and non-Windows applications. See your Microsoft 
Windows 95 or Windows NT documentation for details.

During a remote control session you can transfer text or graphics contained 
in the host’s clipboard to the remote or the remote’s clipboard to the host. 
Remember, copying information into the clipboard overwrites any existing 
information in the clipboard.

To copy clipboard text:

1 Choose TRANSFER CLIPBOARD from the remote online menu or click 
the clipboard icon on the remote online toolbar.

Figure 7-9

2 Click which clipboard you want to transfer.

3 Do one of the following procedures:

■ Click Text if you want to transfer only the text in the clipboard, 
ignoring any graphics. 

■ Click Graphics if it is necessary to transfer the bitmaps in the 
clipboard and performance is not an issue. 

Viewing clipboard contents
The Clipboard Viewer must be installed on the host or remote PC to access it. 
If Clipboard Viewer is not available in the Accessories menu, add it using the 
Windows 95 or Windows NT Control Panel. (Refer to your Windows manual 
for details.)

Check Text 
only if you 
want optimal 
performance
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To view the contents of the host’s clipboard:

Do one of the following:

■ Click the Windows Start button on the host and choose CLIPBOARD 
VIEWER from the Accessories group.

■ Double-click the clipboard shortcut if it exists on the host desktop.

To view the contents of the remote’s clipboard:

Do one of the following:

■ Click the Windows 95 Start button on the remote and choose 
CLIPBOARD VIEWER from the Accessories menu.

■ Double-click the clipboard shortcut if it exists on the remote 
desktop.

NOTE: The remote Windows Start button is not visible if the remote 
is using full-screen display to view the host. Press Alt+Enter to return 
to window mode.

Online Options
Online options include options for remote host screen and keyboard states, 
DOS session options, screen display, and special keyboard handling.

Changes made to any of these options during a remote control session affect 
only the current session and do not change the settings configured in the 
application options properties or the remote control connection item 
properties.

To access online options:

■ Choose ONLINE OPTIONS from the remote’s online menu or click the 
online options button on the remote online toolbar.



Chapter 7.  File transfers and session management 104
Figure 7-10

General options
Options for screen scaling, color scaling, and the host’s screen and keyboard 
status are found in the General property page.

To change the host’s general options:

1 Choose ONLINE OPTIONS from the remote’s online menu.

2 Check to enable the following options:

■ Screen Scaling: Causes the host screen to scale down to fit in the 
remote’s terminal window. If left unchecked, the remote user 
must scroll to view portions of the screen if the host image is too 
large to fit in the remote’s window.

■ Remote Control Toolbar: Displays the online toolbar on the 
remote PC. This toolbar contains icons that provide quick access 
to online menu options such as file transfer, chat, recording 
sessions, and running scripts. If left unchecked, the toolbar does 
not display and the user must select options from the online 
menu.

■ Synchronize Mouse Buttons: Allows the remote caller to control 
the host using the same mouse configuration used on the remote 
computer. For example, if the remote caller is using a left-hand 
mouse configuration, the host mouse adjusts to allow left-hand 
mouse control of the session.
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■ ColorScale : Allows the user to reduce the number of colors the 
host uses when translating bitmaps to improve the screen display 
performance. Choose 2 or 4 colors to optimize the screen display 
on the remote during the session. When this option is disabled, 
the host translates the highest number of colors that it supports.

NOTE: To use the ColorScale option effectively, the color palette on 
the host PC must be set to 256 colors or greater.

■ Reduce Host Desktop Area To Match Remote: Causes the host to 
reduce screen resolution to match the resolution used by the 
remote PC.

■ Host Active Window Tracking: Automatically moves the remote’s 
view to any currently active window on the host. For example, a 
remote caller could be unaware of an error message if it is 
displayed beyond the remote’s viewing area. When this option is 
checked, the remote’s viewing area is automatically focused on 
the error message.

To change the host’s status options:

1 Choose ONLINE OPTIONS from the remote’s online menu.

2 Check to enable the screen and keyboard state you want to use for 
the host during the session: 

■ Host Keyboard Locked: Allows you to disable the host’s keyboard 
and mouse to prevent interruptions. The host user can only 
observe the remote control session.

■ Host Screen Blanked: Blanks the host screen during the session to 
protect your privacy. Use this option when the host PC is 
unattended and is running confidential applications. As a host 
security option, the host user may configure the host screen to 
automatically blank upon connection. (See “Configuring host 
security options” on page 47 for details.)

If the host has not granted the remote user the privilege of blanking 
the host screen, this option is dimmed and cannot be checked.

DOS settings
When the host is running DOS in a full-screen window, or when the host 
user has exited to DOS, the host screen may contain characters or graphics 
that differ from the screen display when the host PC is running Windows. 
The options available in the DOS Settings property page (Figure 7-11), allow 
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the remote user to make adjustments to several DOS display characteristics if 
the remote PC experiences problems reading and displaying the host screen.

Figure 7-11

Check the desired check boxes in the DOS Settings property page.

■ Full Graphics Support: Select when you want the most accurate 
representation of DOS graphics possible. Leave unchecked to 
improve screen display speed if an approximation of graphics is 
acceptable.

■ Synchronize Display: Select to slow the host application to the rate at 
which the remote can display screen activity. If unchecked, some 
lines of text may scroll off the screen before the remote is able to 
display them. Uncheck this option if the speed of the application is 
more important than a complete display of all characters, such as 
with a lengthy database indexing procedure.

■ Special Keyboard Handler: Select the keyboard handler type and 
level you want to use. Keyboard handlers allow the remote user to 
operate the host PC effectively while executing host applications that 
handle keyboard input in a non-standard fashion. Keyboard handlers 
are divided into two types, Type 1 and Type 2. See the “Glossary”  
for a detailed explanation of keyboard handling functions. 

DOS settings enhance 
sessions in DOS window
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pcANYWHERE file manager
You can use the pcANYWHERE file manager to transfer files between a 
remote and a host during remote computing sessions, and to manage folders 
and files on both host and remote computers. Some of the more frequently 
used functions can also be accessed from the file manager button bar at the 
bottom of the window.

To access the file manager from the remote:

1 Begin a remote computing session. (See “Making the connection” on 
page 75 for instructions on starting a session.)

2 Choose FILE TRANSFER from the remote online menu or click the file 
transfer icon on the remote online toolbar (see Figure 7-1).

To access the file manager from the host:

1 Begin a remote computing session. (See “Making the connection” on 
page 75 for instructions on starting a session.)

2 Right-click the pcANYWHERE In Session icon and choose FILE 
TRANSFER from the pcANYWHERE menu.

3 Select CONTROLLED BY HOST from the submenu. (See “Sending files” 
on page 111 for details.)
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Figure 7-12

4 Choose EXIT FILE MANAGER from the File menu to exit the file 
manager and return to the remote computing session.

Setting file manager options
pcANYWHERE file manager options include file sorting, file detail, and file 
transfer preferences.

Selecting file sorting options
By default, the files in the host and remote file list boxes are sorted 
alphabetically by name. You can change the sort criteria using the View 
menu. You can specify file sorting by name, extension, date, or size. For 
example, sorting by extension places .DOC files near the top of the list. 
Sorting by date places your most recently modified files at the top of the list.

You can select the FILTER command from the View menu to sort files by type. 
For example, you can choose to view only program files (Figure 7-13).

Remote and 
host files are 
listed side by 
side for easy file 
management

The arrow 
indicates the 
direction of the 
file transfer. Click 
on this arrow to 
quickly change 
direction

The file 
manager button 
bar contains 
frequently used 
actions

Click to add selected files to 
an AutoXfer procedure
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Figure 7-13

To change file sorting for the active file list box:

1 Choose FILE TRANSFER from the remote or host online menu.

2 Choose how you want to list the files from the View menu.

Selecting file details options
You control the amount of detail displayed for each file listed in the host and 
remote file list boxes. All listings must contain the filename, but you can 
choose whether or not to display file date, time, and size.

To change file details for the active file list box:

1 Choose FILE TRANSFER from the remote or host online menu.

2 Choose from SHOW DATE, SHOW TIME, and SHOW SIZE on the View 
menu.

Selecting files and folders
You must select one or more files or folders before performing file transfer or 
some file management operations. You can select from either the remote or 
host list box. Only one of the two list boxes may be active at a time.

The two drop-down list boxes in the file manager window display the names 
of the currently selected remote and host drives. The contents of these drives 
appear in the remote and host list boxes.

To select a different drive:

Do one of the following:

■ Click the prompt button in the drive drop-down list box and select a 
drive letter from the list.

You can 
choose to view 
executable 
files only

This example will list only 
Excel spreadsheet files
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■ Choose CHANGE FOLDER from the File menu and type the new drive 
letter and folder in the New Folder text box.

To display folder contents:

■ Double-click the name of the folder that you want to display.

To select a single file or folder:

1 Click the name of the file or folder.

2 Click the name of a second file or folder. Note that the previously 
selected file is no longer selected.

To select two or more files in sequence:

1 Choose the first file by clicking its filename.

2 Press Shift and click the last filename in the group you want to 
select.

To select multiple files not in sequence:

1 Click the first filename.

2 Press Ctrl while clicking each of the other filenames. Only the files 
selected are highlighted.

Using the Tag menu to select files
The pcANYWHERE file manager Tag menu lets you select all or some of the 
files or folders in the active file list box.

The options available in the Tag menu are:

■ TAG ALL: Selects all files and folders in the active list box.

■ TAG FILES: Selects all files in the active list box, omitting folders.

■ TAG FOLDERS: Selects all folders in the active list box and the files 
contained within the folders. Files listed in the active file list box are 
not included in the selection.

■ CLEAR TAGS: Clears all file and folder selections.

■ REVERSE TAGS: Deselects the tagged files and folders while selecting 
the unselected files and folders.

■ TAG BY: Selects files and folders based on a filter you specify.
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Figure 7-14

Deselecting files
You can deselect a file by holding down the Ctrl key and clicking on the files 
you want to deselect.

To deselect a file in a group of selected files:

■ Press Ctrl while clicking the name of any selected files or folders you 
want to deselect.

Sending files
This section covers file transfers for remote control sessions. For information 
on online service file transfers, see “Uploading and downloading files” on 
page 169.

A file transfer can be started by either PC. (For information on setting file 
transfer options, see “Selecting file transfer options” on page 113.)

To start a file transfer from the remote:

1 Choose FILE TRANSFER from the remote or host online menu.

2 Select the desired source files or folders in the remote file list box. 
(See “Selecting files and folders” on page 109.)

3 Do one of the following:

■ Choose SEND from the File menu.

■ Click the Send button on the file manager’s button bar.

■ Use the mouse to drag and drop the selected files to the host list 
box.

You can easily tag all files 
having the same extension
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Figure 7-15

4 Click OK to confirm the selections in the dialog box.

Figure 7-16

NOTE: If the Pause Remote Control To Maximize File Transfer Performance 
option in the Application Options, File Transfer property page is not 
checked, the file transfer window automatically minimizes when the file 
transfer begins. See “File Transfer” on page 133 for information on file 
transfer options.

To start a file transfer from the host:

1 Choose FILE TRANSFER from the host online menu. (See “To view the 
online menu on the host PC:” on page 92.)

Folder where file 
is being sent from

Folder where file 
is sent to

Verifies that the 
SpeedSend  option is 
enabled

Allows simultaneous 
remote control and file 
transfer operationsVerifies that Virus 

Scan is enabled
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Figure 7-17

2 Choose one of the following options:

■ CONTROLLED BY HOST: Allows the host user to access the File 
Manager and transfer files. The remote user receives the file 
transfer status dialog box (see Figure 7-16).

■ CONTROLLED BY REMOTE: Allows the remote user to access the File 
Manager and transfer files. The host user receives the file transfer 
status dialog box (see Figure 7-16).

Selecting file transfer options
File transfer options include file overwrite preferences, file compression, and 
crash recovery settings.

File overwrite preferences allow you to specify whether or not you want to 
confirm before a file is overwritten during the file transfer process. Normally 
you should require verification before overwriting files. If you intend to 
overwrite a large number of files, or if you are running an AutoXfer 
procedure, you may want to choose to overwrite automatically, or to 
overwrite older files only.

You can use file compression to improve file transfer speed. Files 
compressed by pcANYWHERE are automatically uncompressed to their 
original states before being written to the target drive. If files have already 
been compressed by a compression scheme such as PKZIP, there will be no 
noticeable improvement in the speed of the file transfer.

When enabled, crash recovery allows a file transfer that was interrupted 
before completion to continue transferring at the point of the interruption. If 
crash recovery is not enabled, an interrupted file transfer starts again at the 
beginning of the file. You should consider using crash recovery when you 
transfer very large files.

File transfer performance is enhanced when SpeedSend is enabled because it 
causes pcANYWHERE to compare files with duplicate filenames and transfer 

Click to choose whether 
the host or remote user 
controls the file transfer
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only the information that is different in the source file. If SpeedSend is not 
enabled, pcANYWHERE transfers the entire file.

To set file transfer options:

1 Choose FILE TRANSFER from the host or remote online menu. (See 
“Online menus” on page 91 for instructions on accessing the online 
menus.)

2 Choose FILE TRANSFER OPTIONS from the Configure menu.

Figure 7-18

3 Click the Destination File prompt button and select a file overwrite 
preference from the drop-down list.

4 Check Use Compression to compress files during transfer.

5 Check Allow Crash Recovery to enable crash recovery.

6 Check Use SpeedSend to compare duplicate files and transfer only 
the data that is different in the source file.

7 Click OK to save the settings and return to the pcANYWHERE File 
Manager window. The selections remain in effect for all sessions 
until you change them.

Managing folders and files
The pcANYWHERE file manager gives you control over folders and files on 
both the host and the remote computers, which is useful when transferring 
files. For example, you may have connected to a host for the purpose of 
transferring one or more files to your remote computer, but once connected 
you realize that there is not a suitable folder in which to place these new 
files. The CREATE FOLDER command allows you to create a new folder during 
a session. If you had been sending files to the host, you could just as easily 
have created a new folder on the host computer.

Use SpeedSend when you want 
pcANYWHERE to compare duplicate 
files and transfer only the data that is 
different in the source file
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To create a new folder:

1 Choose FILE TRANSFER from the host or remote online menu. (See 
“Online menus” on page 91 for instructions on accessing online 
menus.)

2 Choose the folder or drive in which you would like to create the 
new folder.

3 Choose CREATE FOLDER from the File menu or click the Create Folder 
button on the file manager button bar.

Figure 7-19

4 Type name of the new folder.

5 Click OK.

The new folder appears in the active list box.

Deleting files and folders
You can delete files and folder contents anywhere on any host or remote 
drive with the Delete command.

To delete folders or files in folders:

1 Choose FILE TRANSFER from the host or remote online menu. (See 
“Online menus” on page 91 for instructions on accessing online 
menus.)

2 Choose the files or folders you want to delete. 

3 Choose DELETE from the File menu or click the Delete button on the 
file manager button bar.

Create a 
subfolder 
named Sept 
in the Minutes 
folder
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Figure 7-20

If you selected a single file or folder, its name appears in the Delete text 
box. If you selected multiple files or folders, the text box is replaced 
with an information line that indicates the number of selected files.

4 Click OK.

The file or folder selected is deleted.

Renaming files and folders
You can rename files and folders anywhere on any host or remote drive with 
the RENAME command.

To rename a file or folder:

1 Choose FILE TRANSFER from the host or remote online menu. (See 
“Online menus” on page 91 for instructions on accessing online 
menus.)

2 Choose the file or folder you want to rename. (See “Selecting files 
and folders” on page 109 for details.)

3 Choose RENAME from the File menu or click the Rename button on 
the file manager button bar. 

The name of the selected file or folder appears in the Rename text box.

Figure 7-21

4 Type the new file or folder name in the To text box and click OK.
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Copying files
You can make a local copy of files anywhere on any host or remote drive 
with the LOCAL COPY command. The new copy of the file can be given a new 
name or be located in a different folder or drive on the local system.

NOTE: Local copy does not transfer files between host and remote 
computers. A copy of the selected file is made on the same computer as the 
original file. 

To copy files and folders:

1 Choose FILE TRANSFER from the host or remote online menu. (See 
“Online menus” on page 91 for instructions on accessing online 
menus.)

2 Choose the file you want to copy. (See “Selecting files and folders” 
on page 109 for details.)

3 Choose LOCAL COPY from the File menu or click the Local Copy 
button on the file manager button bar.

Figure 7-22

4 Type the destination pathname in the To text box and click OK.

Comparing folders
The Compare Folders feature looks at both host and remote folders and 
informs you if they are the same. If the folders differ, the files that are 
different or missing are highlighted in both folders. The compare folders 
function only informs you of the differences; no action is taken.

It is a good idea to use the compare folders function before executing a 
synchronization or cloning command to verify the files that will be 
transferred during these procedures.
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NOTE: The compare function does not include comparing files in subfolders 
at the same time.

To compare folders:

1 Choose FILE TRANSFER from the host or remote online menu. (See 
“Online menus” on page 91 for instructions on accessing online 
menus.)

2 Choose host and remote folders to compare from the list.

3 Choose COMPARE FOLDERS from the File menu.

pcANYWHERE compares the two folders and reports the results of the 
comparison. If the folders are different, the affected files are 
highlighted. Double-click the arrow between the computer names to 
switch between host and remote list boxes and view highlighted files.

Synchronizing and cloning folders
The processes of synchronizing and cloning folders are similar and both 
produce the same end result: host and remote folders will be identical to 
each other. The action taken and the effect upon the folders, however, is 
very different, and you should read this section carefully before using either 
feature.

Synchronization changes both host and remote folders by copying files in 
both folders to make the two folders identical to each other. Files that exist 
on the host but are missing on the remote are copied to the remote, and files 
that exist on the remote but are missing on the host are copied to the host. 
When duplicate filenames are encountered, the date and time stamp of the 
file are compared and the file with the most current date and time is copied. 
No files are deleted in a synchronization process.

In addition to synchronizing folders, you can synchronize selected files. For 
example, you may want to synchronize only the *.DOC files. Synchronization 
on selected files ensures that both host and remote directories contain 
identical files.

Cloning transfers and deletes files to make both folders identical to the 
source folder, that is, the folder you are in when you choose the CLONE menu 
command. Files that are in the source folder but are missing on the 
destination folder are transferred. Files that exist in the destination folder that 
are not in the source folder are deleted from the destination folder.
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To synchronize folders:

1 Choose FILE TRANSFER from the host or remote online menu. (See 
“Online menus” on page 91 for instructions on accessing online 
menus.)

2 Choose the host and remote folders you wish to synchronize.

3 Choose SYNCHRONIZE from the File menu or click the Sync button on 
the file manager button bar.

Figure 7-23

4 Verify that both the host and remote folders are correct in the 
Synchronize Folder dialog box.

5 Click OK to begin synchronization.

To synchronize selected files in a folder:

1 Choose FILE TRANSFER from the host or remote online menu. (See 
“Online menus” on page 91 for instructions on accessing online 
menus.)

2 Choose the remote and host folders that contain the files you wish to 
synchronize. (See “Selecting files and folders” on page 109 for 
details.)

3 Choose FILTER from the View menu.
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Figure 7-24

4 Click the button for the file type you want to synchronize or type a 
specific filter in the Custom text box.

5 Click OK.

The folder lists only the files specified in the filter.

6 Set a filter for the other list box following steps 3 and 4 above.

TIP: Click the arrow between the computer names to easily switch between 
list boxes. The arrow indicates the direction of the file transfer.

Synchronization affects the files listed in each list box at the time you execute 
the command. You must create a filter for both host and remote directories to 
restrict the synchronization process to those specific files.

To clone a folder:

WARNING! Cloning could result in data loss. Files in the destination folder 
that are not in the source folder will be deleted from the disk. If you are 
unsure of the files that will be deleted, perform a folder compare first. 
Comparing folders creates a display of the file differences (See “Comparing 
folders” on page 117).

1 Choose FILE TRANSFER from the host or remote online menu. (See 
“Online menus” on page 91 for instructions on accessing online 
menus.)

2 Select the folder that you want to duplicate (the source), then select 
the folder to be adjusted so that it becomes an exact match of the 
source folder (the destination). 

3 Choose CLONE from the File menu.
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Figure 7-25

4 Verify that the source and destination folders are correct.

5 Click OK to begin the cloning process.

To exit file manager and return to the remote control session:

■ Choose EXIT FILE MANAGER from the File menu to exit file manager 
and return to the remote computing session.





8
Customizing 
application options

Application options are global settings used in pcANYWHERE’s various 
modes of operation. pcANYWHERE uses default settings for these options 
unless the user customizes them. These default settings are the most 
commonly used and it may not be necessary to change them. 

Options configured in the Application Options properties sheet affect all 
sessions on the PC. Some options can be temporarily changed during an 
individual remote control or online service session, but the changes affect 
only the current session and do not modify the configured settings. 

The Application Options properties sheet contains nine property pages:

System Setup: Use this page to name your computer and configure your PC’s 
dialing properties.

Remote Operation: Use this page to configure options to use during all 
remote computing sessions.

Remote Printing: Use this page to add remote PC printer definitions to allow 
the remote caller to print to the local printer during a session.

DOS Sessions: Use this page to configure settings to optimize the remote’s 
display when displaying some DOS characters.

Host Operation: Use this page to set global host options to use for every host 
session. 

TCP/IP: Use this page to create a list of TCP/IP hosts.

File Transfer: Use this page to set file transfer options for the ZMODEM, 
ASCII, and pcANYWHERE file transfer protocols.

Terminal Emulation: Use this page to adjust terminal settings for any of the 
supported terminal types and to configure macro keys and translation tables 
to use during terminal emulation connections.

Button Bars: Use this page to customize the pcANYWHERE action bars and 
toolbar with only the functions you want to access.
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System Setup
Use the System Setup property page to name your computer and configure 
your PC’s dialing properties. When you are a host PC, your computer name 
appears in the title bar on the remote PC’s screen. Your computer name is 
also used to identify your PC as an available host on the network.

pcANYWHERE allows you to create and maintain one or more dialing 
configurations. For example, when making calls from your office PC, you 
may use a configuration that dials 9 first to obtain an outside line, but when 
making calls from your home PC, you would use a configuration that does 
not use the dial 9 option. 

To configure system setup options:

1 Choose APPLICATION OPTIONS from the File menu.

Figure 8-1

2 Do one of the following:

■ Click User Defined and type a name for your PC. 

■ Click Windows Computer Name to use the name displayed in the 
text box. This is the name you entered when you installed 
Windows 95 or Windows NT.

Click to change or 
add dialing 
information

Text box displays 
computer name 
entered during 
the Windows 95 
and Windows NT 
installation
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NOTE: If the network administrator has disabled the user-defined 
computer name option, you only will be able to view either your 
Windows computer name or your network address, depending on 
which name the administrator used. 

3 Verify that the location and area code listed in the dialing properties 
group box is correct. 

■ If it is correct stop here.

■ If it is not correct for your location, proceed to step 4.

4 Click Dialing Properties.

Figure 8-2

5 Set the dialing properties for your PC and click OK.

You return to the Application Options properties sheet.

6 Type the name of the cryptographic certificate store to use for 
encryption. A certificate store is created by the network administrator 
and contains certificate authorities.

7 Check Use NT Event Log to use the Windows NT Event Viewer to 
monitor the server security events.

Click to create 
a new dialing 
configuration
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Remote Operation
The settings configured in the Remote Operation property page affect every 
remote control session on the PC or workstation. These options can be 
changed during a session. The changes affect only the current session, 
however, and do not change the settings configured in the Remote Operation 
property page. (See “Online Options” on page 103 for information on 
changing these options during a session.)

To configure remote control operations:

1 Choose APPLICATION OPTIONS from the File menu.

2 Click the Remote Operation tab in the Application Options 
properties sheet.

Figure 8-3
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3 Set the following remote options as needed.

■ ColorScale™: Specifies the number of colors the host uses when 
translating bitmaps. Choose two or four colors to optimize the 
screen display on the remote during the session. 

NOTE: To use this option effectively, the color palette on the host 
PC must be set to 256 colors or greater.

■ pcANYWHERE Cache File Size: Specifies the amount of disk 
space pcANYWHERE uses when caching bitmap information 
during a remote control session. If the bitmap is in the cache 
when a Windows screen is redrawn, the data does not have to be 
resent, which results in better performance. The default value is 
set by the Smart Setup wizard the first time pcANYWHERE is run 
and is based on the disk space available on the PC.

You may want to reduce the cache file size when connecting to 
multiple hosts to ensure that cache is available for all the sessions. 
pcANYWHERE32 never uses more than fifty percent of available 
disk space for a cache file. 

■ Allow Connection To Multiple Hosts: Causes the pcANYWHERE 
application to remain open after making the first connection, 
allowing the remote PC to connect to multiple hosts. Each session 
occurs in a separate window and, when minimized, each session 
appears as a separate task in the taskbar. See “pcANYWHERE 
Cache File Size” above for information on using cache files in 
multiple sessions.

TIP: Leaving the pcANYWHERE application open uses memory 
resources. Leave this option unchecked to increase available 
memory. To quickly connect to additional hosts, drag the connection 
item to the Windows 95 desktop. (See “To connect to multiple 
hosts:” on page 78 for details.)

■ Optimize Desktop For Remote Control: Improves the 
performance of a session by disabling any desktop wallpaper, 
desktop pattern, full screen drag, screen saver, and power saver, 
configured on the host PC. 

■ Reduce Host Desktop Area To Match Remote: Causes the host to 
reduce screen resolution to match the resolution used by the 
remote PC. (This option is not supported under Windows NT, 
3.51.)
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■ Screen Scaling: Causes the host screen to scale down to fit in the 
remote terminal’s window. Check the box to enable this feature. 
If left unchecked, the remote user must scroll to view portions of 
the screen if the host image is too large to fit in the terminal’s 
window. 

■ Local Full Screen Display: Displays the host image full-screen on 
the remote PC. If unchecked, the host screen appears in a 
window. Press Alt+Enter to return to a windowed display.

■ Host Active Window Tracking: Automatically moves the remote’s 
view to any currently active window on the host. For example, 
during a session between computers using different screen 
resolutions, an error message on the host may appear out of the 
remote’s viewing area. 

■ Synchronize Mouse Buttons: Allows the remote caller to control 
the host using the same mouse configuration used on the remote 
computer. For example, if the remote caller is using a left-hand 
mouse configuration, the host mouse adjusts to allow left-hand 
mouse control of the session.

■ Use Local Fonts For Win 3.x Hosts: Improves the performance in 
a Windows 3.x session by having the remote use a local font that 
closely matches the font used at the host. This option is checked 
by default. If text is not displayed correctly on the remote, 
uncheck this check box.

Remote Printing
Remote printing allows the remote caller to print to the printer at the 
remote’s location as well as to the host printer during a session. 

To add remote printer definitions on the host PC:

1 Choose APPLICATION OPTIONS from the File menu.

2 Click the Remote Printing tab.
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Figure 8-4

3 Click Add Printer to add a remote printer definition to the list.

4 Do one of the following procedures:

■ Select the remote printer driver from the list of Currently Installed 
Drivers and click Next.

■ Select the manufacturer and model of the remote printer from the 
Manufacturers and Printers list boxes and click Next. 

5 Type a name that identifies the owner or location of the remote 
printer and click Finish. The remote caller selects this name to print 
to the local printer during a session.

6 Click OK to return to the pcANYWHERE main window.

NOTE: If the remote printer driver is not listed in the Manufacturers 
list box, install it following the manufacturer’s instructions. After 
installation, you can select it as a remote printer from the Currently 
Installed Driver list. 
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DOS Sessions
When the host is running DOS in a full-screen window, or when the host 
user has exited to DOS, the host screen may contain characters that differ 
from the screen display when the host PC is running Windows. The 
following options allow the remote user to make adjustments to several DOS 
display characteristics if the remote PC experiences problems reading and 
displaying the host screen.

To change settings for DOS sessions:

1 Choose APPLICATION OPTIONS from the File menu.

2 Click the DOS Sessions tab.

Figure 8-5

3 Configure the DOS session options you want to use.

■ Special Keyboard Handler: Specifies which special keyboard 
handler to use during a session. This option can be changed 
during a session by accessing the remote online menu. For more 
online menu and keyboard handling information, see “File 
transfers and session management” on page 91.

■ Synchronize Display With Host: Slows the host application to the 
rate at which the remote can display screen activity. If this option 
is unchecked, some lines of text may scroll off the screen before 
the remote is able to display them. If the speed of the application 
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is more important than a complete display of all characters, such 
as with a lengthy database indexing procedure, uncheck this 
option.

■ Full Graphics Support: Provides the best possible representation 
of DOS graphics. Uncheck to improve speed, when an 
approximation of graphics is acceptable.

■ Fonts/Colors: Determines the background and foreground colors 
to use during the session as well as the font style and size.

Host Operation
The options on the Host Operation property page control the ring number 
on which the host answers incoming calls and the video mode used for all 
sessions. 

To configure host operation options:

1 Choose APPLICATION OPTIONS from the File menu.

2 Click the Host Operation tab.

3 Type the number of rings after which the host answers an incoming 
call. Any number from 1 through 99 can be used.

4 Select the host’s video mode:

■ Default (Accelerator Enabled): Maximizes the performance of a 
pcANYWHERE32 remote control connection. This is the preferred 
video mode and should be selected unless you experience video 
problems on the host.

■ Accelerator Disabled: Select this option if the host is using a 3D 
accelerator video card. 

■ Compatibility: Select this option if you experience incomplete or 
distorted video display when connected to the host.

TCP/IP Hosts
Use the TCP/IP host list to add the names or addresses of pcANYWHERE 
hosts available on your TCP/IP network or the Internet. pcANYWHERE32 
uses this information to generate an Internet host list. The host names and IP 
addresses appear in the Network Hosts dialog box after you launch a remote 
control connection item. For additional information, see “To make a modem 
connection to the host:” on page 76.
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You can create a list of TCP/IP hosts using any of the following identifiers:

■ pcANYWHERE Host Name: Use a pcANYWHERE host name if the 
host is located on the local subnet. The host name appears in the 
Network Hosts dialog box. 

■ DNS Name: Use a DNS name if the network administrator has 
assigned a DNS name and an IP address to the host PCs. 

■ Host IP Address: Use an IP address to connect to a host regardless of 
the subnet it is located on. The host IP address appears in the 
Network Hosts dialog box. 

■ Specific Group IP Address: Substitute 255 for the last portion of an IP 
address to display all hosts having an IP address containing the first 
three portions of the group address. For example, an address of 
120.45.62.255 in the TCP/IP list causes pcANYWHERE to list all hosts 
with IP addresses beginning with 120.45.62.

TIP: Use this addressing method when the host PC is connecting to 
the Internet through an Internet service provider.

To create a list of TCP/IP hosts:

1 Choose APPLICATION OPTIONS from the File menu.

2 Click the TCP/IP tab.

Figure 8-6
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3 Enter the TCP/IP host name, IP address, DNS name, or specific 
subnet address in the TCP/IP Hosts To Search For text box. 

NOTE: A pcANYWHERE host name can be used only for hosts on 
the local subnet. 

4 Click Add. 

5 Repeat steps 3 and 4 for each host you want to add.

To remove a TCP/IP host name from the list:

1 Click the address or name of the TCP/IP host you want to remove.

2 Click Remove.

File Transfer
The File Transfer property page allows you to specify a default folder for 
your downloaded files, enable virus checking on all files transferred, and 
customize options for three file transfer protocols. If you do not specify a 
default download folder, your transferred files are downloaded to the folder 
where pcANYWHERE is installed.

If pcANYWHERE detects a virus on the file you are attempting to download, 
the file transfer process is canceled.

To specify a default download folder:

1 Choose APPLICATION OPTIONS from the File menu.

2 Click the File Transfer tab.
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Figure 8-7

3 Check Pause Remote Control To Optimize File Transfer Performance. 
Leave unchecked if file transfer speed is not a priority and you want 
to run remote control and file transfer simultaneously. 

This feature can be enabled and disabled during a connection. (See “To 
start a file transfer from the remote:” on page 111 for additional 
information.)

4 Do one of the following:

■ Enter a path in the Download Folder text box.

■ Click Browse to select a folder.

5 Check Virus Check All Downloaded Files to cause Norton AntiVirus 
to scan all files for viruses before downloading.

File transfer protocols
File transfer protocols are used by computers to reduce errors when 
exchanging data. In any type of connection, both computers must use the 
same protocol. When making a remote control connection, pcANYWHERE 
uses its own file transfer protocol. When making connections to online 
services, pcANYWHERE uses the protocol that is supported by the online 
service. ZMODEM is commonly used, but many systems also support such 
protocols as XMODEM and Kermit. Check with your system administrator to 
determine which type to use.
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To configure the pcANYWHERE file transfer protocol:

1 Choose APPLICATION OPTIONS from the File menu.

2 Click the File Transfer tab.

3 Select pcANYWHERE from the Protocols group box and click 
Settings.

Figure 8-8

4 Click the Destination File prompt button and select a file overwrite 
option from the drop-down list:

■ Never Overwrite Duplicate Files: Prevents pcANYWHERE from 
transferring a file if a duplicate filename is found in the 
destination folder. 

■ Always Overwrite Duplicate Files: Allows pcANYWHERE to 
transfer the file and automatically overwrite any duplicate file 
found in the destination folder.

■ Verify Before Overwriting: Warns you that a duplicate filename 
exists in the destination folder, and asks you to confirm the file 
transfer.

■ Always Ask For Destination: Causes pcANYWHERE to always ask 
you what folder to place the file in.

■ Overwrite Older Files Only: Allows pcANYWHERE to 
automatically overwrite duplicate files if they are older than the 
file being transferred. 

5 Check one or all of the following options:

■ Use Compression: Improves file transfer speed. Files compressed 
by pcANYWHERE are automatically uncompressed to their 
original states before being written to the destination drive. If files 
are already compressed by a compression scheme such as PKZIP, 
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there will be no noticeable improvement in the speed of the file 
transfer.

■ Allow Crash Recovery: Allows an interrupted file transfer process 
to restart at the point at which the file transfer was previously 
disconnected. If crash recovery is not selected, an interrupted file 
transfer starts at the beginning of the file. Crash recovery should 
be considered when transferring very large files.

■ Use SpeedSend: Enhances the performance of a file transfer of 
files with duplicate filenames by comparing the two files and 
transferring only the data that is different in the source file.

6 Click OK to save settings and return to the File Transfer property 
page.

To configure the ASCII file transfer protocol:

1 Choose APPLICATION OPTIONS from the File menu.

2 Click the File Transfer tab.

3 Select ASCII from the Protocols group box and click Settings.

Figure 8-9
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4 Set the appropriate ASCII settings.

■ Pacing: Changes the pace at which characters and lines are 
transmitted and the character that is used as the pace character 
between lines. The transmitting computer sends a line then waits 
for the pace character before sending another line.

■ Download Timeout: Sets the number of seconds of idleness after 
which the download activity will be terminated.

■ Upload Translations: Determines how carriage returns and 
linefeeds are translated while uploading information. For 
example, if data files on the host computer end lines with single 
carriage returns, you may want to strip the linefeeds when 
uploading these files.

■ Download Translations: Determines how carriage returns and 
linefeeds are translated while downloading information. For 
example, if data files on a host computer end lines with single 
carriage returns, you may want to interpret each carriage return as 
a carriage return/linefeed when downloading the files.

5 Click OK to accept settings and return to the Application Options 
property sheet.

To configure the ZMODEM file transfer protocol:

1 Choose APPLICATION OPTIONS from the File menu.

2 Click the File Transfer tab.

3 Select ZMODEM from the Protocols group box and click Settings.

Figure 8-10
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4 Set the appropriate ZMODEM settings:

■ Error Checking: 32-bit error checking provides the most accurate 
results. 

■ Data Window: Transmitting computer waits for acknowledgment 
of each buffer or window content before sending more data. 
When using a modem with error-checking capability, data is 
transmitted more quickly without a window. When using a 
window for the most possible accuracy, the larger the window 
the better, because there are fewer acknowledgments to make. 
Start with the 4K window, then reduce to the 2K if you have 
problems. 

■ Crash Recovery: Allows an interrupted file transfer process to 
restart at the point at which the file transfer was previously 
disconnected. If crash recovery is not selected, an interrupted file 
transfer starts at the beginning of the file. Crash recovery should 
be considered when transferring very large files.

■ Allow Auto Downloading: When you download files, ZMODEM 
can start the transfer automatically. You tell the online service 
what you want to download and the status box for ZMODEM 
displays.

Terminal Emulation
pcANYWHERE for Windows 95 and Windows NT includes a wide variety of 
the most commonly used terminal emulators. Although most users do not 
need to adjust terminal settings, you can customize each of the terminal 
emulators to your needs and preferences. Terminal settings specify how each 
type of emulation operates on your computer. These settings involve both 
display and keyboard performance. To configure a terminal emulator:

1 Choose APPLICATION OPTIONS from the File menu.

2 Click the Terminal Emulation tab.
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Figure 8-11

3 Choose any of the following display options:

■ Automatic Font Sizing: Causes pcANYWHERE to automatically 
select the font size displayed on the remote screen, based upon 
the size of the terminal window.

■ Automatic Scroll Bars: Causes the screen to display horizontal and 
vertical scroll bars.

■ Status Line: Causes display of a status line at the bottom of the 
screen. This status line contains the terminal type, communication 
port, data rate, parity, and flow control being used.

4 Do one of the following:

■ Click Apply to save settings and leave the Applications Options 
properties sheet open.

■ Click OK to save settings and return to the pcANYWHERE main 
window.

Macro keys
Macro keys are key combinations for user-defined functions associated with 
them, such as keyboard commands, running a script file, or executing a 
program. You may specify up to ten different macro keys for use during 
pcANYWHERE terminal emulation sessions. Macro keys are stored in files 
with the .MK7 extension.
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To configure macro keys:

1 Choose APPLICATION OPTIONS from the File menu.

2 Click the Terminal Emulation tab.

3 Click Macro Keys to display the Select Macro Key File dialog box.

Figure 8-12

4 Select a folder for the macro key files. You can accept the default 
folder (where pcANYWHERE is installed) or select a new folder from 
the drop-down list box.

5 Do one of the following:

■ Choose an existing macro key file.

■ Create a new macro key file by typing a new filename in the File 
Name text box.

6 Click OK.

Figure 8-13

7 Choose a key combination from the Macro Key list box.
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8 Choose an option button in the Macro Type group box to specify the 
macro type:

■ Send Text: Indicates the macro is a command or group of 
keystrokes to be transmitted.

■ Execute A Script: Indicates the macro is a pcANYWHERE script to 
be executed.

■ Run A Program: Indicates the macro is a program to be executed.

9 In the Text/Script/Program text box, enter macro keystrokes or a 
complete path and filename for the pcANYWHERE script to run or 
program to execute.

10 Click OK to save the macro key settings and return to the Terminal 
Emulation property page. 

Translation tables
Translation tables translate one character to another. You can translate 
characters you are sending, receiving, or both. Translation tables are stored in 
files with the .TRN extension. You can have several .TRN files, and you can 
assign the same .TRN file to more than one session object.

CAUTION: This is an advanced feature intended for users who are 
experienced with communication programs. You probably do not need to 
edit translation tables. This feature is used only when the keyboard does not 
behave as expected because of an incompatibility between an online service 
and a pcANYWHERE terminal emulator, or to filter certain codes sent by the 
host.

To set up a translation table:

1 Choose APPLICATION OPTIONS from the File menu.

2 Click the Terminal Emulation tab.

3 Click Translation Tables to display the Select Translation File dialog 
box.
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Figure 8-14

4 Do one of the following:

■ Choose an existing translation table file.

■ Create a new translation file by typing a new filename in the File 
Name text box.

5 Click OK.

Figure 8-15

NOTE: When you enter a new filename to create a translation table, 
pcANYWHERE loads a default table that does not specify any 
translations. You must edit this default table and specify the 
translations needed.

6 Click the code you want to change. 
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The selected code number and current hexadecimal values appear in 
the Modify Table Entry group box (see Figure 8-15).

7 Enter the new hexadecimal translation values for the selected code. 

8 Repeat steps 6 and 7 to enter additional values.

9 Click OK to return to the Terminal Emulation property page.

Fonts and colors
You can select your preference of background and foreground colors your 
monitor uses during a connection with an online service, as well as choose a 
font and size to improve the readability of the text on your screen.

To customize your display’s color and font:

1 Choose APPLICATION OPTIONS from the File menu.

2 Click the Terminal Emulation tab. 

3 Click Font/Colors to display the Font dialog box.

Figure 8-16

4 Choose a font style and size to use from the Font and Size drop-
down list boxes.

5 Choose the colors to use from the Foreground Color and 
Background Color list boxes.

6 Click OK to save the settings and return to Terminal Emulation 
property page. 
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Customizing the action bar and toolbar options
The action bar is a graphical representation of the pcANYWHERE functions 
listed in the Action menu (Figure 8-17). The action bar can be customized to 
display only the actions you want. In addition, you can customize the size of 
the action buttons by choosing to display the button with the icon only for a 
small button or icon with text for a larger button. 

Figure 8-17 Action bar and Action menu

The toolbar is a graphical representation of the options available in the View 
and File menus (Figure 8-18). The toolbar can be customized to hide the 
folder history, the folder browse box, or both.

Figure 8-18 Toolbar
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To customize the action buttons and toolbar options:

1 Choose APPLICATION OPTIONS from the File menu.

2 Click the Button Bars tab. 

Figure 8-19

3 Check the actions you want to appear on the action bar. 

4 Choose the size of the button by clicking Icon Only for a smaller 
button, or Icon And Text for the larger button. 

5 Check the toolbar options you want to display.

■ Allow Folder Browse: Check to display the folder browse box 
allowing you to change folders.

■ Show Folder History: Check to display a list of the most recently 
selected folders.

6 Do one of the following:

■ Click Apply to save the settings and leave the Application Options 
properties sheet open.

■ Click OK to save the settings and return to the pcANYWHERE 
main window.
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Gateways
pcANYWHERE’s gateway feature allows network users to shar
communications device, usually a modem, attached to any PC on the 
network. The gateway provides dial-in and dial-out services that allow 
network users access to systems off the local area network (LAN) and allows 
off-LAN users to access the network. For example, a network user can call 
someone who is connected to a different network—even if neither user has a 
modem—as long as both networks have gateways.

The gateway can be either unidirectional or bidirectional. A unidirectional 
gateway waits for either incoming calls from the modem or for outgoing calls 
from the network, but not both types. A bidirectional gateway accepts calls 
from either the network or the modem.

Gateway concepts
A pcANYWHERE gateway takes the information from one communications 
device, converts it, and sends it out through the other communications 
device. The gateway is designed to operate completely in the background 
and allows network users at gateway stations to continue operating their PCs 
without interruption.

To properly set up a gateway PC, you must specify two connection devices: 
one for the network and one for the modem (or other communications 
device). For example, if users on a network want to access a gateway PC on 
the network to use its modem to dial an online service such as a electronic 
bulletin board system (BBS), the gateway PC should be set up as follows:

■ Network as the incoming connection device (because the gateway 
receives calls from users on the network). 

■ Modem as the outgoing connection device (because the gateway’s 
modem is used to dial the online service).

For a unidirectional gateway, the incoming configuration indicates what 
device the gateway accepts data from and the outgoing configuration 
indicates what device the gateway sends data to. 

Using bidirectional gateways on the network allows outside users access to 
the network and network users access to host PCs and online services. Using 
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two unidirectional gateways, each sending data in the opposite direction, 
also provides this functionality; however, this requires two PCs.

A single unidirectional gateway allows you to restrict calls to only incoming 
or only outgoing calls. For example, with a unidirectional gateway that 
receives calls from the network and sends data over the modem, you allow 
network users to make connections to each other and call off-LAN but 
prevent any outsiders from accessing (dialing into) the network.

Configuring gateway connection items
You can create connection items manually or you can run the Add Be A 
Gateway Item wizard (Figure 9-1). The wizard allows you to configure the 
name and connection devices for the connection item, and uses default 
settings in the remaining property pages. See “pcANYWHERE32 connection 
items” on page 11 for information on connection items.

To customize the wizard’s default settings, you can edit the connection item’s 
properties.

Figure 9-1
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To create a new gateway connection item:

1 Click the Gateway action button.

2 Do one of the following:

■ Choose NEW from the File menu.

■ Right-click in the gateway window and choose NEW from the 
context menu.

To modify a connection item’s properties:

Do one of the following:

■ Right-click the connection item and choose PROPERTIES from the 
context menu.

■ Click the connection item and choose PROPERTIES from the File 
menu.

Figure 9-2

The gateway connection item’s properties sheet contains three property 
pages:

Connection Info: Use this page to select the incoming and outgoing hardware 
device this gateway connection item will use for each session. 
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Settings: Use this page to configure the gateway for bidirectional operation 
and assign an optional classification for the gateway. 

Protect Item: Use this page to protect the selected gateway item with a 
password. 

To configure gateway connection information:

1 Open the gateway item’s properties sheet. (See “To modify a 
connection item’s properties:” on page 149 for information.) 

2 Select the connection device the gateway uses for incoming and 
outgoing calls. (See “Connection devices” on page 31 for more 
information.)

To configure gateway settings:

1 Open the gateway item’s properties sheet. (See “To modify a 
connection item’s properties:” on page 149.)

2 Click the Settings tab.

Figure 9-3

3 Check one or both of the following options:

■ Bidirectional: Designates whether the gateway allows both 
incoming and outgoing calls. Unchecked, the gateway restricts 
calls to only incoming or only outgoing.

■ Inactivity Timeout: Specifies the maximum period of inactivity 
allowed before the gateway automatically ends the idle session.
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4 Enter a name for a gateway classification if you want this gateway to 
be part of a group of gateways. Gateway classes are commonly 
based on the speed of the modem. For example, a network 
administrator might create a class of 9600-bps gateways called 
“9600.”

Password-protect item
You can protect a gateway connection item from being modified, viewed, or 
executed by another user when you assign a password to the item. The same 
password can be used to protect all your connection items, including those 
under the other action buttons. 

See “Protecting connection items” on page 12 for more information on 
password-protecting connection items. 

Starting a gateway session
The pcANYWHERE32 gateway makes connections using the connection 
device information in the Connection Info property page and the settings 
configured in the Settings property page.

To load the gateway:

1 Click the Be A Gateway action button.

2 Do one of the following:

■ Double-click the gateway connection item that contains the 
settings you want to use.

■ Right-click the gateway connection item you want to use and 
choose LAUNCH GATEWAY from the context menu.

The gateway loads into memory and routes incoming and outgoing calls as 
configured in the gateway connection item properties sheet.

For information on making connections using a gateway PC, see “Connecting 
through a gateway” on page 79.
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Online services
An online service is a service such as CompuServe, Dow Jones, MCI Mail, or 
an electronic bulletin board service (BBS) such as the Symantec BBS. The 
service may be on another PC, a mainframe, or a minicomputer. Online 
services offer information on a vast variety of topics. Each service usually has 
its own set of procedures by which you identify yourself and log in. During 
an online session, your PC mimics, or emulates, the type of terminal that the 
service uses to communicate. pcANYWHERE provides several terminal 
emulation types and file transfer protocols commonly used by online 
services. Each service will tell you which of these to use.

Before you can connect to an online service, you must first create one or 
more online service connection items. Each connection item is a 
pcANYWHERE file containing dialing instructions and other settings that are 
used to connect to a particular online service.

Whether you are using an online session to connect directly to a mainframe 
computer or to connect to a BBS over telephone lines, the procedures are 
similar. pcANYWHERE makes the connection using information contained in 
the online service connection item’s properties sheet. 

Creating online service connection items
You can create connection items manually or you can run the Add Online 
Service wizard (Figure 10-1). The wizard allows you to configure the name, 
connection device, and terminal emulation for the connection item, and uses 
default settings in the remaining property pages. (See “Quick Start wizards” 
on page 13 for information on pcANYWHERE’s wizards.)

To customize the default settings used by the wizard you can edit the 
connection item’s properties.
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Figure 10-1

To create a new online service connection item:

1 Click the Call Online Service action button.

2 Do one of the following:

■ Double-click the Add Online Service Item icon to run the wizard.

■ Choose NEW from the File menu.

■ Right-click in the online service window and choose NEW from 
the context menu.

To modify a connection item’s properties:

Do one of the following:

■ Click the connection item to select it and choose PROPERTIES from the 
File menu.

■ Right-click the connection item and choose PROPERTIES from the 
context menu.

The selected online service connection item’s properties sheet displays with 
the Connection Info page on top.
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Figure 10-2

The online service properties sheet contains five property pages:

Connection Info: Use this page to select the hardware device this online 
service connection item will use for each session. 

Settings: Use this page to configure terminal emulation and a file transfer 
protocol to automate your connections to the online service. 

Session: Use this page to configure session options such as recording a 
session in a file, running a script, using translation tables or macro keys, and 
creating an activity log. 

Advanced: Use this page to configure special settings for the terminal you are 
emulating such as line wrap, screen wrap, or translation of carriage returns.

Protect Item: Use this page to protect the selected online service item with a 
password. 

To configure online service connection information:

1 Open the online service item’s properties sheet. (See “To modify a 
connection item’s properties:” on page 154.)

2 Select the communication device this online service item uses to 
make a connection from the Device list. (See “Connection devices” 
on page 31 for information on configuring connection devices.)
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To configure online service settings:

1 Open the online service connection item’s properties sheet. (See “To 
modify a connection item’s properties:” on page 154.) 

2 Click the Settings tab.

Figure 10-3

3 Select a terminal emulation to use from the Terminal Emulation 
drop-down list box. Most bulletin boards and online services use 
ANSI. If the screen is not clear or accurate, try another emulation, or 
contact the bulletin board administrator or online service and ask 
which terminal type to use.

4 Choose a file transfer protocol to use from the File Transfer Protocol 
drop-down list box.

5 Do one of the following:

■ Enter the area code, phone number, and any required prefix, in 
the Use Manually Entered Prefix, Area Code, And Phone Number 
field. 

■ Click Use Dialing Properties And Phone Number to enter the area 
code and phone number. Use the dialing properties configured in 
the Location property page. 
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If the phone number is not provided in either of the above locations, 
you are prompted for one when you launch the connection item.

6 Click Dialing Properties to view the dialing properties of your 
current location or to create a new dialing properties location.

7 Enter values for either of the following options:

■ Number Of Redial Attempts: Sets the number of times 
pcANYWHERE will attempt to dial the host after a failed call.

■ Seconds Between Redials: Instructs pcANYWHERE how long to 
wait before attempting to redial the host after a failed call.

To configure online service session options:

1 Open the online service connection item’s properties sheet. (See “To 
modify a connection item’s properties:” on page 154.) 

2 Click the Session tab. 

Figure 10-4

3 Check any or all of the following options:

■ Record Session In File For Later Playback: Causes recording of the 
activities of the session to a file for playback later. You can type a 
new filename in the text box or you can use the Browse button to 
locate and use an existing record file. The new session is 
appended to the end of this file. (See “Utilities” on page 173 for 
information on session recording and playback.) 
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■ Run Script File After Connect: Causes execution of a script file 
when the session starts. Use the Browse button to display the 
Scripts dialog box from which you can select a script to run. Refer 
to online help or the Creating pcANYWHERE Scripts manual for 
information on creating and using scripts.

■ Use Translation Table File: Enables a translation table to be used 
for this session. Use the Browse button to view and select from 
available translation (.TRN) files. 

■ Use Macro Key File: Enables special macro keys to be used 
during the session. Use the Browse button to view and select 
from available macro (.MK7) files. (See “Macro keys” on page 139 
for information on creating macro key files.)

■ Save Session Statistics In Activity Log File: Causes session statistics 
to be saved in a log file. (See “Utilities” on page 173 for more 
information on log files and reports.)

■ Begin Script Recording After Connection: Creates a script file 
automatically from the activities occurring during this session. 
Refer to online help or the Creating pcANYWHERE Scripts manual 
for information on script commands.

To configure online service advanced options:

1 Open the online service connection item’s properties sheet. (See “To 
modify a connection item’s properties” on page 154.) 

2 Click the Advanced tab.
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Figure 10-5

3 Click Defaults to see the default values for the terminal you are 
emulating.

4 Check any of the following options to enable them:

■ Line Wrap: Determines how your monitor displays lines that 
exceed the width of the terminal display window. If Line Wrap is 
checked, lines that exceed the width of the display window 
continue on the next line. When the cursor reaches the far right 
side of the screen, the next character appears in the first position 
on the next line. If Line Wrap is unchecked, the cursor remains on 
the same line until a line feed is received.

■ Screen Wrap: Controls what happens when the entire screen is 
filled. If Screen Wrap is unchecked, the display scrolls, discards 
the top line of the display, and displays the new line at the 
bottom of the screen. If Screen Wrap is checked, the next line 
overwrites the top line when the cursor reaches the last position 
on the last line of the terminal display window.

■ Destructive <BS> Key: Causes the backspace key to act as a 
destructive backspace, that is to delete characters as it passes over 
them. If this option is unchecked, the backspace key will move 
the cursor to the left without deleting characters.

■ Translate Receive CR To CR/LF: Causes the cursor to move to the 
left side of the terminal display window and to advance one line 
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each time a carriage return character is received. Check this 
option only if the display does not scroll vertically as expected.

■ Break Length: Specifies the length of the break signal used to 
interrupt programs running on a mainframe or minicomputer. 
(This break should not be confused with the Ctrl+Break key 
combination, which sends a control character. This break is a 
sustained low signal used in online communications.) Do not 
alter the default break length setting of 5 unless required to by a 
specific online service.

Password-protect item
You can protect an online service connection item from being modified, 
viewed, or executed by another user when you assign a password to the 
item. You can use the same password for each of your connection items, 
including other action button connection items. 

For more information on password-protecting connection items, see “To 
password protect a connection item:” on page 12. 

Starting an online service session
Once you have established one or more online service connection items, 
starting a session with an online service is easy. 

To call an online service:

1 Click the Call Online Service action button.

2 Do one of the following:

■ Double-click an online service connection item.

■ Right-click an online service connection item and choose 
CONNECT from the context menu.

3 Enter the phone number of the online service. If you entered the 
phone number in the Settings property page, the number is dialed 
automatically and you are not prompted for one. (See “To configure 
online service settings:” on page 156.)

4 If you are connecting to the online service through a pcANYWHERE 
gateway, choose the gateway name from the list of available 
gateways. If you entered a gateway name in the Details property 
page for the selected network device, pcANYWHERE automatically 
connects to that gateway and a list of gateways is not provided. 
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(See “Connection devices” on page 31 for information on network 
configurations.)

NOTE: Log-on procedures vary from system to system. You can automate the 
log-on procedure by creating a custom script file that logs you onto the 
specified online service. Refer to online help or the Creating pcANYWHERE 
Scripts manual supplied with your software for information on script 
commands.

Managing the online service session
While you are connected to an online service, all session activities take place 
within the terminal window. You can access the pcANYWHERE Terminal 
menu bar, which is located near the top of the window, any time during and 
after completion of an online service session (Figure 10-6). These menus 
contain groups of related commands used to access pcANYWHERE’s features 
and options during a session.

Figure 10-6



Chapter 10.  Online services 162
Running scripts
A script is an executable file used to automate online service connections. 
pcANYWHERE scripts automate a variety of online service session activities. 
Scripts can be executed when a session starts or at any time during a session. 
For more detailed information on scripts, refer to online help or the Creating 
pcANYWHERE Scripts manual included on the pcANYWHERE32 CD. 

To start a script file during an online service session:

1 Begin an online service session. 

2 Choose SCRIPTS from the File menu.

The Scripts dialog box displays.

Figure 10-7

3 Choose a script file to execute from the Scripts list box.

4 Click Run to execute the selected script file.

Script recording 
pcANYWHERE can create a script automatically by recording the activities of 
a session and saving them to a script file. For example, with a script you can 
streamline a connection with an online service or electronic bulletin board, 
navigate the appropriate menus, upload your electronic mail, or post 
messages to a bulletin board.
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To create a script file automatically:

1 Begin an online service connection.

2 Choose RECORD SCRIPT from the File menu.

A cassette tape symbol appears in the title bar indicating that the 
procedures executed during the session are being recorded to a script 
file.

3 Proceed with the online service activities.

To stop the script recording:

1 Uncheck RECORD SCRIPT from the File menu. 

Figure 10-8

2 Enter a description that clearly defines what the script file 
accomplishes.

3 Click Save Script As.

Figure 10-9

4 Choose the folder in which you want to save the script file.

Click to choose a folder and filename 
for the recorded script file

Click if you do not want to save the 
recorded file

Click if you want to continue to record 
the script file
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5 Enter a filename for the script file in the File Name text box.

6 Click Save to save the script file.

Printing from the terminal window
Sometimes you need a printed copy of an online session or screen. Instead 
of using session recording to save the screen or session to a file, you can 
print directly from the terminal window. (See “Recording sessions” on page 
175 for more information.)

To print from the terminal window:

1 Begin an online service session. (See “Starting an online service 
session” on page 160.)

2 Do one of the following:

■ Choose PRINT ONLINE from the Sessions menu to enable session 
printing. Terminal window output is sent to your printer 
continuously during the session.

■ Choose PRINT SCREEN from the File menu to print only the current 
terminal display.

To end terminal window printing:

■ Choose PRINT ONLINE from the Sessions menu to disable session 
printing.

NOTE: A checkmark appears next to the PRINT ONLINE menu command when 
session printing is enabled. Printing a session is like using a camcorder or 
VCR; you need to start and stop the recording. Alternatively, when you 
choose PRINT SCREEN from the File menu, the action is more like taking a 
snapshot.

Editing terminal window text
The terminal window supports the use of the Windows clipboard. You can 
cut, copy, and paste text from the clipboard to the pcANYWHERE terminal 
window or you can upload clipboard contents directly to the online service, 
providing the Windows application from which you are copying the text 
supports the Windows clipboard.
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You can copy clipboard text to the local terminal window or you can upload 
it to the online service. You use standard Windows editing keys to edit text in 
the clipboard.

To copy and paste text from an application to the terminal window:

1 Switch to another Windows application (Alt+Tab).

2 Mark the text you want to copy or move by dragging the mouse 
cursor over it.

3 Do one of the following:

■ Choose COPY from the Edit menu of the other Windows 
application to copy the selected text to the clipboard.

■ Choose CUT from the Edit menu of the other Windows application 
to move the selected text to the clipboard.

4 Switch to the pcANYWHERE terminal window (Alt+Tab).

5 Do one of the following:

■ Choose PASTE from the terminal window’s Edit menu to place the 
text in the local terminal window.

■ Choose PASTE TO HOST from the terminal window’s Edit menu to 
send the text to the connected online service.

Adjusting session options
You can adjust hardware, terminal, and display options during a session with 
an online service. The ability to modify your settings during the session 
allows you to override the settings configured in the Terminal Emulation 
property page on the Application Options properties sheet. These 
modifications affect only the current session and do not change the settings 
configured in the Terminal Emulation property page. Check with your online 
service administrator or sysop for the correct session settings.

To adjust hardware settings during an online service session:

1 Begin a session with an online service. (See “Starting an online 
service session” on page 160.)

2 Choose HARDWARE from the Session menu.
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Figure 10-10

3 Choose the desired data rate, parity, and flow control for the session 
and click OK. (See “Connection devices” on page 31 for information 
on data rate, parity, and flow control.)

To adjust terminal emulation settings during an online service 
session:

1 Begin a session with an online service. (See “Starting an online 
service session” on page 160.)

2 Choose TERMINAL from the Session menu.

Figure 10-11

3 Select the desired terminal settings.

■ Emulation: Click the prompt button to select a different type of 
terminal emulation if your screen is not clear or accurate after 
connecting.

■ Font/Colors: Click to display the Windows Font And Colors dialog 
box, which allows you to change the font, font style, and point 
size, of characters in the Terminal window.

■ Line Wrap: Check this box to determine how your monitor 
displays lines that exceed the width of the terminal display 
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window. If Line Wrap is checked, lines that exceed the width of 
the display window continue on the next line. When the cursor 
reaches the far right side of the screen, the next character appears 
in the first position on the next line. If Line Wrap is unchecked, 
the cursor remains on the same line until a line feed is received.

■ Destructive BS: Check this box to cause the Backspace key to act 
as a destructive backspace, that is to delete characters as it passes 
over them. If this option is unchecked, the backspace key will 
move the cursor to the left without deleting characters.

■ Screen Wrap: Check this box to control what happens when the 
entire screen is filled. If Screen Wrap is unchecked, the display 
scrolls, discards the top line of the display, and displays the new 
line at the bottom of the screen. If Screen Wrap is checked, the 
next line overwrites the top line when the cursor reaches the last 
position on the last line of the terminal display window. 

■ CR TO CR/LF: Check this box to cause the cursor to move to the 
left side of the terminal display window and to advance one line 
each time a carriage return character is received. Check this 
option only if the display does not scroll vertically as expected.

■ Macro Keys: Check this box to enable special macro keys to be 
used during the session. Use the Browse button to view and 
select from available macro (.MK7) files. (See “Macro keys” on 
page 139 for information on creating macro key files.)

■ Translation Tables: Check this box to enable a translation table to 
be used for this session. Use the Browse button to view and 
select from available translation (.TRN) files. (See “Translation 
tables” on page 141 for more information on translation tables.)

4 Click OK.

To adjust display settings:

1 Begin a session with an online service. (See “Starting an online 
service session” on page 160.)

2 Choose DISPLAY from the Session menu.
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Figure 10-12

3 Check the desired display options.

■ Automatic Font Sizing: pcANYWHERE selects a font size based 
upon the size of the terminal window.

■ Automatic Scroll Bars: Causes horizontal and vertical scroll bars to 
appear on the screen.

■ Status Line: Causes the status line to appear at the bottom of the 
screen. This status line contains the terminal type, communication 
port, data rate, parity, and flow control currently used.

4 Click OK to close the dialog box and save the changes.

File transfer protocols
You can receive files (download) from or send files (upload) to an online 
service. To do so, you must follow the procedures for receiving or sending 
files required by the online service and by pcANYWHERE.

You must be sure that both the online service and your PC use the same file 
transfer protocol. Normally, you specify the name of the protocol as part of 
the session configuration. 

pcANYWHERE terminal mode offers a selection of the most popular file 
transfer protocols for use with online services. Most online services offer a 
number of different file transfer protocols, so finding a match should not be a 
problem.

Some online services let you register a preferred protocol that is used 
automatically whenever you download a file. Others prompt you to select 
from a list of available file transfer protocols. If you want to establish a 
protocol as the default for this online service, you can add this information to 
the Settings property page in the online service connection item’s properties 
sheet. (See “To configure online service settings:” on page 156.)
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To change the default file transfer protocol during a session:

1 Choose PROTOCOL from the Transfers menu in the pcANYWHERE 
Terminal window.

Figure 10-13

2 Select a file transfer protocol from the list provided and click OK.

NOTE: You can customize the ZMODEM and ASCII protocols 
supported by pcANYWHERE, although this is usually not necessary. 
For example, you can increase the level of error-checking the 
ZMODEM protocol uses. (See “File transfer protocols” on page 134 
for details.)

Uploading and downloading files
Whether you are downloading (receiving files) or uploading (sending files), 
file transfer is a cooperative effort between two computers. To download 
files after establishing a connection, select one or more files and initiate a file 
transfer using commands dictated by the online service. To complete the 
operation you need to initiate file receiving at your end of the connection. 
Uploading files is much the same, except for the direction of the data flow.

When you transfer files from online services, they are placed in the 
pcANYWHERE program folder by default. You can change the default by 
specifying a download, or target, folder. The target folder is the folder that 
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will receive the file, while the source folder is the folder from which the file 
is being sent.

To download files from an online service:

1 Begin an online service session.

2 Select a file for transfer and initiate a download by following the 
online service’s instructions.

3 Choose RECEIVE FILE from the Transfer menu.

Figure 10-14

4 Select the drive and folder in which you want the downloaded file to 
be sent. If the protocol dialog box for the particular protocol you are 
using provides a File Name text box, you can provide a name for the 
downloaded file. Otherwise, the file will be downloaded with the 
original filename.

TIP: If the online service supports ZMODEM you can use it to 
automate file downloading by enabling the pcANYWHERE Auto 
Download Protocol Option (see “File transfer protocols” on page 134 
for information on protocol settings). When you use ZMODEM with 
this feature enabled, pcANYWHERE anticipates incoming files and 
handles the download procedure automatically. Many online 
services that support this protocol also support automatic 
downloading of multiple files and optional automatic logoff upon 
completion of file transfer. For more information, contact your online 
service sysop or system administrator.

Target folder
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5 Change the target folder, if desired.

6 Click OK.

The file is transferred to the specified download folder.

To upload files to an online service:

1 Begin an online service session.

2 Initiate an upload according to the online service’s instructions.

3 Choose SEND FILE from the Transfer menu.

Figure 10-15

4 Choose a file for uploading.

5 If desired, change the target folder or edit the filename.

6 Click OK to send the file to the online service.

To end an online service session:

■ Choose EXIT from the File menu in the pcANYWHERE Terminal 
window to end the session and return to the pcANYWHERE main 
window.
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11
Utilities
This chapter explains pcANYWHERE’s utility functions. These 
accessed from the Utilities menu:

■ LIVEUPDATE: Automatically downloads available pcANYWHERE32 
updates and installs them on your computer. 

■ PLAYBACK SESSIONS/SCREENS: Plays back recorded remote control and 
online service sessions or specific screens you have saved from these 
sessions.

■ ACTIVITY LOG PROCESSING: Manages the session data by creating log 
files that record the time, date, and duration of sessions, as well as 
other information. You can create a report, delete old log 
information, or move information to a history file for archiving.

■ SCRIPTS: Allows you to create a new script, edit or compile an 
existing one, and run it. For information, see the Creating 
pcANYWHERE Scripts manual.

■ DATA CONVERSION: Converts configuration files from previous 
versions of pcANYWHERE to connection items in pcANYWHERE32.

Downloading pcANYWHERE32 updates using LiveUpdate
The LiveUpdate program connects to a Symantec LiveUpdate server and 
checks for any available pcANYWHERE32 updates. 

To download pcANYWHERE32 updates:

1 Choose LIVEUPDATE from the Utilities menu.

2 Select the device to use to connect to the LiveUpdate server and 
click OK.

3 Select the update you want to download from the Select Updates 
dialog box.
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Figure 11-1

4 Click Next to continue.

Live Update downloads the selected upgrade and automatically updates 
your version of pcANYWHERE32.

Capturing remote control and online session information
pcANYWHERE32 offers two utilities for obtaining and saving information 
from remote control or online service connections: 

■ Recording Files: Allows you to record all activities occurring during a 
session. Recording a session is similar to operating a VCR or audio 
tape recorder. You turn recording on and off as needed. Each start 
and stop defines the beginning and ending of a recorded session. 
Sessions are numbered in the recording file beginning with one.

■ Log Files: Allows you to capture information about remote control or 
online service sessions for curiosity, historical, or security purposes. 
For example, you may want to know just how often you call a 
particular host PC or online service to keep track of your total time 
online.
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Recording sessions
It is often helpful to have a recording of a remote control or online service 
session. For example, as the host user demonstrates a complex program or 
procedure, you can record the host screen instead of taking notes. You then 
can play back the recording to review the exact steps demonstrated.

Recording a session can be started in two ways:

■ Automatically Upon Connection: When recording is enabled in the 
Session property page of the remote control or online service 
connection item, recording begins immediately after the connection 
is established.

■ During A Session: Recording can be enabled during a remote control 
session from the remote online menu and during an online service 
session from the File menu.

To start recording automatically:

1 Right-click a remote control or online service connection item and 
choose PROPERTIES from the context menu.

2 Click the Session tab.

3 Check Record Session In File For Later Playback.

4 Type a name for the recorded file. If you leave this text box blank, 
you are prompted for a filename when you stop the recording or 
end the session.

5 Click OK.

Recording starts immediately after a connection is made. 

To start recording during a session:

1 Do one of the following:

■ In a remote control connection, choose RECORDING from the 
remote control online menu. 

■ In an online service connection, choose RECORDING from the 
terminal window’s File menu.
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Figure 11-2

2 Do one of the following:

■ Choose an existing record file to add the current recorded session 
to the end of that file.

■ Enter a new filename to save the session in a new record file. 

3 Click Save to save the session to the selected recording file.

To stop recording during a session:

Do one of the following:

■ In a Remote Control connection, choose RECORDING from the remote 
control online menu to disable the record option. 

■ In an Online Service connection, choose RECORDING from the 
terminal window’s File menu to disable the record option.

Playing back recorded sessions
When you play back a recorded session, you need to specify which file and 
which session within that file you want to replay. The sessions in a file are 
numbered in the order of their occurrence. pcANYWHERE automatically 
assigns an .RCD extension to record files.

During a replay of a session, you can do any of the following:

■ Copy a session or partial session to a new file.

■ Save a recorded session as a raw binary file so you can process the 
text data in an application that requires binary files.

■ Save a displayed screen from a recorded session as a screen shot.
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To play back recorded sessions:

1 Choose PLAYBACK SESSIONS/SCREENS from the Utilities menu.

Figure 11-3

2 If you saved the recording file to a specific folder, choose that folder 
from the Look In drop-down box. The default folder for screen files 
is the pcANYWHERE32 install folder.

3 Choose Record Files (.*RCD) from the Files Of Type drop-down box.

4 Choose the name of a recording file to play back and click Open.

Figure 11-4

5 Select the options you want to use during the playback.

■ Control Panel: Check to use the Playback Control Panel. If 
unchecked, the Playback Control Panel does not appear and you 
must select the options from the Controls menu.

■ Stop After Each Session: Click to cause the playback to stop after 
each recorded session. Choose NEXT from the Controls menu or 

Choose Screen Files to 
display all .SCN files

Choose Record 
Files to display all 
.RCD files
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click the button on the Control Panel to continue with the 
next session.

■ Repeat Current Session: Click to cause the session indicated in the 
Start Session group box to play back continuously.

■ Repeat All Sessions: Click to cause all the sessions in the recorded 
file to continuously play back.

■ Speed: Move the slider to the left to cause the playback speed to 
decrease and to the right to increase the playback speed. You can 
use the speed control during a playback. 

6 Click OK to start the playback. 

The Playback Control Panel appears if you checked the Control Panel 
option in step 5 above. If you did not check this option you can select 
the playback options from the Controls menu. 

Figure 11-5

The Playback Control Panel offers the following options:

Skip To Next Session: Choose NEXT from the Controls menu or click the 
 button on the Control Panel.

View Previous Session: Choose PREVIOUS from the Controls menu or click the 
 button on the Control Panel.

Pause Playback: Choose PAUSE from the Controls menu or click the Pause 
button on the Control Panel.

Resume Playback: Choose PLAY from the Controls menu or click the Play 
button on the Control Panel.

Stop Playback: Choose STOP from the Controls menu or click the Stop button 
on the Control Panel.

You can control 
playback using the 
control panel

You can select 
playback options 
from the Controls 
menu 

Click OPTIONS to 
display the control 
panel during a 
playback
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Save Session To Another File: Choose RECORD from the Controls menu or 
click the Record button on the Control Panel. Type a new filename or 
append the session to an existing file.

Save Session To A Binary File: Click Save Session on the Control Panel and 
type a filename for the binary file.

Saving screens
Capturing the contents of the screen during a session is like taking a 
snapshot with a camera. pcANYWHERE32 stores screen shots in a file with an 
.SCN extension. They appear in the order of occurrence, beginning with one.

To save session screens:

1 Begin a remote control or online service session.

2 Do one of the following:

■ In a remote control session, choose SAVE SCREEN from the remote 
online menu. (See“Online menus” on page 91 for more 
information.)

■ In an online service session, choose SAVE SCREEN from the 
terminal window’s File menu.

3 Type a filename to save the screen to a new file or select an existing 
filename to add the screen to the end of the file.

Repeat the above steps for each screen you wish to save. The screens 
are saved in the selected file in the order they are captured, starting 
with one.

To play back recorded screens:

1 Choose PLAYBACK SESSIONS/SCREENS from the Utilities menu.

2 If you saved the screen file to a specific folder, choose that folder 
from the Look In drop-down box. The default folder for screen files 
is the pcANYWHERE32 install folder.

3 Choose Screen Files (*.SCN) from the Files Of Type drop-down box.

4 Select the screen file you want to play back and click Open.

5 Choose NEXT or PREVIOUS from the Controls menu to view other 
screens captured in that file.
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Logging remote control and online service sessions
A pcANYWHERE32 log file contains information on every session the host or 
remote PC participates in. The host user can track who has made 
connections to the host, the session start and end times, and how the session 
was ended. The remote user can track hosts called, file transfer activities, and 
review comments from the remote user.

To log sessions on the remote PC:

1 Right-click a remote control or online service connection item and 
choose PROPERTIES from the context menu.

2 Click the Session tab.

3 Check Save Session Statistics In Log File on the Session property 
page and click OK.

Repeat the above steps for each connection item you want to log.

To log sessions on the host PC:

1 Right-click a host connection item and choose PROPERTIES from the 
context menu.

2 Click the Callers tab.

3 Choose Specify Individual Caller Privileges on the Callers property 
page.

4 Right-click a caller connection item and choose PROPERTIES from the 
context menu.

5 Click the Advanced tab.

6 Check Save Session Statistics In Activity Log on the Advanced 
property page and click OK.

Repeat this procedure for every caller you want logged.

Creating an activity log report

From the information stored in log files, you can create a chronological 
listing of connections called an activity log report. You can display this report 
on screen or write it to a text file to print later.

Remote logging of host connections includes data for each logged session.
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Figure 11-6

Host logging of remote connections includes data for each logged session. 

Figure 11-7

To create and view a log report:

1 Choose ACTIVITY LOG PROCESSING from the Utilities menu.

2 Do one of the following:

■ Choose Remote Session Log to create a report of host connections 
made by this remote PC.

Date and 
time of 
connection

File transfer 
information on 
any file sent 
or received 
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session

Optional 
comments of 
remote caller 
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time of 
connection

Date and 
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session 
disconnect

Name of remote 
caller as listed in 
the Callers 
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the host 
connection item

Cause of session 
disconnect

Host PC name as 
specified in the 
host’s application 
options properties 
sheet

Name of 
registered 
user
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■ Choose Host Session Log to create a report of remote calls made 
to this host PC.

3 Click Report

4 Type a filename for the report and click Open.

Figure 11-8

5 Check the remote or host options you want to include in the log 
report.

6 Enter a date range if you want a report that covers only a specific 
period of time.

7 Click OK then click Yes to view the log file.

The log report displays in the selected format.

Deleting and archiving logged information
The pcANYWHERE32 log files are named AW.RL6 for the remote and AW.HL6 
for the host. New log information is appended to these log files, causing 
them to increase in size. When a log file becomes too large, you can delete 
or archive some of the older data to a history log file. History log files are 
named AW.RH6 for the remote and AW.HH6 for the host. 

Host options are 
grayed when 
creating a remote 
log report

Enter a date range to 
control which log 
entries are included 
in the report
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To delete or archive log file data:

1 Choose ACTIVITY LOG PROCESSING from the Utilities menu.

Figure 11-9

2 Do one of the following:

■ Select Host Session Log to archive a host log file.

■ Select Remote Session Log to archive a remote log file.

3 Click Archive/Delete. 

Figure 11-10

4 Enter start and end dates for the data you want to archive or delete 
in the Date Range group box.

5 Check one or both of the following:

■ Copy Log Entries To Archive File: Copies data in specified date 
range to a compressed archive file.

■ Delete Log Entries From Source: Deletes data in specified date 
range from the log file.

6 Click OK.

To create a log report using archived data:

1 Choose ACTIVITY LOG PROCESSING from the Utilities menu.

2 Do one of the following:

Archived session 
log data is saved in 
history log files
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■ Choose Remote History Log to create a report using archived data 
of host connections made by this remote PC.

■ Choose Host History Log to create a report using archived data of 
remote calls made to this host PC.

3 Create the report as described in “To create and view a log report:” 
on page 181.

Data conversion
You can use the data conversion utility to convert data configuration files 
from earlier versions of pcANYWHERE to pcANYWHERE32 format. The data 
conversion utility in pcANYWHERE32 can be used to:

■ Convert configuration files from a previous version of pcANYWHERE 
so that they can be used as connection items in pcANYWHERE32 for 
Windows 95 and Windows NT.

■ Export configuration files from a previous version of pcANYWHERE 
to a text data file for report generation.

■ Import data from a pcANYWHERE text data file into 
pcANYWHERE32 connection items. 

To convert configuration files:

1 Choose DATA CONVERSION from the Utilities menu.

Figure 11-11

2 Click Convert pcANYWHERE Data Files and click Next.
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Figure 11-12

3 Choose the previous version of pcANYWHERE from the Version 
drop-down box. 

4 If the configuration files are from a network installation of 
pcANYWHERE, type the configuration file’s user ID.

5 Indicate which folder the old configuration files can be found in and 
click Next.

Figure 11-13
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version of 
pcANYWHERE 
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box
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installation
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6 Indicate the folder where you want to save the converted files by 
typing a folder name in the Destination Folder text box. Click 
Browse to locate and select a folder.

7 Click Finish to complete the conversion.



e following 

A
Data encryption
This version of pcANYWHERE32 encrypts data using any of th
encryption methods:

■ Public Key: Provides the highest level of session security by using 
pre-defined keys distributed by a certificate authority.

■ Symmetric: Uses similar session security options as Public Key, 
however, it does not use certificate authority issued certificates for 
authenticating callers. 

■ pcANYWHERE: Provides minimum data security by using a simple 
transformation of data to prevent data interception by third parties.

Basic encryption concepts
Modern encryption methods rely on a cryptographic key—typically a long 
string of alphanumeric characters—to determine how an encryption 
algorithm scrambles and unscrambles the data. A cryptographic system that 
uses key pairs, that is, a Public Key and a matching private key, is known as 
public key cryptography. A system that uses a single key to encrypt and 
decrypt data is known as symmetric cryptography.

pcANYWHERE32 uses a combination of Public Key and symmetric 
encryption methods. By combining both techniques, pcANYWYERE32 takes 
advantage of the strengths of each method:

■ Symmetric encryption is fast but requires sharing the key if the 
encrypted data is given to others.

■ Public Key encryption is slower but the private key (the key used to 
decrypt data) is not shared.

Public key encryption
Public key encryption uses key pairs— a public key that encrypts data and a 
corresponding private key that decrypts data. A unique public key and 
private key are generated for each user. These key pairs, along with the 
user’s name, are stored in a certificate issued by a certificate authority.

■ When one person needs to send encrypted data to another, the 
sender encrypts the data using the public key of the recipient. Since 
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only the private key can decrypt data, the public key can be shared 
with anyone.

■ To decrypt the data, the recipient uses his or her own private key. 

Some pre-configuration is required to ensure that both the host and remote 
have access to the appropriate key pairs.  

When public key encryption is selected, pcANYWHERE32 uses public key 
encryption to authenticate the caller and establish a connection, then uses 
the faster symmetric encryption to secure the session.

NOTE: Public Key encryption requires CryptoAPI, 2.0, available in Windows 
NT 4.0 Service Pack 3, or Microsoft Internet Explorer 4.0. 

Public Key components
The following components comprise the total public key encryption  
method:

■ Microsoft-compatible certificates: You may obtain  personal 
certificates (or key pairs) from a commercial certificate authority or 
through an internal certificate server. 

NOTE: Private keys must be compatible with Microsoft’s CryptoAPI.

After the certificate has been installed, it appears in the Private Key list 
box on the host and remote security options property page. (See 
“Configuring host security options” on page 47 and “To configure 
security options:” on page 74 for details.)

NOTE: If the host is running as a Windows NT service, the private 
certificate must be installed on the host PC as a machine key, not a 
user key. The Private Key list box displays machine keys only. 
Consult your key administration system documentation for details on 
creating machine keysets.

■ Certificate store: A certificate is a data document containing a 
person’s name, public key, and the signature of the certificate 
authority that issued the certificate. A certificate store is a secure 
database containing one or more certificates. To locate the public 
key for a session, pcANYWHERE32 searches a certificate store for the 
certificate belonging to the current caller.
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pcANYWHERE32 uses certificate stores in any of the following formats:

■ A Microsoft-compatible certificate store.

■ A standard PKCS#7 cryptographic message.

■ A single encoded certificate.

The host needs access to a certificate store containing the remote’s 
certificate, and the remote needs access to a certificate store containing 
the host’s certificate. You must specify the filename of the certificate 
store in the Application Options, System Setup property page.  (See “To 
configure system setup options:” on page 124.)

■ Certificate common name: Every host and remote caller should be 
configured with the common name from its own certificate.  This 
name is provided on the Security Options property page of the host 
and remote connection item. When a connection is attempted, the 
common name for the host and the remote are verified for 
authenticity. 

Symmetric encryption
When symmetric encryption is selected, pcANYWHERE32  generates a 
unique public key and uses this key to encrypt and safely pass the symmetric 
key used to encrypt the session.  Because the public key is not obtained from 
a certificate authority  it does not provide the level of caller authentication 
that total public key encryption does.  

To enhance caller authentication when using symmetric encryption, use 
pcANYWHERE’s individual caller privileges options. (See “Configuring host 
callers” on page 51 for details.)

The Symmetric encryption level is available on any operating system  that 
supports CryptoAPI such as Windows NT 4.0. For the Windows 95 operating 
system, CryptoAPI 1.0 is available with OSR2 or with Microsoft Internet 
Explorer 3.0 and higher. 

pcANYWHERE encryption
pcANYWHERE encryption applies a simple transformation to data so that the 
datastream cannot be easily interpreted by a third party. This encryption level 
is compatible with earlier versions of pcANYWHERE.
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Technical Information
With CryptoAPI, cryptographic functions are actually performed by a 
Cryptographic Service Provider (CSP), or low-level cryptography driver, 
which functions as part of the operating system. Microsoft provides a basic 
CSP as part of Windows NT and Internet Explorer. This basic CSP can be 
replaced by third-party products.

pcANYWHERE32 uses the default Prov_RSA_FULL CSP and the RC4 
symmetric algorithm. Any CSP classed as PROV_RSA_FULL that provides RC4 
can support pcANYWHERE32.

Many important parameters are determined by the CSP in use. For example, 
the basic Microsoft CSP uses 512-bit public keys and 40-bit session keys. 
Other CSPs use different key lengths.

Please visit the Microsoft website for more details on CryptoAPI and available 
CSPs. 
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Security features
This appendix summarizes the security features available in th
pcANYWHERE32:

■ Table B-1: Lists options used to protect the host PC from 
unauthorized users at the host site. 

■ Table B-2: Lists options to protect the host PC from unauthorized 
callers making a connection.

■ Table B-3: Lists remote caller privileges that restrict the activities of 
the remote caller on the host PC. You can assign unique privileges 
and  restrictions to each remote caller allowed to connect to the host 
PC.

■ Table B-4: Lists options that monitor  remote control activities on the 
host PC.  

Table B-1 Security options that protect the configurations  

Use this option On page To

Protect Item 51, 75 Password protect connection items to 
prevent unauthorized users from changing 
or using the connection item.

Lock NT Workstation 46 Lock a Windows NT workstation with a 
password to prevent unauthorized users 
from accessing the host PC.

Use Windows 95 Screen 
Saver

46 Lock a Windows 95 workstation by 
assigning a password to your Windows 95 
screen saver to prevent unauthorized users 
from accessing the host PC.

End Of Session or Loss Of 
Connection

Choose the mode to which the host PC 
returns after a session disconnects.  You 
can also choose to log off the user on the 
host PC.

Blank The Host Screen 48 Blank the host screen after a connection to 
prevent users at the host site from viewing 
the activities on the host.
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Lock Host 
Keyboard/Mouse

45 Lock the host or  remote PC’s keyboard and 
mouse during a remote control session to 
prevent unauthorized users from using the 
PC during a session.

Table B-2 Security options that control connections to the host PC  

Use this option On page To

Use NT User Privileges 58 Use the Windows NT User Manager to 
control caller access to the host PC.

Caller Password 44 Assign remote callers a password that 
allows connecting to the host PC.

Case-sensitive Passwords 49 Increase password security  by making 
them case-sensitive.

Callback 55 Use a callback phone number to verify the 
remote caller connecting to the host PC. 

Prompt to Confirm 
Connection

48 Allow the host user to acknowledge the 
remote caller and permit connection to the 
host PC.

Limit Login Attempts 49 Restrict the number of times a remote caller 
can attempt to log in to the host PC.

Limit Time To Complete 
Login

49 Restrict the amount of time a remote caller 
has to establish a connection to the host 
PC.

Encryption 47, 74 Choose one of three levels of data 
encryption to protect the integrity of data 
being transferred by the host PC.

Allow Any Caller To 
Reconnect

49 Restrict a reconnection to the host PC to the 
caller that was signed on to the host at the 
time of an abnormal disconnect. This 
prevents unauthorized viewing of 
information that may have been left on the 
host screen during the previous session.

Table B-1 Security options that protect the configurations  (continued)

Use this option On page To
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Table B-3 Security options that control remote caller privileges on the host PC

Table B-4 Security options that monitor activities on the host PC

Use this option On page To

Individual Caller Rights 54 Choose whether to allow a remote caller to:

Blank the host screen

Cancel the host, preventing other 
connections

Restart the host PC

Upload or download file on the host PC

Access drives on the host PC

Limiting The Session 57 Control the amount of time a remote caller 
is connected to the host PC.

Subject Caller  To Inactivity 
Timeout

48 Disconnect the caller after a specified time 
of inactivity.

Use this option On page To

Log Failed Connection 
Attempts

48 Create a log file with information on 
unsuccessful attempts to connect to the 
host PC.

Save Session Statistics In 
Activity Log

57 Create log files that record the time, date, 
caller, and duration of sessions, as well as 
other information.  

Use NT Event Log 125 Log pcANYWHERE32 session events to the 
Windows NT event log.
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ACS Asynchronous Communications Server. Communications server 

that manages a pool of modems. The server directs outgoing 
messages to the next available modem and directs incoming 
messages to the appropriate workstation. See also asynchronous 
transmission; NASI/NCSI.

ANSI American National Standards Institute. 1. Organization of 
American industry and business groups that develop trade and 
communications standards. 2. Terminal emulation that enables 
the use of ANSI commands (escape sequences) to control the 
screen and keyboard. These escape sequences have been 
standardized by ANSI.

attribute Property of an object, such as a file or display device. 

baud rate Number of times per second a signal changes in a 
communications channel. This rate varies in the number of bits it 
represents. For example, a 300-baud modem that transmits one 
bit per baud (300 x 1) is also a 300-bps modem. However, what 
is often called a 1,200-baud modem is really a 300-baud modem 
that transmits four bits per baud (300 x 4) or 1200-bps. 

BBS Bulletin Board Service. Online service that allows messaging, 
electronic mail, and file transfer between computer through 
modems. Generally, users of a bulletin board share a particular 
interest. See also online service.

caller privileges All the information and access privileges for remote users. The 
information includes login name, password, and drive access.

carrier Signal generated by a modem that is used to transmit data. The 
scratchy sound you hear when you initially connect with another 
modem is the carrier signal.

certificate File used by cryptographic systems as proof of identify. It 
contains your name and your public key.

certificate authority Office or bureau that issues security certificates.

certificate store Database containing security certificates.
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chat mode Way for the host and remote user to communicate online during 
a remote control session. A dialogue window appears on each 
screen. Both user messages appear on both screens.

class Way to group gateway hardware configurations that have similar 
characteristics. When you create the gateway, you assign it to a 
class. The class is specified in a network hardware configuration 
when you want to use the gateway.

communications 
protocol

Set of rules designed to allow computers to exchange data with 
one another with as little error as possible. Some protocols, such 
as RS-232-C, refer to hardware standards; others, such as 
XMODEM, refer to file-transfer protocols.

compression Method by which data is compacted for more efficient 
transmission. Data is compressed before transmission and 
decompressed afterwards. 

connection item Files represented by an icon and a name. These files contain 
connection information, such as the device used to make a 
connection, and commands or options used during a session.

context menu Menu that appears when you right click over an interface object, 
and that provides options and information specific to that object. 

crash recovery Way to salvage data partially transmitted at the time a connection 
ends abnormally. One of the preferences that can be set for the 
AWSEND program or the ZMODEM file-transfer protocol.

CSP Cryptographic Service Provider operating system software that 
provides cryptographic services compliant with the Microsoft 
CryptoAPI. Base-level CSPs are shipped with Windows NT 4.0 
and with Microsoft Internet Explorer 3.0 and up.

data transfer Movement of information from one location to another. The 
speed of transfer is called the “data rate” or “data transfer rate.”

Device/Port Option in all hardware configurations that allows you to select a 
type of device or device driver for communications or the port 
used by such a device.

dial-up networking Connection in which a PC calls a server and operates as a local 
workstation on the network. See also RAS; remote networking.

display device 
attribute

Characteristics of a monitor or other display device that control 
color, underlining, blinking cursor, and so on. See also attribute; 
file attribute; video attribute.
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direct connection Form of data communication in which one computer or terminal 
is directly connected to another, usually via a null modem cable. 
See also null modem cable.

download folder Folder in which files received during file transfer are stored.

encryption Method or algorithm used to scramble data being transferred to 
protect the data from being intercepted by unauthorized 
persons. 

error-checking method Method of error correction. For example, for the ZMODEM file-
transfer protocol, you can specify 16-bit CRC or 32-bit CRC error 
checking.

error correction Retransmitting data until it is received correctly. “Noisy” lines or 
faulty connections sometimes cause errors that translate into 
erroneous characters on the screen and in transferred files. 

file attribute Setting for a file that indicates the size of the file and the date 
and time it was created or modified. See also attribute; display 
device attribute; video attribute.

file transfer Process of using communications to move or transmit a file from 
one computer to another. In communications, a protocol must 
be agreed upon by sending and receiving computers before file 
transfer can take place. See also FTP.

File Transfer Protocol See FTP.

flow control Signal acknowledging that communication or the transfer of 
information can take place. When a modem or computer 
receives data at a faster rate than it can be processed, data is 
stored in a special area of memory called a data buffer. Flow 
control prevents data loss by temporarily halting data 
transmission when the buffer approaches its capacity. Also an 
option in serial hardware configurations. See also 
communications protocol; handshake; hardware handshake; 
protocol.

FTP Method of file transfer understood and used by both the remote 
and the host computer. For online sessions, you select a file-
transfer protocol acceptable to the online service as part of the 
session configuration. You can change your selection during a 
session. See also file transfer; TCP/IP.
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gateway PC on a LAN with a modem. The PC runs a small TSR in the 
background, which allows users on the network to dial out or 
off-LAN users to dial in to the LAN through the modem. 

inactivity timeout Time period (in minutes) of inactivity after which a remote 
control session is ended. Inactivity is the absence of keystrokes, 
mouse movements, and data transmission between PCs. 
Establishing such a timeout period keeps the telephone line free 
in case remote users forget to end their sessions when finished 
with the host PC. 

initialize 1. To prepare for use. 2. In communications, to set a modem 
and software parameters at the start of a session. 

Internet Protocol See IP.

interrupt request See IRQ.

IP Internet Protocol. Network layer for the TCP/IP protocol suite 
widely used on Ethernet networks. This layer is a 
connectionless, best-effort packet-switching protocol. It provides 
packet routing, fragmentation, and re-assembly through the 
Datalink layer. See also client-server; Internet; protocol; TCP; 
TCP/IP.

IRQ Interrupt Request. Request for a hardware interrupt. Each 
request has a number corresponding to one of the fixed set of 
interrupts for the PC. PCs with the AT architecture have 
interrupts from 0 to 15. 

keyboard handler Device that allows the remote user to operate the host PC 
effectively while executing host applications that handle 
keyboard input in a non-standard fashion. See also keyboard.

LAN Local area network. Group of computers and other devices 
dispersed over a relatively limited area and connected by a 
communications link that enables any device to interact with any 
other device on the network. This group of computers usually 
includes one computer, known as a server, that is specialized to 
store commonly needed programs and data and respond quickly 
to requests from network users for this information. See also 
network; WAN.
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leased line (Windows 
NT)

Telephone channel leased from a common carrier for private 
use. A leased line is faster and quieter, but generally more 
expensive than a switched telephone line. Leased Line is an 
option in serial hardware configurations. It is set to “No” by 
default. Set it to “Yes” if you are using a leased line. 

log To record the activities and events that take place on a computer 
system. The records are stored in a data file. 

login To identify yourself to a computer after connecting to it over a 
communications line. During the login procedure, the computer 
usually requests your name and a password. On a computer 
used by many people, the login procedure provides a means of 
identifying authorized users, keeping track of their usage time, 
and maintaining security by controlling their access to sensitive 
files or actions. See also logoff.

logoff To end a session with a computer accessed over a 
communications line. Also known as “logout.” See also login.

macro Set of characters and control codes assigned to a macro key. 
When the macro key is typed, the assigned keystrokes are 
executed (played back). For example, a single macro keystroke 
can send a password to an online service. See also macro key.

macro key Keystroke (from Alt+0 to Alt+9) assigned to a string of 
keystrokes. See also macro.

modem Modulator/demodulator. Communications device that enables a 
computer to transmit information over a standard telephone line. 
This device translates (modulates) digital data to an analog 
signal for transmission over telephone lines and then back to 
digital (demodulates) at the other end. It can transmit at different 
speeds or data-transfer rates. 

NACS NetWare Asynchronous Communications Services. Novell device 
that allows any network station to share dial-up phone lines or 
directly connected lines to a host or other asynchronous device. 
In addition, remote users can access the network and transmit 
data over synchronous protocols.

NASI NetWare Asynchronous Services Interface. Network station 
software used with NACS.
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NASI/NCSI NetWare Asynchronous Services Interface/NetWare 
Asynchronous Communications Services. Novell device driver 
for a network ACS such as an ACS2 or a NACS. See also ACS; 
NACS.

network Group of computers and associated hardware that are connected 
together by communication lines or other means for the purpose 
of sharing information and hardware between users. See also 
LAN; WAN.

node Computer attached to the network (server or workstation). Also 
known as “workstation.”

null modem cable Cable that enables two computers to communicate without the 
use of modems. A null modem cable enables this 
communication by crossing the sending and receiving wires so 
the wire used for transmitting by one device is used for receiving 
by the other and vice versa. 

online service Computer communications system or service that allows users to 
dial in for information, messages, and files. CompuServe is an 
example of a commercial online service. See also BBS.

parallel port Generally used for printer connections. Most computers have at 
least one parallel port (known as “LPT1”) for this purpose. 

parallel cable Special cable that is used to connect two computers to allow for 
data transmission without the use of modems.

properties sheet Set of property pages that contain connection device information 
and other options or settings used by a connection item during a 
session.

property page Single page contained within the properties sheet of a 
connection item. See also properties sheet.

protocol Set of rules that enable computers to exchange data with one 
another with as few errors as possible. See also communications 
protocol. 

RAS Remote Access Service. Connection in which a PC calls a server 
and operates as a local workstation on that network. See also 
dial-up networking; remote networking.

remote 
communications

Interaction with a host by a remote computer through a 
telephone connection or another communications line.
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remote control To control a host PC from a remote PC.

remote networking Connection in which a PC calls a server and operates as a local 
workstation on that network. See RAS; dial-up networking.

serial transmission 1. Transmission of discrete signals one after the other. 2. In 
communications and data transfer, sending information over a 
single wire one bit at a time. This is the method used in 
microcomputer modem-to-modem communications over 
telephone lines.

Speed Option found in serial port connections that specifies the bps at 
which data is transmitted over a modem or null modem cable.

TCP Transmission Control Protocol. Most common transport layer 
protocol used on Ethernet and the Internet. The protocol is built 
on top of IP and is nearly always seen in the combination 
TCP/IP. It adds reliable communication, flow-control, 
multiplexing, and connection-oriented communication as well as 
full-duplex, process-to-process connections.

TCP/IP Transmission Control Protocol over Internet Protocol. De facto 
standard Ethernet protocols. See also FTP; IP; protocol; TCP.

terminal Device consisting of a monitor, video adapter, and keyboard. 
This device does little or no processing on its own. Instead, it is 
connected to a computer with a communications link over a 
cable. Terminals are used mainly with multiple-user systems 
(that is, with a mainframe), where they are used to monitor and 
receive but not store information.

terminal emulation Technique of mimicking a terminal by using software that 
conforms to a standard such as ANSI. 

time-out Predetermined period of time during which a given task must be 
completed. If the time-out value is reached before or during the 
execution of the task, the task is canceled. 

translation table Table that specifies a conversion of specific data bytes from one 
code to another. 

video attribute Visual feature used to set off certain parts of a screen, such as 
highlighting or blinking. See also attribute; display device 
attribute; file attribute.
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WAN Wide area network. Network, usually constructed with serial 
lines, extending over distances greater than one kilometer. See 
also LAN; network.

X-ON/X-OFF Most common of asynchronous communications protocols 
established to govern software flow control. Under this protocol, 
the receiving device sends a specific character when it wants the 
transmitting device to stop sending characters. It sends a 
different character when it wants the transmission to resume. 
Depending on the online service you are accessing, you may 
need to choose X-ON/X-OFF as the setting for flow control in a 
hardware configuration. 
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Symantec StandardCare Support is available at no charge to all registered 
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http://www.symantec.com

Online support
Technical support is also available through several online services 24 hours a 
day. All registered Symantec customers have unlimited access to this 
information.

World Wide Web and FTP
Point your Web browser to:

http://www.symantec.com/techsupp

to find the latest Frequently Asked Questions (FAQs), search the Symantec 
Knowledge Base for solutions to common situations, or post your own query 
to a support newsgroup. All messages posted to the discussion group receive 
a response from a Symantec representative (posted back to the discussion 
group) within 48 hours. These forums are in Usenet newsgroup (Internet 
news) format and require a newsreader.

You can also FTP directly to this site to download technical notes and 
software patches at:

ftp://ftp.symantec.com

CompuServe and America Online
Exchange information and ideas with Symantec representatives and other 
users of Symantec products in the Symantec forums on CompuServe
(GO SYMANTEC) and America Online (Keyword: SYMANTEC).

All messages posted to CompuServe and America Online receive a response 
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America Online U.S. and Canada (800) 227-6364

CompuServe U.S. and Canada (800) 848-8199
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Symantec Bulletin Board Service (BBS)
The Symantec BBS provides a customer service forum, shareware and public 
domain software, FAQs, file download service, and access to our Internet 
discussion groups. Set your modem to 8 data bits, 1 stop bit, no parity and 
dial (541) 484-6669.

Automated fax retrieval system
You can use Symantec’s automated fax retrieval system 24 hours a day to 
receive product information directly to your fax machine.

For general product information, fact sheets and product upgrade order 
forms, please call our Customer Service fax retrieval system at (800) 554-4403 
or (541) 984-2490.

For technical application notes, please call our Technical Support fax retrieval 
system on (541) 984-2490 and select option 2.

Support for old and discontinued versions
When a new version of this software is released, registered users will receive 
upgrade information in the mail. Telephone support will be provided for the 
previous version for 6 months after the release of the new version. Technical 
information may still be available through Online Support.

When Symantec announces that a product will no longer be marketed or 
sold, telephone support will be discontinued 60 days later. Support will only 
be available for discontinued products through online services. See the 
section “Online Support” previously in this chapter.

Customer Service
Symantec’s Customer Service department can assist you with non-technical 
questions. Call Customer Service to:

■ Order an upgrade.

■ Subscribe to the Symantec Support Solution of your choice.

■ Fulfill your request for product literature or demonstration disks.

■ Find out about dealers and consultants in your area.
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■ Update your product registration with address or name changes.

You can also visit Customer Service online at:

http://www.symantec.com/custserv

for the latest Customer Service FAQs, to find out the status of your order or 
return, or to post a query to a Customer Service discussion group.

Customer Service discussion groups provide a forum for customers to ask 
general questions about Symantec products and services. All messages 
posted receive a response from a Symantec customer service representative 
within 2 business days. These forums are in Usenet newsgroup (Internet 
news) format and require a newsreader.

Worldwide Service and Support
Symantec provides Technical Support and Customer Service worldwide. 
Services vary by country and include International Partners who represent 
Symantec in regions without a Symantec office.

Service and Support offices
NORTH AMERICA

Symantec Corporation (800) 441-7234 (USA & Canada)
175 W. Broadway (541) 334-6054 (all other locations)
Eugene, OR, 97401 Fax: (541) 984-8020

Automated Fax Retrieval (800) 554-4403
(541) 984-2490

EUROPE

Symantec Europe Ltd. +31 (71) 535 3111
Kanaalpark 145 Fax: +31 (71) 535 3150
2321 JV Leiden
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Automated Fax Retrieval +31 (71) 535 3255
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Symantec Australia Pty. Ltd. +61 (2) 9850 1000
408 Victoria Road Fax: +61 (2) 9850 1001
Gladesville, NSW 2111
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Automated Fax Retrieval +61 (2) 9817 4550

Most International Partners provide Customer Service and Technical Support 
for Symantec products in your local language. For more information on other 
Symantec and International Partner locations, please call our Technical 
Support automated fax retrieval service, in the United States at
+1 (541) 984-2490, choose Option 2, and request document 1400.

Every effort has been made to ensure the accuracy of this information. 
However, the information contained herein is subject to change without 
notice. Symantec Corporation reserves the right for such change without 
prior notice.
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A
action bar 9

buttons 9
customizing 144–145

Action menu 144
activity log. See log file
ACTIVITY LOG PROCESSING command 

(Utilities menu) 173, 181, 183
Activity Log Processing dialog box 183
activity log report. See log report
Add Be A Gateway Item wizard 148
ADD BE A HOST PC ITEM (Quick Start menu) 

14
Add Be A Host PC wizard 43
Add Modem command button 28
Add New Be A Host PC icon 43
Add New Caller icon 52, 53, 59
Add New Remote Ctrl icon 66
Add New Remote Ctrl wizard 65
Add Online Service Item icon 154
Add Online Service wizard 153–154
Add Remote Networking Item icon 84
Add Remote Networking Item wizard 84–86
administrative installation instructions 23–26
administrator options 24–26
advanced modem settings 40
Advanced property page (caller properties) 

56
Advanced property page (online service) 

155, 159
Alt+Enter 95, 103
append session recording to existing file 70, 

157, 176
application options 123–145

customizing 123–145
defined 123

APPLICATION OPTIONS... command (File 
menu) 124–145
Application Options properties sheet 123–145
Apply command button 145
Archive/Delete Host/Remote Log dialog box 

183
archiving logged information 182–184
ASCII file-transfer protocol 136–137, 169
ASCII Protocol Settings property page 136
asynchronous communications server

NACS 34
at (@) symbol used as a separator 82
authorizing remote’s connection to host 48
auto download protocol option 170
automatic

dialing of online service 69, 156
downloading 138, 170
login to host PC 67, 69
modem selection in Windows 95 28
online service login 161
script execution upon connection to 

online service 158
AutoXfer™ icon (remote’s online toolbar) 95
AW.HH6 file 182
AW.HL6 file 182
AW.RH6 file 182
AW.RL6 file 182

B
backspace key

changing configuration during session 167
configuring 159

Banyan 34
BBS 10, 153
Be A Gateway action button 10, 151
Be A Host PC action button 43
Be A Host wizard 14–15
bidirectional gateway 147, 150
binary file, saving recorded session as 176
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bitmap information, caching 127
bitmaps, transferring in clipboard 96
blanking host screen 48, 105

allowing 56
break signal 160
bulletin board service. See  BBS 10
button bar 108

See also action bar; file manager button 
bar; toolbar

Button Bars property page 123

C
cache file size 127
Call A Host PC mode 10
Call Online Service action button 10, 160
callback

delay 46
remote from host 55
remote from host, host disconnects and 

calls back 63
Callback property page 55
caller

changing properties of 54–62
configuration 51–62
creating 53

caller login 53
caller password 53, 61
caller privileges 56–57
caller properties 54–62
caller wizard. See New Caller wizard
callers property page 44, 52, 59
calling

configuration 67
host from remote 75–82
host from remote, using remote control 

wizard 15
online service 160
remote from host, host disconnects and 

calls back 55, 63
remote from host, waiting mode 76
restricting to allow incoming or outgoing 

on gateway 150
using gateway connection device 147

canceling host, allowing 56
canceling remote control session 94
capture. See saving
capturing session screens 179
carriage return and linefeed translation 137, 

160, 167
carrier detect 34, 40
case-sensitivity

administrator password 25
passwords 49

cassette tape symbol 163
CHANGE FOLDER... command (pcANYWHERE 

file manager File menu) 110
changing

See also editing
caller properties 54–62
file-transfer protocols 168–169
modem settings online 166
online service options during session 165–

169
remote control session options while 

online 91–106
chat

See also sending
defined 93
initiating 93

CHAT command (remote or host online menu) 
93

chat window 93
class, gateway 35, 151
clearing tags 110
clipboard

copying text 165
pasting text 165
transferring contents between host and 

remote PCs 96, 102
transferring contents to online service 

164–165
viewing contents (host) 103
viewing contents (remote) 103

clipboard icon (remote online toolbar) 102
Clipboard Viewer 102

installing 102
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CLONE... command (pcANYWHERE file 
manager File menu) 118, 120

Clone Folder dialog box 121
cloning 120

See also copying files
contrasted to synchronization 118

colors
256 105, 127
changing during online session 166
determining for DOS session 131
scaling on host 105, 127
screen display 143

ColorScale feature 105, 127
COM port

See also LPT port; port
configuring 33, 39

command to execute after connection 57
communication port. See COM port
communications device. See connection 

device; device
company name 21
COMPARE FOLDERS command (pcANYWHERE 

file manager File menu) 118
comparing

See also cloning; synchronizing
files using SpeedSend feature 114
folders 117

compression 113, 114, 136
CompuServe 10, 153
computer name 124
configuration files, converting from earlier 

version to connection items 184–186
configuring

administrator options 24–26
callers 51–62
connection device 67
connection item 31–32
connection item, Windows NT RAS 87
connection to host 67
connection to online service 155
DOS session on host 130–131
file transfer default settings 133–138
gateway 148–151

configuring (continued)
hardware device 67
host connection information 45
host security options 47–51
modem connection 32
NASI/NCSI network devices 36–37
network device 34–37
online options, remote control session 

103–106
online service connection information 

155–160
optional settings 67
parallel ports 34
remote control dialing settings 67
remote control session default settings 

126–145
remote networking settings 84–87
serial ports 32
terminal emulator 138–143
your computer to be a host PC 43–62

confirm connection 48
CONNECT command (context menu) 76, 77, 82, 

87, 160
connection

allowing 48
authorizing 48
dial-up 84, 87
gateway 79, 148–151
modem 76
network 77
online service 10, 155, 160
prompt to confirm 48
remote control 75–79

types 76
remote network 84, 87

connection device 31–41
See also device
changing settings during online service 

session 166
gateway 150
modem 32
network 34–37
network, remote 84
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connection device (continued)
parallel cable direct connection 34
selection 33, 39
selection for gateway session 149
selection for online service 155
selection for remote control session 67
serial 33, 39
supported 32
Windows 95 31–32, 34–38
Windows NT 32, 38

Connection Info property page
gateway 149
host 44
online service 155
remote 67
Windows 95 31–38
Windows NT 38–41

connection information, logging 181
connection item 11–13

Be A Host PC 11, 14
configuring 31–32, 155–160
context menu 11
converting from earlier version of 

pcANYWHERE 184–186
creating, host 43–58
creating, online service 153–154
creating, remote control 65–75
customizing 65–75
defined 11, 43
displaying 11
editing 31, 39, 66, 86
file transfer 10, 15
gateway 10, 148–151
icon 11, 65
new 31, 39
online service 153–160
password-protection 12–13, 67, 75, 160
remote control 10, 15, 65–75
remote networking 84–86, 87
remote networking, Windows NT RAS 87
updating 184
using wizards 14
what it does 11

connection item icon 154
connection preferences 33, 40
CONTENTS command (Help menu) 13
context menu 11

connection item 11
control-menu box 91
control panel, playback of recorded files 178–

179
control panel, Windows 95 32
CONTROLLED BY HOST command (File Transfer 

submenu, host online menu) 107, 113
CONTROLLED BY REMOTE command (File 

Transfer submenu, host online menu) 113
Controls menu 178
converting configuration files to connection 

items 184–186
Copy dialog box 117
copying files 117

See also cloning; synchronizing
copying prerecorded session to new file 176
copying text to clipboard 165
CPU required 19
CR/LF 160, 167
crash recovery 113, 114

pcANYWHERE file-transfer protocol 136
ZMODEM 138

CREATE FOLDER... command (pcANYWHERE 
file manager File menu) 115

creating
caller entry 53
folder, during remote control session 115
gateway connection item 149
host PC connection item using properties 

sheet 43–58
log report 180, 181
log report using archived data 183
new host to call 65–66
online service connection item 153–154
record file 175–176
remote control connection item 65–75
remote networking connection item 84–86
remote networking connection item, 

Windows NT RAS 87
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creating (continued)
script file by recording online service 

session 163
criteria, sorting files in file manager 108
Ctrl+Break 57, 160
Ctrl+C 57
Ctrl+click 110
custom modem 32

Windows NT 40
customizing

action bar 144–145
application options 123–145
connection item 65–75, 155–160
gateway default settings 148–151
online service session 165–169
pcANYWHERE default settings 123–145
screen display 143
toolbar 144, 145

cutting terminal window text to clipboard 165

D
DATA CONVERSION command (Utilities menu) 

173, 184
Data Conversion wizard 184–186
Data File Upgrade dialog box 185
data rate, changing online 166
data window size 138
date

display files by 109
range for displayed entries in activity log 

report 182
sort files by 108

default break length 160
default file-transfer protocol, changing 169
default settings, customizing 123–145
Delete button 115
deleting

files 115
folders 115
logged information 182–184
text using backspace key 159, 167

deselecting
selected files 111
tagged files and folders 110

desktop optimization 127
destructive backspace 159, 167
details of files 109
Details property page

modem
Windows 95 33
Windows NT 40

network 35
device sharing 79

See also connection device
dialing

dial-up network server 83
host PC 76
online service 160

dialing instructions 67
dialog box help 13
dial-up networking 83
direct connection

parallel cable 34
serial cable 33

direction of file transfer 108, 120
disabling host

desktop configuration 127
keyboard 105
screen 105

disconnect session after specified time expires 
57

disconnect session if inactive 50
disconnect session when done 112
disk drive requirements to run 

pcANYWHERE32 19
display

See also screen
adjusting settings during online session 

166–168
blanking on host 48, 105
customizing 143
full-screen 95, 103
requirement to run pcANYWHERE32 19
synchronization 106, 130
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display (continued)
terminal window options 159–160

DISPLAY... command (terminal window Session 
menu) 167

Display dialog box 167
displaying

clipboard contents 102
connection items 11
drive contents 109
file details 109
folder contents 110
full-screen remote control session 103, 

128
host’s screen on remote 95, 103
online menu (host) 92
online menu (remote) 91
online toolbar (remote) 104
scroll bars in terminal window 168
Windows 95 Start button 103

DOS running on host 105, 130–131
DOS session options 130–131
DOS Settings property page 105
Dow Jones 153
download

folder 133, 170
timeout 137
translations of carriage returns and 

linefeeds 137
downloading

See also file transfer; sending
allowing by remote caller 56
automatically using ZMODEM 138, 170
from online service 169–171
preventing 56

drag and drop
file transfer (remote control) 111

dragging
disabling on host 127
selected files for file transfer (remote 

control) 111

drive
changing 109
restricting caller access 57

Drive Access... command button 57

E
editing

See also changing
action bar options 144–145
caller item 54–62
connection item properties 31, 39
connection item properties (gateway) 

148–151
connection item properties (host) 44, 45
connection item properties (online 

service) 154
connection item properties (remote) 66
online service session options 165–169

emulation, terminal 138–143
END SESSION command (host online menu) 95
END SESSION command (remote online menu) 

94
ending remote control session 94

time limit expires 57
error checking 138, 169
executing command on host after connection 

57
EXIT CHAT command (File menu) 94
EXIT command (terminal window File menu) 

171
EXIT FILE MANAGER command (pcANYWHERE 

file manager File menu) 108, 121
exiting

chat window 94
file manager 108, 121
online service session 171
remote control session 94

exporting configuration files from previous 
version of pcANYWHERE 184

extension
sort files by 108
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F
file compression 113, 114, 136
file details 109
file list boxes 108
file manager 107–120

accessing 107
exiting 108
setting options 108–109
starting 107

file manager button bar 108
file manager window 108
file size, sorting by 108
file transfer 107–120

See also downloading; sending; uploading
configuring 133–138
controlled by host 113
controlled by remote 113
default settings 133–138
direction displayed in file manager 

window 108
direction, switching 120
download folder 133, 170
enhancing performance using SpeedSend 

113, 136
managing folders and files 114–120
online services 134, 169–171
performance issues 83
remote control 134
via remote networking 83
selecting preferences 113–114
source folder 170
speed 113
SpeedSend 113, 136
starting from host 112
starting from remote 111
target folder 170
using direct parallel connection 34

File Transfer action button 10
FILE TRANSFER... command (host online menu) 

107, 112
FILE TRANSFER... command (remote online 

menu) 107–109, 111

file transfer connection item 10, 15
relationship to remote control connection 

item 75
File Transfer icon (remote’s online toolbar) 

107
file transfer options 113–114
FILE TRANSFER OPTIONS... command 

(pcANYWHERE file manager Configure 
menu) 114

File Transfer property page 123
File Transfer Protocol dialog box 169
file-transfer protocols 134–138, 156, 168–169

ASCII 136–137, 169
changing during online session 168–169
pcANYWHERE 135
ZMODEM 137–138, 169, 170

File Transfer Status box 112
file transfer wizard 15
filename

log file 71, 182
record file 157
recording files 70
sort by 108

files
comparing 114, 117
compressing during transfer 114
configuration, conversion to connection 

items 184–186
copying 117
deleting 115
managing 114–120
multiple 110
overwriting 113, 135
renaming 116
selecting 109–110
selecting using filters 119
sending 111
sorting 108–109
synchronizing 119
tagging 110
virus-checking on download 134

FILTER... command (pcANYWHERE file 
manager View menu) 108, 119
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filtering
files 108–109, 119
using to tag files 110

Find tab, online help 13
flow control

changing online 166
remote control 34, 40

folders
cloning 120
comparing 117
creating in file manager 115
deleting 115
displaying contents 110
displaying list of those recently selected 

145
download 133, 170
managing 114–120
renaming 116
selecting 109–110
source 170
specifying for location of program at 

installation 21–22
synchronizing 119
tagging 110
target 170
transferring between host and remote 111
WINAW32 21–22

font
changing during online session 166
determining for DOS session 131
local 128
sizing, automatic 168
terminal emulation 143

Font And Colors dialog box (Windows) 166
Font dialog box 143
FULL SCREEN command (remote online menu) 

95
full-screen display mode 95, 103, 128
full-screen drag, disabling on host 127
Full Screen icon (remote’s online toolbar) 95

G
gateway 147–151

action button 10
bidirectional 147, 150
classification 35, 151
configuring 148–151
connection item 10, 148–151
creating new 149
loading into memory 151
setting up network connection with 35
starting 151
unidirectional 147, 148, 150
using to connect to online service 160
what it does 147–148

Gateway action button 149
gateway connection 35, 148–151

remote through modem 79
gateway connection item 151

password-protection 150
gateway PC, setting up 147–151
gateway wizard 16

customizing settings 148
General property page 104
graphics support, DOS 106, 131

H
HARDWARE... command (terminal window 

Session menu) 165
hardware device

See also connection device
selection 67
settings 166

hardware requirements 19
Hardware Settings dialog box 166
Hayes compatible modem setting 40
help system 13
hexadecimal translation values 143
history log file 182
host

See also host, network; host PC
canceling by remote, allowing 56
new 65–66
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Host and Remote Session Log Report dialog 
box 182

host connection item
creating 43
defined 43
login options 49
minimizing 46
properties 44–58

host history file 182
host log file 182
host mode 62

loading at startup 46
host, network 78

connecting through gateway modem 82
selection 82

host online menu 93
host PC

See also host
canceling from memory 95
changing options while online 103–106
configuring optional settings 150
configuring your computer to be a host 

43–62
control of callers 51–62
creating connection item using properties 

sheet 43–58
dialing instructions to call 150
disabling desktop configuration 127
DOS session with 130–131
editing connection item properties 44
initiates file transfer 112
initiates remote control session 62
keyboard 105
log report 181
login options 49
logs session 180
name 68
online menu 92–95
restricting drive access 57
screen blanking 105
screen saver use 46
security 46, 47–51, 54–62
setting remote caller privileges 56–57

host PC to call
configuring optional settings 67
creating connection item using properties 

sheet 66
dialing instructions 67
phone number 81

host session icon 93
host wizard 11, 14–15, 43

I
icon

connection item 11, 65
online toolbar (remote PC) 95

importing data into connection item 184
inactivity timeout

downloading files 137
enforcing 50, 57
setting time limit 48
specifying, gateway session 150

Index tab, online help 13
individual caller privileges 52
information services 10
installing pcANYWHERE32

network 23–26
network workstation 26–29
standalone PC 19–23

installing Windows Clipboard Viewer 102
IPX 34, 84

K
Kermit file-transfer protocol 134
keyboard

activating during remote control session 
47

locking 105
keyboard handler types 106
keys

backspace, destructive 159, 167
macro 139–141, 158, 167
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L
LAN

See also network
accessing via remote networking 83, 87–

89
using gateway on 147

LAUNCH GATEWAY command (context menu) 
151

LAUNCH HOST command 63
launching host at startup 46
licensing your copy of pcANYWHERE32 21
line wrap

changing configuration during session 166
configuring 159

local copy, defined 117
Local Copy button 117
local fonts for Windows 3.x hosts 128
location of pcANYWHERE program 21–22
locking host using screen saver 46
log file 174, 180

archiving 182–184
deleting 182–184
enabling 48, 57
entering filename 71
filename 182
host 182
remote 182
saving online service session information 

158, 180–184
saving remote control session information 

71, 180–184
log report 180

creating and viewing 181
host PC 181
remote PC 181
using archived data to create 183

logging connections 181
login

to host 69
new caller 53
online service, using script file 161

login information, host PC 67
login name, remote user 69

login options 49
LPT port

See also COM port; parallel cable direct 
connection

configuring for file transfer 34

M
macro keys 139–141, 158, 167
Make New Connection wizard (remote 

networking) 85
managing files and folders when transferring 

files 114–120
MCI Mail 153
memory requirements 19
menu, online. See online menu
messages, sending. See chat
minimize host 46
.MK6 file extension 139, 158, 167
modem

adding using Smart Setup wizard 28
automatic selection 28
custom 32
group name for NASI/NCSI connection 37
Hayes compatible 40
preferences 33, 40
selection from Device list 32
selection from Select A Modem list 

(remote networking wizard) 85
selection from Use Modem list, Windows 

NT 40
modem connection

callback delay 46
custom 32
gateway 147
remote control 76
Windows 95 31–35
Windows NT 38–39

Modem dialog box 40
modem settings, advanced 40
modem speed

as basis for gateway class 151
changing online 166
setting 33, 40
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Modems folder, Windows 95 control panel 32
modifying. See changing; editing
mouse

activating during remote control session 
47

drag and drop file transfer 111

N
name, entering at installation 21
naming

files and folders during file transfer 116
network PC 26
PC 26, 124

NASI/NCSI network devices 36–37
NetBIOS 34, 84
network

See also host; LAN
action button 10
connection as remote node 10
dial-up connection 83
installation instructions 23–26
remote connection 10
using gateway on 35, 147
using to connect to host 77

network administrator. See administrative 
installation; administrator options

network device
configuring 34–37
selecting 88

network host 68
automatic connection 68
connecting using remote networking 87–

89
connecting via server using dial-up 

connection 87–89
grayed option 68
selecting 78

network protocol 34
network server. See server
network workstation

installation instructions for pcANYWHERE 
26–29

networking, remote. See remote networking

New Caller wizard 53
NEW command (context menu) 43, 66, 84, 149, 

154
NEW command (File menu) 31, 39, 43, 66, 84, 

149, 154
new features in this version of pcANYWHERE 

16–17
New Host Properties sheet 44
Norton AntiVirus 134
Norton pcANYWHERE. See pcANYWHERE32
Norton pcANYWHERE32

installation 19–29
Novell Asynchronous Communications Server.  

See NACS
Novell NetWare 34

O
online help 13
online menu

host 92–95
options common to host and remote 93–

95
remote 91–93, 95–106

ONLINE OPTIONS... command (remote online 
menu) 103

Online Options icon (remote’s online toolbar) 
95

online service
action button 10
connecting to 10
connecting to using gateway 147, 160
defined 153
file transfer 168–171
session configuration 155–160
wizard 153–154

online service connection 155
online service connection item 160

configuring 155–160
creating 153–154
editing 154
password-protection 160

online service options
changing during session 166–168
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online service properties sheet 155
online service session 160–171

ending 171
file-transfer protocol 134
logging 180
managing 161–171
playing back 177–179
recording in file 175–176
starting 160–161

online toolbar (remote PC) 104
optimizing host’s desktop 127
OPTIONS... command (Controls menu) 178
overwrite preferences 113, 135

P
pacing 137
parallel cable direct connection

configuring 34
parity

changing online 166
gateway 35
remote control 33, 40

password
administrator 25
assigning to caller 62
case-sensitivity 49
case-sensitivity, administrator password 

25
entering 75
new caller 53
requiring to run item 13
requiring to view properties 13
requiring to view/change caller item 62

password-protection
See also security
caller items 61
connection items 12–13
gateway connection item 151
item-level security features 55–62
online service connection item 160
remote control connection items 67, 75
screen saver 46

PASTE command (terminal window Edit menu) 
165

PASTE TO HOST command (terminal window 
Edit menu) 165

PC. See gateway PC, setting up; host PC; 
remote PC

PCANYWHERE command (remote control-
menu box) 91

pcANYWHERE Data Conversion wizard 184–
186

pcANYWHERE Data File Upgrade dialog box 
185

pcANYWHERE file-transfer protocol 135
pcANYWHERE32

connection item conversion from earlier 
versions 184–186

file compression 113, 136
file manager’s file transfer functions 107–

120
file-transfer protocol 135
main functions 9–10
new features 16–17
online help system 13
quick tour 9–10
terminal window 161–168

performance
file transfer 113

phone number
dial-up network server 86
gateway connection to host 81
online service 69, 156, 160
remote caller 55, 61
remote networking computer 85

PKZIP files 113, 136
playback captured screens 179
Playback Control Panel 178–179
playback options

selecting from Controls menu 178
selecting from Playback Control Panel 

177–179
playback recorded sessions 177–179
PLAYBACK SESSIONS/SCREENS command (Utilities 

menu) 173, 177, 179
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port
See also COM port
name, NASI/NCSI 37
parallel 34
serial 33, 39

power saver, disabling 127
preferences

connection 33, 40
file transfer 113–114

PRINT ONLINE command (terminal window 
Sessions menu) 164

PRINT SCREEN command (terminal window File 
menu) 164

printing
from terminal window 164

privileges, remote caller 56–57
program location, specifying folder 22
PROPERTIES... command (context menu) 11, 31, 

39, 44, 66, 86, 149, 154
PROPERTIES... command (File menu) 44, 66, 86, 

149, 154
properties sheets

accessing 66
connection item 66
modifying, password required 13
new caller 55
New Host 44
online service 155
Remote Control 66

Protect Item property page
caller 62
gateway 150
host 45
online service 155
remote 67

protocol
file-transfer 134–138, 156, 168–169
network 34

Q
Quick Start

file transfer 15
gateway 16

Quick Start action button 13
Quick Start menu 14

ADD BE A HOST PC ITEM 14
Quick Start wizards 14

R
RAM required for program 19
RAS, Windows NT 83
.RCD file extension 177
reading clipboard contents 102
RECEIVE FILE... command (terminal window 

Transfer menu) 170
receiving files. See downloading; file transfer
record file 174

creating 175–176
entering filename 70, 157
playing back 177
saving as binary file 176
selecting 70

RECORD SCRIPT command (terminal window 
File menu) 163

Record Session in File for Later Playback 
check box 175

RECORDING command (remote online menu) 
96, 175, 176

RECORDING command (terminal window File 
menu) 175, 176

Recording icon (remote’s online toolbar) 96
recording script file 158, 162–164
recording sessions

online service 157, 175–176
remote control 70, 175–176

Reference book section, online help 13
registering your copy of pcANYWHERE32 22
remote access service (RAS)

connection items 87
remote access service.  See RAS, Windows NT
remote caller. See caller



Index 222
remote control
combining with remote networking 84
contrasted to remote networking 83
ending session 94
overview 83
wizard 65

Remote Control action button 10
using to start modem connection 76, 82
using to start network connection 77

remote control connection 75–79
performance 83

remote control connection item 10, 15
configuring 67–75
creating 65–75
password-protection 75

remote control session
changing options online 91–106
configuration 75–76
configuring default settings 126–145
disconnect when file transfer complete 

112
ending 94
file-transfer protocol 134
logging 180
managing 91–106
online options 103
performance enhancement options 127
playing back 177–179
recording in file 175–176
starting 76–78
starting from host 62

remote history file 182
remote log file 182
remote network connection 87
remote networking 83–89

combining with remote control 84
contrasted to remote control 83
creating connection item 84–86
overview 83
performance 83

Remote Networking action button 10, 84, 87

remote networking connection item 87
editing 86
Windows NT RAS 87

remote networking session 87–89
remote online menu 95
Remote Operation property page 123
remote PC

dials up network server 83
initiates file transfer 111
initiates session 76–78
log report 181
logs session 180
as network workstation 10
online menu 91–93, 93–95, 95–106
waits for call 76, 78

Rename button 116
RENAME... command (pcANYWHERE file 

manager File menu) 116
Rename dialog box 116
renaming

files and folders 116
requirements

to install and run pcANYWHERE32 19
RESTART HOST command (remote online menu) 

96
Restart Host icon (remote’s online toolbar) 96
restart host PC

allowing 56
reversing file and folder selections 110
rights, caller. See privileges, remote caller
running

host mode 62
host mode at startup 46
pcANYWHERE file manager 107
pcANYWHERE32 for the first time 28
pcANYWHERE32 from Windows 95 27
pcANYWHERE32 from Windows NT 28–

29
script file after connection 158
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S
Save Recorded Script dialog box 163
SAVE SCREEN command (remote online menu) 

96, 179
SAVE SCREEN command (terminal window File 

menu) 179
Save Screen icon (remote’s online toolbar) 96
Save Script File As dialog box 163
Save Session Statistics in Activity Log check 

box 180
saving

chat window contents to file 94
online service session to file 176
recorded script to file 163
remote control session to file 71, 176
session screens 179
session statistics in activity log 57, 180

scaling
screen 104, 128
screen colors 105, 127

scan files for viruses before downloading 134
.SCN file extension 179
screen 106

See also display
blanking on host PC 48, 105
blanking on host PC, allowing 56
capturing image during session 179
colors 143
playing back 179
printing from terminal window 164
scaling 104, 128
scaling colors 105, 127

screen saver
disabling 127
launching while host waits for call 46
password-protecting 46
using to lock host 46

Screen Scaling icon (remote’s online toolbar) 
95

screen wrap
changing configuration during session 167
configuring 159

script
discarding 163
recording after connection 158, 162–164
saving 163

script execution 96, 158
when online service session starts 162

SCRIPTS command (remote online menu) 96
SCRIPTS... command (terminal window File 

menu) 162
SCRIPTS command (Utilities menu) 173
Scripts dialog box 162
scroll bars

terminal window 139, 168
searching online help topics 13
security

See also password-protection
configuring on host 47–51
item-level 55–62
protecting remote control connection 

items 75
unidirectional gateway used for 148

Security Options property page 44
Select File to Receive dialog box 170
Select Macro Key File dialog box 140
Select Playback File dialog box 177
Select Recording File dialog box 176
Select Translation File dialog box 142
selecting

connection device 39
connection device, online service 155
connection device, serial connection 33
connection item 11–12
connection items, recent 14
devices from list 32, 67, 149
downloaded file destination 170
drive 109
file-transfer protocol 169
files and folders 109–110
files to synchronize 119
gateway connection device 150
modem 32
modem, custom 32, 40
multiple files 110
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selecting (continued)
network device 88
network host 78
network server 87
recording file for session 70, 176
recording file to play back 177
script to run 162

Send button 111
SEND... command (pcANYWHERE file 

manager File menu) 111
Send Ctrl+Alt+Del icon (remote’s online 

toolbar) 96
sending

See also chat; downloading; file transfer; 
SpeedSend file transfer

files (remote control session) 111
message to another user 93

serial cable direct connection 33
serial port. See COM port
server

dialing up using remote networking 83
dial-up 87
NASI/NCSI 37
selecting 87

Session Log Report dialog box, host and 
remote 182

Session property page
remote control 67, 70

Session property page (online service) 155, 
157

sessions
append recording to existing file 70
disconnect remote control session after 

timeout 50
logging 180
logging, host 181
logging, remote 181
managing (remote control) 91–106
online service 160–171
playing back 177–179
recording, online service 157, 175–176
recording, remote control 70, 175–176
remote control 70–82

sessions (continued)
remote control, starting from host 62
remote networking 87–89
saving to file 71, 176
screen capture and playback 179

sessions, append recording to existing file 157
set up pcANYWHERE using the Smart Setup 

wizard 28
Settings property page

callers 53, 55
gateway 150
host 44, 46
online service 155, 156
remote 67

SHARED DATA... command (Administrator 
menu) 25

size
data window, ZMODEM file transfer 138
display files by 109
sorting files by 108

Smart Setup wizard 28
software requirements 20
sort criteria 108
sorting files 108–109
SpeedSend file transfer 113, 114, 136

verifying option enabled 112
SPX 34, 84
standalone PC, installation instructions 19–23
Start button (Windows 95) 103

accessing during remote control session 
103

displaying 103
starting 11

gateway session 151
host PC in host mode 63
host wizard 11
online service session 160–161
pcANYWHERE file manager 107
playback of recorded session 178
remote control session 76–78
remote networking session 87–89

status line, terminal window 139, 168
stopping remote control session 94
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subfolder
file comparison 117

superuser privileges 56
Symantec’s bulletin board 153
Sync button 119
SYNCHRONIZE... command (pcANYWHERE file 

manager File menu) 119
synchronize display 106
Synchronize Folder dialog box 119
synchronizing

contrasted to cloning 118
files 119
folders 119
screen display, DOS host 106, 130

system administrator. See administrative 
installation; administrator options

System Setup property page 123
SYSTEM.DAT file 23

T
tables, translation 141–143
Tag menu (pcANYWHERE file manager) 110
tape symbol in title bar 163
target folder 169

See also download, folder
task-switching on host (Windows NT) 96
TCP/IP

configuring network device 34
TCP/IP property page 123
telephone line

contrasted to connection via LAN 83
Terminal 138
terminal emulation 138–143, 156
Terminal Emulation property page 123, 139
terminal window 161–168

clipboard support 164–165
display options 139, 159–160, 166–168
fonts and colors 143
menu bar 161
printing from 164
sending output to printer 164

text
copying, cutting, and pasting 165
terminal window 165

time, display files by 109
time limit to remote control session, 

establishing 57
timeout

enforcing 50, 57
file download 137
setting 48
specifying for gateway session 150

toggling between full-screen display and 
window mode 103

toolbar 104
customizing 144, 145
online (remote) 95
online (remote), displaying 104

TRANSFER CLIPBOARD... command (remote 
online menu) 96, 102

Transfer Clipboard icon (remote’s online 
toolbar) 96

transferring
data between PC and remote network 83
files between remote PC and host PC 107–

120
files, using pcANYWHERE file manager 

107–120
graphics 96
Windows clipboard contents 96, 102, 164–

165
translate CR to CR/LF 160, 167
translation tables 141–143, 158

selecting 167
.TRN file 158, 167
typing message to another user online 93

U
unidirectional gateway 147, 148, 150
upload translations of carriage returns and 

linefeeds 137
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uploading
See also file transfer
allowing by remote 56
preventing 56
using clipboard 165
to online service 171

Use Modem list box 40
user-defined computer name 124
user ID, configuration file 185
User property page 37
USER.DAT file 23
Utilities menu 173–186

V
viewing

captured screen image 179
clipboard contents 102
full-screen display mode 95, 103
host’s screen on remote 95, 103
log report 181
online menu (host) 92
online menu (remote) 91

virus scans before downloading files 134

W
wait for call from host 76, 78
wait for call from network or modem (gateway 

PC) 147
wait for call from remote 63
WAIT FOR CONNECTION command (context 

menu) 78
wallpaper, disabling 127
What’s This

accessing 13
what it does 13

WINAW32 folder 22
window mode 95, 103
window size, ZMODEM file transfer 138
Windows 3.x, using local fonts 128
Windows 95

changes made to system and user files 23
clipboard 102, 164

Windows 95 (continued)
connection information 31–37
Start button 103
supported connection devices 31–32, 37
version required 20

Windows NT
clipboard 164
connection information 38–41
modem definitions 38
RAS 83
running pcANYWHERE 28–29
send Ctrl+Alt+Del to host 96
supported connection devices 32, 38
supported features of pcANYWHERE 9
task-switching on host 96
version required 20

wizard
adding new caller 53
adding new host 43
adding new remote control 65
Data Conversion 184–186
file transfer 15
gateway 16, 148
host 14–15, 43
online service 153–154
remote control 15, 65
remote networking 84–86
Smart Setup 28
what it does 14

workstation
installation instructions 26–29

wrapping
lines 159, 166
screen display 159, 167

X
XMODEM file-transfer protocol 134

Z
ZMODEM file-transfer protocol 137–138, 169, 

170
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